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1 
Planning the Test

Planning the Test - Concepts

The following topics provide some information that can help you in
planning tests with the Serial BERT :

• “Introduction to the Serial BERT - Concepts ” on page 9
explains the basics of bit error rates (BER) and BER testing with
the Serial BERT .

• “Which Test is Appropriate? - Concepts ” on page 13 provides
you with some basic information about the types of testing you
can do with the Serial BERT .

• “Connecting the DUT - Concepts ” on page 17 tells you how
you should connect your DUT to the Serial BERT .

Introduction to the Serial BERT

Introduction to the Serial BERT - Concepts

These topics explain some of the basics of BER, Serial BERT , and
BER testing with the Serial BERT .

Important Information about the Pattern Generator Outputs

The pattern generator output ports must be terminated with 50  Ω
if they are not connected:

• Data Out

• Data Out

Agilent J-BERT N4903 High-Performance Serial BERT
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• Clock Out

• Clock Out

Termination of output ports improves the test performance.

Important Information Regarding Security

The Serial BERT  is a PC-based instrument with a standard
Windows operating system. As such, it is subject to the same
security protection measures as any other PC.

See the Microsoft web site for more information regarding data
security:

http://www.microsoft.com/security/default.mspx

Every user must have administrator privileges to run the Serial
BERT firmware. Otherwise the firmware does not have access to the
instrument's hardware.

It ist recommended that you create a recovery disk for the
instrument. See “How to Restore the Operating System” on page
382.

Note also that there is a recovery image on the hard disk. See the
Windows Help for instructions on restoring a recovery image.

Understanding BER

Bit error ratio (BER) is the most fundamental measure of system
performance. It is the ratio of the number of errored bits to the
total number of bits received.

For example, 1 error in 1000 bits corresponds to a BER of 1/1000
or 1x10 -3 . This would be displayed on the instrument as 1E-3. Refer
to the following table to familiarize yourself with how BERs are
displayed. Notice that smaller exponents correspond to higher
BERs, and larger exponents correspond to lower BERs.

Table 1

Fraction Exponent Instrument Display

1/1 1 x 100 1E+0

1/10 1 x 10-1 1E-1

1/100 1 x 10-2 1E-2

1 Planning the Test
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Table 1

Fraction Exponent Instrument Display

1/1000 1 x 10-3 1E-3

1/10,000 1 x 10-4 1E-4

1/100,000 1 x 10-5 1E-5

1/1,000,000 1 x 10-6 1E-6

1/10,000,000 1 x 10-7 1E-7

Understanding the Serial BERT

The Serial BERT , also referred to as a Bit Error Ratio Tester
(BERT), is a powerful instrument that enables you to analyze
systems and components in the telecommunication and enterprise
communication industries. It is an essential tool for designing and
troubleshooting communications systems, high-speed integrated
circuits (ICs), and photonic components. Its intuitive operation and
leading edge performance will help you quickly verify error
performance.

The Serial BERT  comes with advanced jitter generation capabilities
for jitter tolerance testing (J-BERT). The instrument provides:

• Excellent waveform performance

• Outstanding rise times and jitter performance

• A choice of logic family interfaces

• Easy object-oriented programming with the IVI-COM interface

• Remote commands similar to HP/Agilent 71603B

• A variety of ways in which to accumulate and view test results

• A collection of example patterns

• Convenient online documentation

• Automatic setup of optimum sampling point

• A variety of powerful advanced analysis tools

• Special support for jitter analysis and characterization

Planning the Test 1
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Which Features are Available?

The Serial BERT  is available in different options. They differ in the
range of provided bit rates and in the available features.

Depending on the options you bought you can have the following
installed:

• C07

Bit rate range: 150 Mbit/s to 7 Gbit/s with built-in clock data
recovery (CDR)

• C13

Bit rate range: 150 Mbit/s to 12.5 Gbit/s with built-in CDR

• U13

Upgrade of a 7 Gbit/s instrument to 12.5 Gbit/s

• A01

Bit Recovery Mode (measures BER without expecting a particular
pattern)

• J10, U10

Option/Upgrade for jitter injection. Total jitter can be composed
from random, periodic, sinusoidal, and bounded uncorrelated
sources.

• J11

Spread Spectrum Clock (SSC)

• J12

Option/Upgrade for Jitter Tolerance Compliance tests. Use this
test to ensure that the jitter tolerance of the device under test
complies with a certain standard.

• J20

User-installable hardware module "Interference Channel" for
simulating intersymbol and sinusoidal interference

To check the options of your Serial BERT , press About in the Help
menu. The About dialog shows the installed options.

1 Planning the Test
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Which Test is Appropriate?

Which Test is Appropriate? - Concepts

These topics help you to decide on the appropriate test setup for
your device.

Determining How to Test Your Device

The Serial BERT  can help you test the performance of components
and systems for high-speed digital transmission equipment.

An important parameter of a digital system is the rate at which
errors occur in the system. The analyzer will compare the bits sent
to your device with the bits received from your device. It will record
the number of bit errors and display results such as the bit error
ratio (BER). In addition, accumulated results can be analyzed to
help you determine what caused the bit errors.

The analyzer can be set up to work with your device in many
different ways. To determine the best measurement setup, you must
first decide how you want to test your device. Before actually
setting up and making measurements, you may want to consider the
following questions:

• What is the purpose of your test?

• What are the testing requirements of your device?

What is the Purpose of Your Test?

Does the purpose of your test fall under one of the following
categories?

• To monitor instantaneous BER during measurement setup,
experiments, and adjustments. See .

• To measure and log error performance over time. See
“Accumulated Measurements - Concepts ” on page 300.

• To measure the eye height and width of the incoming data signal
at specific alignment BER thresholds. See “Eye Measurements -
Concepts ” on page 309.

Planning the Test 1
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The following references may also be helpful in determining how to
test your device.

• For a list of recommended patterns for your device and
application, see “When to Use Which Pattern?” on page 26.

• For a list of recommended connection diagrams for your device
and application, see “Connecting the DUT - Concepts ” on page
17.

What are the Testing Requirements of Your Device?

Considering the requirements of your device will help you choose
which instrument functions to use during the test setup and when
making measurements.

• Do you need to use a custom test pattern?

If you have a long series of 1's or 0's in your custom pattern, be
sure to avoid false sync. See “What is False Synchronization?” on
page 135

• Do you want to use alternating patterns?

Then you must first import or create a custom pattern that
contains an A half (pattern A) and B half (pattern B). See
“Pattern Alternation - Concepts ” on page 98.

• Are you aware of how custom pattern size can affect the pattern
output?

See “Why the Serial BERT Repeats Memory-Based Patterns” on
page 32.

• Do you need more than two patterns or a mix of custom patterns
and PRBS?

• Does your device change the input pattern it receives?

If your device inverts logic, then select Data Inverted in the
Sampling Point Setup window. If your device changes patterns in
other ways, then you must know the expected output pattern
and select it as the error detector reference pattern.

• What logic family is your device compatible with?

The pattern generator has preset voltage levels to work with
ECL, SCFL, LVPECL, LVDS, and CML. Be sure to select the
correct logic family. See “Understanding how the Serial BERT
Uses Logic Families and Terminations” on page 74.

• What is the input termination voltage of your device?

Make sure it is the same voltage as displayed in the pattern
generator termination list.

1 Planning the Test
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• What termination voltage is the output of your device designed
to work with?

Make sure it is set for the error detector's data port termination.
See “Data In Port Termination” on page 109.

• What bit rate do you need to test your device at?

The Serial BERT  allows you to run tests from 150 Mb/s up to
12.5Gb/s (depending on the options with which you bought the
instrument). See “Error Detector Bit Rate” on page 116 for more
information.

• Does your device require differential inputs?

As complementary outputs, Data/Clock Out and Data/Clock Out
may satisfy this requirement. See “Diagram 2. Connections for
Differential Inputs” on page 18.

• Is the output of your device noisy or very small in amplitude?

You may need to manually set up a sampling point. See .

• Do you want to check the BER in bursts (for example, for loop
testing applications)?

The Serial BERT  provides capabilities that help you set up and
run burst tests. See “Introduction to Burst Sync Mode” on page
137.

• Are you aware of how the sync mode setting can affect the way
errors are measured and displayed?

See “What Type of Synchronization Should You Use?” on page
134.

Test Times and Confidence Levels

A true BER measurement must be statistically valid. Because it is
not possible to predict with certainty when errors will occur, your
device must be tested long enough to have confidence in its BER
performance. The table below lists the test times required for
different BERs at specific bit rates.

N O T E The test times in this table are valid for continuous measurements. If measurements
are made in bursts, the test times will be longer (continuous test time divided by
the burst duty cycle times the burst sync ratio). See “Introduction to Burst Sync
Mode” on page 137 for background information.

The test times for 95% confidence level are:

Planning the Test 1
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Table 2

BER STM-64/
OC-192
(9.95328 Gb/
s)

STM-16c/
OC-48c
(2.48832 Gb/
s)

STM-4c/
OC-12c
(622.08 Mb/s)

STM-1/OC-3
(155.52 Mb/s)

1E-14 ~ 8.4 hours ~ 1.4 days ~ 5.6 days ~ 22.4 days

1E-13 ~ 50 minutes ~ 3.3 hours ~ 13 hours ~ 2.2 days

1E-12 ~ 5 minutes ~ 20 minutes ~ 80 minutes ~ 5.3 hours

1E-11 ~ 30 seconds ~ 2 minutes ~ 8 minutes ~ 32 minutes

1E-10 ~ 3 seconds ~ 12 seconds ~ 48 seconds ~ 3.2 minutes

The formula for confidence level is as follows:

C = 1 - e^-nb

Where:

C = degree of confidence (0.95 = 95%)

e = natural base number

n = number of bits examined without error

b = desired residual BER

You may want to prove that your device has a certain residual BER.
If you know this desired BER and the desired confidence level, you
can calculate the number of bits that must be measured without
error. The number of bits, in turn, can be translated into a period
of time at a certain bit rate. That is what is done in the above table.

The following example shows how to calculate the number of bits
if the desired BER (b) is 1E-10 and the desired confidence level (C)
is 95%:

1 Change formula "C = 1 - e^-nb" to solve for the number of bits
(n)

n = -ln(1-C)/b

2 Replace variables C and b

n = - ln(1 - 0.95)/1E-10

3 Calculate the number of bits

n = - ln(1 - 0.95)/1E-10 = 2.99/1E-10 = 2.99E+10 bits

1 Planning the Test
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4 Calculate the time period at the STM-16/OC-48 bit rate (2.48832
Gb/s)

2.99E+10 / 2.48832E+9 = 12.016 seconds

Connecting the DUT

Connecting the DUT - Concepts

This section provides information on how to connect your DUT for
several common test scenarios.

N O T E The pattern generator's Data Out and Clock Out ports must be terminated with
50 Ω if they are not connected.

The following procedure is recommended when setting up a test:

1 If your DUT can handle 0V, press the 0V (Disable) button in the
PG Output Setup screen.

The pattern generator's Data Out and Clock Out outputs are set
to 0V. This is indicated in the PG Output Setup screen.

2 Connect the DUT as necessary.

3 Terminate any non-connected Data Out and Clock Out ports
(normal and complementary).

4 If the outputs are disabled, press the 0V (Disable) button to enable
them.

To avoid damaging your device, set up the devices properly before
making connections.

C A U T I O N ESD can damage or destroy electronic components. Coaxial cables with both ends
unconnected may store electrostatic charges. Before connecting any coaxial cable
of this sort to a device or instrument, momentarily short the center and outer
conductors of the cable. When making connections, ensure the proper use of a
grounded, resistor-isolated wrist strap.

Connect your device according to the diagrams below:

Planning the Test 1
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Diagram 1. Connections for Different In/Out Data Rates

Often used for multiplexers, or when the data rate received by the
device is not equal to the data rate sent from the device.

Diagram 2. Connections for Differential Inputs

Application is the same as in Diagram 1. Illustrates how to connect
to a device requiring differential signals.

1 Planning the Test

18 Agilent J-BERT N4903 High-Performance Serial BERT



Diagram 3. Connections for an Amplifier

Often used for amplifiers.

Diagram 4. Connections for a Flip-Flop

Often used for flip-flops.

Planning the Test 1
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Diagram 5. Connections for a MUX/DEMUX Pair

Used to test multiplexer/demultiplexer (MUX/DEMUX) pairs. For
accurate measurement results, the timing of data signals between
the MUX/DEMUX pair must be set properly.

Diagram 6. Connections for a DCA or Oscilloscope (PGonly)

Used for measuring the output waveform of your device. For the
least amount of jitter, the clock output signal may be used as a
trigger for the oscilloscope.

1 Planning the Test
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Diagram 7. Connections for a SONET/SDH Receiver (PGonly)

Often used with network equipment, such as SONET/SDH receivers.
The device shown may or may not require a clock signal.

Diagram 8. Connections for an External Data Source (EDonly)

Used when the device is stimulated by another data source.
Illustrates the use of an oscilloscope in addition to the error
detector.

N O T E As in all setups, the pattern sent to the error detector must be the same as the
internal reference pattern of the error detector. Dynamic patterns and/or patterns
with live payloads cannot be used.

N O T E Diagrams 1 through 8 can use an external clock reference connected to the Clock
In port of the pattern generator, if desired.

Planning the Test 1
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2 
Setting up Patterns

Setting up Patterns - Concepts

The purpose of data patterns is to simulate the type of data that
your device might receive in the real world. Different patterns
present different data loads to your device, which can cause
variations in the bit error ratio. A bit pattern is sent from the
pattern generator to your device. At the same time, the expected
output pattern of your device is internally generated in the error
detector (to provide a reference).

Selecting a pattern is the first step in setting up a BER
measurement. The Serial BERT  provides various patterns to fulfill
most standard testing needs.

How does the Serial BERT Generate Patterns?

The Serial BERT  has two possibilities for generating patterns: either
by directly generating them from the hardware, or by loading
patterns into the memory and generating the output according to
the pattern in the memory. These memory-based patterns can be
either user patterns (file-based), or software-generated patterns.

The hardware-generated patterns available with the Serial BERT  are
PRBS 2^n -1 patterns. They provide long, high-speed, random
traffic patterns that can be used for testing a wide range of devices.
These patterns cannot be manipulated in any way.

The memory-based approach is more flexible. It makes it possible
to define any pattern (within the physical limits of the memory) for
defining the output. The Serial BERT  provides two possibilities for
defining the output: by defining user patterns or by selecting a
software-generated pattern.

Agilent J-BERT N4903 High-Performance Serial BERT
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User patterns are file-based, editable patterns. These may be
patterns that you set up using the Serial BERT 's Pattern Editor, or
any of the patterns delivered with the Serial BERT . You can easily
define your own patterns for any special requirements.

The Serial BERT  can also generate various PRBS 2^n patterns with
a range of polynomes from 7 to 23. These patterns can be further
modified by setting special mark densities (ratio of 1's to total bits)
or by defining the zero substitution.

It is possible to combine several patterns in a sequence. A sequence
consists of up to four blocks that can be looped. Each block can
generate a pause signal (constant 0 or 1), a divided clock, a 2^n -1
PRBS, or a user pattern.

What Patterns are Available?

The Serial BERT  offers various industry standard and customized
patterns for many BER testing scenarios.

The following graphic illustrates what patterns are available on the
Serial BERT . Note that there are two main branches, corresponding
to the hardware-generated and memory-based patterns, and the
memory-based patterns are further broken down into software-
generated patterns and user patterns.

Pattern Family Tree

User Patterns

Hardware-Generated
Patterns

Custom User
Patterns

Example Patterns
in C:\N490X\Pattern\Demo

2^n-1 PRBS

FDDI Fiber-Channel
Gigabit Ethernet 2^n PRBS 2^n PRBS

Mark Density SDH SONET

Industry Standard Pattern or
modified Industry Standard Pattern

PRBS

Software-Generated Patterns

Zero Substitution Mark Density

Memory-Based Patterns

See “Example Patterns” on page 33 for a complete listing of the
example patterns.

2 Setting up Patterns
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What is PRBS?

The most common type of industry-standard pattern is the Pseudo-
Random Binary Sequence (PRBS). PRBSs have a number of
desirable properties, including the ability to simulate random data
with a balanced number of 1's and 0's.

They are referred to by their pattern lengths, which are powers of
2. Longer pattern lengths give a better approximation of random
data and provide a more rigorous test for the device. However, the
pattern repetition time is significantly longer.

PRBS patterns provide a means to simulate the type of traffic that
a system is likely to see: random traffic. They also enable you to
stress your system to its limits, because large patterns that include
long strings of 1's or 0's are more stressful.

The patterns are easy to generate and can measure at high speeds,
because they are sent repeatedly and can be predicted. Pattern
synchronization, for example, is very fast. When you compare the
sequence with itself, you get 50% errors in all positions, except
when the pattern is exactly aligned.

Hardware-generated PRBSs are non-inverted PRBS 2^n -1 patterns
that allow high-speed measurement of random traffic. They enable
stressful testing of devices, because large patterns contain long
strings of 0's and 1's.

Software-generated PRBSs are non-inverted PRBS 2^n patterns.
They are also called PRBN patterns. These patterns are useful for
applications where the pattern length must be an even number. The
Serial BERT  provides variations of software-generated PRBS
patterns, allowing you to set a pattern's mark density (ratio of 1's)
and zero substitution. These features make it easier for you to run
specific stress tests on your DUT.

The following figure illustrates the PRBS-based patterns available
with the Serial BERT :

PRBS

2^n-1 PRBS
Hardware-Generated

2^n PRBS
Software-Generated

Pure
2^n PRBS

2^n PRBS Mark
Density

2^n PRBS
Zero Substitution

Setting up Patterns 2
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Digital non-return to zero (NRZ) data has a (sin x/x)^2
characteristic frequency spectrum. The PRBS frequency spectrum
follows this envelope, with line spectra of spacing related to the
sequence repetition rate. The longer the sequence before it repeats,
the narrower the line spacing (closer to a continuous spectrum).

Line spacing = bit rate/sequence length
The closer to a continuous spectrum, the more the test signal looks
like an analog noise source. The benefit of this is that such a
stimulus shows any frequency-dependent effects in a device under
test. For example, a clock recovery circuit designed to lock onto a
single frequency may have a tendency to lock onto harmonics. A
long PRBS may uncover such undesirable behavior.

When to Use Which Pattern?

Selecting the appropriate pattern and test setup for your application
is important. Below is a list of recommendations that may be
helpful.

• To simulate random traffic, choose PRBS.

• For functional and alarm testing, choose alternating memory
patterns.

• If the test pattern requires a header, choose one of the “Example
Patterns” on page 33 or use a custom pattern.

• To stress lightwave transmitters and receivers, vary the mark
density of the pattern with a modulator or e/o converter.

• To induce baseline wander for margin testing, vary the mark
density and use alternating patterns.

• For pattern dependency testing, choose one of the “Example
Patterns” on page 33 or use a custom user pattern; vary the
mark density.

• For eye diagram measurements and mask analysis, use the Serial
BERT with a digital communication analyzer or oscilloscope.

• For receiver sensitivity or eye contour measurements, use the
Serial BERT  with a digital communication analyzer or
oscilloscope.

• For a clock recovery circuit stress test, vary the mark density or
use CID (Consecutive Identical Digit) patterns that contain long
runs of 1's and 0's.

Alternatively, use the Serial BERT  or a DCA with an ITU-T
specified pattern for testing STM-n systems. This pattern is to
verify the adequacy of timing recovery and low frequency
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performance of STM-n systems. It consists of a user pattern that
is comprised as follows:

The first row of overhead bytes for the STM-n system, all ones
(zero timing content, high average signal amplitude), pseudo-
random data with 50 % mark-density ratio. This is followed by
a repeat of the pattern overhead, all zeros (zero timing content,
low average signal amplitude), and the PRBS. For full details, see
ITU-T Recommendation G.958.

• For a regenerator test, set up the bit rate according to the device
specification.

T I P If your device converts the input pattern, the error detector needs a different pattern
than the pattern generator. See “Loading Patterns to the Pattern Generator and
Error Detector” on page 41 for details.

User Patterns

User Patterns - Concepts

User patterns are user-editable patterns that are written to the
Serial BERT 's memory for pattern generation (see “How does the
Serial BERT Generate Patterns?” on page 23 for details). User
patterns can contain up to 32Mbit of any arbitrary data pattern.
They may be generated by the Serial BERT  software or defined in
a pattern file and loaded into the memory. The Serial BERT  reads
the memory bit by bit, and generates the output accordingly.

The following topics explain how the Serial BERT  works with user
patterns, and also explain how user patterns are generated.

N O T E The way software-generated patterns (distorted PRBS, PRBN) are output is
identical to that of user patterns: The patterns are written to the memory, and the
output is generated from there. Some of the information in these topics covers how
the patterns are actually generated, and thus also applies to software-generated
patterns.
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When to Test with User Patterns

Creating or editing patterns is necessary for quality testing because
different patterns present different data loads to the device. This
can cause variations in the bit error ratio. With user patterns, you
can define exactly the pattern used in the test.

Supported Pattern Types

The Serial BERT  can import the following pattern types:

• HP/Agilent 71600 series patterns (*.dat file type).

• Patterns saved as ASCII files by the Serial BERT  or the Agilent
86130 (*.ptrn and *.txt file type).

These are described in detail in “Pattern File Specifications” on
page 28.

The Serial BERT  can save files as either *.dat, *.ptrn or *.txt files.

N O T E Downloading a text format pattern into your instrument may take significantly longer
than a binary pattern.

N O T E If you save a modified text format pattern to the same file name, it is always saved
in binary format. If you wish to preserve the original text format file, use the Save
As file command and save the data to a different file.

Pattern File Specifications

For your instrument to download a pattern file, the pattern must
be composed of at least 7 lines. The first 6 lines start with a
keyword to identify the field, followed by an '=' sign. There should
be no spaces around the '=' sign and no blank lines.

Use the following keywords and examples to construct your ASCII
file. Note that the keywords must appear in the given order.

The version field is used to identify different file versions. For this
software version, the field should be set to EPA 2.0. An exact match
for this field is required for the pattern to load correctly.

Syntax: Version=EPA 2.0
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The format field identifies whether the pattern is in dual,
hexadecimal, or binary format.

Syntax: Format=<Dual | Hex | Text | Bin>
Hex and text formats are identical.

This is the creator's description of the pattern. The data after the
'=' sign is read until the end of the line and used directly as the
pattern description. The maximum number of characters is 256.

This identifies standard and alternating patterns. Standard patterns
have a value of 1; alternating patterns have a value of 2. Any other
value is not valid.

Syntax: Count=<1 | 2>

This is the length of the pattern in bits. For a standard pattern of
128 bits, for example, the value is 128. For an alternating pattern,
it is the length of one of the patterns only.

The "Data" tag identifies the start of the pattern data itself. For
standard patterns, there is only one "Data" tag. Alternating patterns
require two "Data" tags. Note that the actual data starts on the line
after the tag.

Syntax: Data=<CR/LF><data contents>
• In dual format, each character represents one bit-only the

numbers '1' and '0' are allowed.

• In hex or text format, each character represents four bits-only
the characters '0' to '9' and 'A' to 'F' are allowed (not case-
sensitive).

• In binary format, each character represents eight bits-all ASCII
characters are allowed.

Example:

'X' in binary format or '88' in hex or text format produce the same
bit sequence as 10001000 in dual format.

In hex or text format, the data must be separated by one white
space. The white space can be a tab, a space, or a new line.

In hex or text format: For pattern lengths that are not multiples of
8 bits , the data has to be padded to provide the correct number
of hex characters. The extra bits are ignored.
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ASCII Pattern Files Examples

Version=EPA 2.0
Format=Hex
Description=This is a simple standard pattern
Count=1
Length=128
Data=
01 02 03 04 10 20 40 80
ff 00 ff 00 ff 00 ff 00

Version=EPA 2.0
Format=Text
Description=This is a simple alternating pattern
Count=2
Length=96
Data=
01 02 03 04 10 20 40 80 ff 00 ff 00
Data=
01 02 03 04 10 20 40 80 ff 00 ff 00

Pattern Resolutions and Lengths

The Serial BERT  has 32Mbits (8 MB) RAM for storing patterns. As
discussed in “How the Serial BERT Generates Memory-Based
Patterns” on page 31, all patterns are loaded into the RAM until
a 512-bit boundary is reached. If the pattern is an odd number of
bits long, it is loaded into the RAM 512 times. Because of the
restricted memory space, there are also restrictions to the pattern
lengths.

For example, a user pattern that is 256,001bit bit long would have
to be loaded into the RAM 512 times to reach the 512-bit boundary.
Such a pattern would occupy more than 128 Mbits in the RAM.

The Serial BERT  handles such patterns by rounding them off to the
nearest length that would fit in the memory. For the above example,
the length would be rounded off to 256,000 bits. This rounding-off
factor is known as the pattern's resolution. The following table lists
all pattern resolutions.

Table 3

Pattern length (standard) Pattern length (alternate) Resolution

≤ 64 kbit ≤ 32 kbit 1 bit
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Table 3

Pattern length (standard) Pattern length (alternate) Resolution

> 64 kbit > 32 kbit 2 bit

> 128 kbit > 64 kbit 4 bit

> 256 kbit > 128 kbit 8 bit

> 512 kbit > 256 kbit 16 bit

> 1 Mbit > 512 kbit 32 bit

> 2 Mbit > 1 Mbit 64 bit

> 4 Mbit > 2 Mbit 128 bit

> 8 Mbit > 4 Mbit 256 bit

> 16 Mbit > 8 Mbit 512 bit

How the Serial BERT Generates Memory-Based Patterns

The basic concept of how the Serial BERT  generates memory-based
patterns is relatively simple: The Serial BERT  has 32Mbits of
internal RAM memory used to store data patterns. The RAM is
organized in 64k of 512-bit blocks.

During test run, the pattern generator reads this memory bit by bit
and generates the corresponding voltage at the output port (1=high,
0=low). The error detector compares the incoming signal voltage
(=data bits) with the bits in the memory and counts the errors.

The Serial BERT  has actually three RAM memory locations where
patterns are stored: in the Pattern Editor memory, in the pattern
generator, and in the error detector. When you modify patterns with
the pattern editor, the patterns in the pattern generator and error
detector are not automatically updated.

For this, you need to write the pattern to the pattern generator
and/or the error detector . There the pattern is saved in the RAM
of the respective module.
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Why the Serial BERT Repeats Memory-Based Patterns

To generate output signals, the Serial BERT  can send only complete
512-bit blocks of data. To maintain predictability of the output
signal, it is necessary to send complete patterns. This applies to
user patterns, alternating patterns, memory-based PRBN patterns,
mark density patterns, and zero substitution patterns.

Therefore, when the Serial BERT  loads a pattern into its internal
memory, it repeats the pattern as necessary until the pattern
reaches a block boundary. For example, if a 1023-bit pattern is
loaded, this is repeated in the RAM 512 times, and thus occupies
1023 blocks. Or, if a 192-bit pattern is loaded, this is repeated 8
times, and occupies 3 blocks, as indicated in the following figure.
This applies to all memory-based patterns available to the Serial
BERT.

During test run, the Serial BERT  always sends out all blocks of a
pattern. In the case of the 192-bit pattern mentioned above, the
pattern is repeated 8 times when sent out (in effect, making it a
1536-bit pattern).

The same behavior of repeating a pattern to fill up complete blocks
also applies to alternating patterns. In this case, each half of the
pattern is loaded into a separate location in the RAM. When an
alternating pattern is generated, first all blocks of pattern A are
sent, then all blocks of pattern B are sent, and so on.

A0 A1 A2 B0 B1 B2 A0 A1 A2

A A A A A A A A B B B B B B B B A A A A A A A A

Implications of Using Memory-Based Patterns

There are several implications to the way Serial BERT  handles
memory-based patterns, a few of which are:

• If you set up an alternating pattern where pattern B is a replica
of pattern A except for the addition of one error, and the pattern
is an odd number of bits long, the error will be repeated 512
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times when B is sent (because pattern B is sent 512 times before
switching back to A).

• If you want to send a periodic pattern, you only have to define
a single repetition. For example, if you want to send alternating
1's and 0's, you only have to define the first two bits. This
pattern is automatically loaded 256 times to fill up a complete
block of RAM.

• If you set up a trigger to be generated whenever a pattern is
sent, the trigger is sent whenever all blocks that store this
pattern have been sent (and not every time the pattern is sent).

So, for example, if you have a standard pattern that is 384 bits
long, this pattern must be loaded into the memory four times to
reach the 512-bit boundary. A trigger would then be generated
every 4x384bits, or 1536bits.

Example Patterns

The Serial BERT  provides a set of example user patterns. These
patterns mimic real data packets and standard stress patterns.

The directory for the example user patterns is: C:\N4903A\Patterns
\Demo.

You can access this folder from the Serial BERT 's Start menu
(N4903A Data -> Pattern).

C A U T I O N Any changes you make to the patterns in this folder are non-recoverable (there is
no backup folder). To avoid inadvertent changes, it is recommended that you copy
the demo files to a different directory before loading them.

This folder contains the following subdirectories with example
patterns:

• FDDI_Jitter.ptrn

The Fiber Distributed Data Interface (FDDI) data dependent
jitter test pattern is used for testing FDDI components or
physical links. The pattern is 1280 bits long and is transmitted
continuously during the test by repeating the pattern. The
sequence causes a near worst case condition for inter-symbol
interference and duty-cycle, base-line wander.

• FDDI_Wander.ptrn

The FDDI baseline wander test pattern is used to test FDDI
components for the effects of a change in the average DC level
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of the signal. The first 45,000 bits are of the code group (01010);
the last 45,000 bits are of the code group (10101).

• SPAT.ptrn

This is a Fiber Channel supply noise stimulus test pattern.

• RPAT.ptrn

This is a Fiber Channel random data pattern.

• K28-7.ptrn

This pattern is used to test Fiber Channel and Gigabit Ethernet
elements. It has a large low frequency content that is used to
test low frequency random jitter (RJ) and PLL tracking errors.
The pattern is composed of five logic highs, followed by five logic
lows. This is repeated continuously and disparity rules are
followed.

11111 00000

11111 00000 (binary).

• K28-5.ptrn

This pattern is used to test Fiber Channel and Gigabit Ethernet
elements. It tests random jitter (RJ) and deterministic jitter (DJ).
The pattern is composed of 10 bits, followed by the complement
of those 10 bits. It contains isolated characters preceded by runs
of the opposite character. Disparity rules are followed.

11 00 00 01 01

00 11 11 10 10 (binary)

• JTPAT.ptrn

This is a Fiber Channel jitter tolerance pattern, used to test
receiver CDR to large instantaneous phase jumps.

• D21-5.ptrn

This pattern is used to test Fiber Channel and Gigabit Ethernet
elements. It tests random jitter (RJ) and the symmetry of logic
transitions. The pattern is composed of alternating logic highs
and lows and is repeated continuously. Disparity rules are
followed.

1010101010

1010101010 (binary)

• CSPAT.ptrn

This Fiber Channel supply noise (SPAT) pattern is packaged into
a Fiber Channel frame for use in system level tests.

• CRPAT.ptrn
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This Fiber Channel Compliant (RPAT) pattern for jitter
generation is packaged into a Fiber Channel frame.

• CJTPAT.ptrn

This Fiber Channel Compliant (JTPAT) pattern for jitter
tolerance is packaged into a Fiber Channel frame.

This directory contains PRBS patterns that have different lengths
and mark densities:

• PRBS7_1-8.ptrn

• PRBS7_2-8.ptrn

• PRBS7_1-2.ptrn

• PRBS7_6-8.ptrn

• PRBS7_7-8.ptrn

• PRBS10_1-8.ptrn

• PRBS10_2-8.ptrn

• PRBS10_1-2.ptrn

• PRBS10_6-8.ptrn

• PRBS10_7-8.ptrn

• PRBS15_1-8.ptrn

• PRBS15_2-8.ptrn

• PRBS15_1-2.ptrn

• PRBS15_6-8.ptrn

• PRBS15_7-8.ptrn

• PRBS23_1-8.ptrn

• PRBS23_2-8.ptrn

• PRBS23_1-2.ptrn

• PRBS23_6-8.ptrn

• PRBS23_7-8.ptrn

• PRBS7-1_1-2.ptrn

T I P The file names indicate how the patterns are configured. For example,
PRBS23_6-8.ptrn has a pattern length of 2^23 (8,388,608) bits and a mark density
of 3/4 (6/8 or 75 percent).
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N O T E PRBS7-1_1-2 is an emulation of a hardware-generated PRBS 2^7 pattern with a
mark density of 50 percent.

This directory contains the following pattern:

• SDH_STM-16_CID.ptrn

Pattern is a SDH STM-16 rate Consecutive Identical Digit (CID )
pattern, same length as a SDH frame with nine bytes of all 1s
and nine bytes of all 0s separated by random data. This
implementation uses one SDH "frame" to carry the CID pattern
as follows: A1, A2, and C1 bytes as per a normal frame, followed
by a block of bytes set to all 1s, then the normal scrambler
sequence (2^7 PRBS) starting with 1111 111. Half way through
the frame, at row 5 column 40, an A1, A2, and C1 sequence is
inserted again followed by a block of bytes set to all 0s, then the
normal scrambler sequence starting with 1111 111 again. The
length is 148,992 bits (STM-16) corresponding to a time constant
of about 4 msec.

• SDH STM-4.ptrn

A standard SDH STM-4 frame and payload. Total pattern length
of 77,760 bits.

All patterns are STM-16 SDH frame, standard pattern, scrambler
ON, and 1010... payload:

• SDH_STM-16.ptrn

Pattern contains no errors or alarms

• SDH_STM-16_HP-BIP.ptrn

Pattern for testing frames with erred parity check sums, (B3)
error

• SDH_STM-16_HP-REI.ptrn

Pattern for testing Remote Error Indication (RDI) alarm

• SDH_STM-16_MS-AIS.ptrn

Pattern for testing Alarm Indicator Signals (AIS) alarm

• SDH_STM-16_MS-BIP.ptrn

Pattern for testing frames with erred parity check sums, (B2)
error

• SDH_STM-16_MS-RDI.ptrn

Pattern for testing Remote Defect Indication (RDI) alarm
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• SDH_STM-16_OOF.ptrn

Pattern for testing Out of Frame (OOF) alarm

• SDH_STM-16_RS-BIP.ptrn

Pattern for testing frames with erred parity check sums, (B1)
error

All patterns are alternate. Pattern A is an error and alarm free SDH
STM-16 frame, scrambler ON, and 1010...payload. Pattern B has
either an error or alarm as per below:

• SDH_STM-16_HP-BIP_alt.ptrn

Pattern for testing frames with erred parity check sums, (B3)
error

• SDH_STM-16_HP-REI_alt.ptrn

Pattern for testing Remote Error Indication (REI) alarm

• SDH_STM-16_MS-AIS_alt.ptrn

Pattern for testing Alarm Indicator Signals (AIS) alarm

• SDH_STM-16_MS-BIP_alt.ptrn

Pattern for testing frames with erred parity check sums, (B2)
error

• SDH_STM-16_MS-RDI_alt.ptrn

Pattern for testing Remote Defect Indication (RDI) alarm

• SDH_STM-16_OOF_alt.ptrn

Pattern for testing Out of Frame (OOF) alarm

• SDH_STM-16_RS-BIP_alt.ptrn

Pattern for testing frames with erred parity check sums, (B1)
error

• SDH STM-64.ptrn

A standard SDH STM-64 frame and payload. Total pattern length
of 1,244,160 bits

This directory contains the following pattern:

• SONET_STS-48_CID.ptrn

Pattern is a SONET STS-48 rate Consecutive Identical Digit
(CID ) pattern, same length as a SONET frame with nine bytes
of all 1s and nine bytes of all 0s separated by random data. This
implementation uses one SONET "frame" to carry the CID pattern
as follows: A1, A2, and C1 bytes as per a normal frame, followed
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by a block of bytes set to all 1s, then the normal scrambler
sequence (2^7 PRBS) starting with 1111 111. Half way through
the frame, at row 5 column 40, an A1, A2, and C1 sequence is
inserted again followed by a block of bytes set to all 0s, then the
normal scrambler sequence starting with 1111 111 again. The
length is 148,992 bits (STS-48) corresponding to a time constant
of about 4 msec.

• SONET OC-12

A standard SONET OC-12 (STS-12) frame and payload. Total
pattern length of 77,760 bits

All patterns are SONET OC-48 (STS-48) frame, standard pattern,
scrambler ON, and 1010... payload:

• SONET_STS-48.ptrn

Pattern contains no errors or alarms

• SONET_STS-48_L-AIS.ptrn

Pattern for testing Alarm Indicator Signals (AIS) alarm

• SONET_STS-48_L-BIP.ptrn

Pattern for testing frames with erred parity check sums, (B2)
error

• SONET_STS-48_L-FERF.ptrn

Pattern for testing L-FERF alarm

• SONET_STS-48_OOF.ptrn

Pattern for testing Out of Frame (OOF) alarm

• SONET_STS-48_P-BIP.ptrn

Pattern for testing frames with erred parity check sums, (B3)
error

• SONET_STS-48_P-FEBE.ptrn

Pattern for testing P-FEBE alarm

• SONET_STS-48_S-BIP.ptrn

Pattern for testing frames with erred parity check sums, (B1)
error

All patterns are alternate. Pattern A is an error and alarm free
SONET OC-48 (STS-48) frame, scrambler ON, and 1010...payload.
Pattern B has either an error or alarm as per below:

• SONET_STS-48_L-AIS_alt.ptrn
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Pattern for testing Alarm Indicator Signals (AIS) alarm

• SONET_STS-48_L-BIP_alt.ptrn

Pattern for testing frames with erred parity check sums, (B2)
error

• SONET_STS-48_L-FERF_alt.ptrn

Pattern for testing L-FERF alarm

• SONET_STS-48_OOF_alt.ptrn

Pattern for testing Out of Frame (OOF) alarm

• SONET_STS-48_P-BIP_alt.ptrn

Pattern for testing frames with erred parity check sums, (B3)
error

• SONET_STS-48_P-FEBE_alt.ptrn

Pattern for testing P-FEBE alarm

• SONET_STS-48_S-BIP_alt.ptrn

Pattern for testing frames with erred parity check sums, (B1)
error

For more information on the recommeded pattern for specific
purposes, see “When to Use Which Pattern?” on page 26.

User Patterns - Procedures

You can do the following tasks in the Edit Pattern window:

• “Creating New Patterns” on page 39

• “Creating New Patterns” on page 39

• “Editing Patterns” on page 40

• “Saving Patterns” on page 41

• “Loading Patterns to the Pattern Generator and Error Detector”
on page 41

• “Loading Patterns Directly from the Pattern Editor” on page
43

Creating New Patterns

To start a new pattern:

1 Press the Edit Pattern on File icon in the Pattern menu.
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2 In the toolbar, click the New icon.

This opens the Pattern Properties dialog box, where you can:

– Enter a Description for the pattern

– Specify the pattern's Length in Bits

– Specify the pattern's Pattern Type ( Standard or Alternate)

3 After you have entered these parameters, click OK.

The pattern is then opened in the Edit Pattern window.

4 You can now continue with modifying the pattern according to
your needs.

Opening Existing Patterns

To open an existing user pattern:

1 Press the Edit Pattern on File icon in the Pattern menu.

2 In the toolbar, click the Open icon.

The Select User Pattern dialog box opens.

3 Use this dialog box to locate and open the desired pattern. You
can select files of the following types:

– 71630 BERT Pattern Files (*.dat)

– 86130A BitAlyzer Pattern Files (*.ptrn)

– ASCII Text Pattern Files (*.txt)

See “ Supported Pattern Types” on page 28 for descriptions of
these files.

Editing Patterns

To edit a user pattern:

1 Press the Edit Pattern on File icon in the Pattern menu.
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2 If no pattern is loaded in the editor, first open a pattern file as
described in “Opening Existing Patterns” on page 40 or create a
new one as described in “Creating New Patterns” on page 39.

3 To change the pattern length or description or to switch between
standard and alternating patterns, press the Properties button.

The Pattern Properties dialog box appears.

4 Define the pattern length, whether it is alternate or standard,
and give it a description. Click OK when finished.

5 Edit the pattern as required. For the function of the different
tool buttons, see “Edit Pattern Window” on page 44.

Saving Patterns

To save the current user pattern:

• In the toolbar, click the Save icon.

If the pattern has already been saved earlier, the saved file is
updated. Otherwise, the Windows standard Save As dialog box
opens, where you can define the file's path and name.

The available file formats to save the file in are:

• Pattern File (*.ptrn) in binary (8 bits/byte), hex (4 bits/byte), or
01 (1 bit/byte) format

• ASCII Pattern Files (*.txt)

See “Pattern File Specifications” on page 28 for descriptions of
these file types.

If you want to save the pattern file in one of the 12 memory slots,
use the file names from UPAT1.ptrn through UPAT12.ptrn
respectively.

Loading Patterns to the Pattern Generator and Error Detector

The recommended way to load the data patterns to the pattern
generator and error detector is to use the Pattern Select Form dialog
box.
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1 Press the Pattern Select icon in the Pattern menu.

The Pattern Select Form dialog box opens.

2 Select one of the following pattern types for the pattern
generator, and follow the next required action as listed below.

Table 4

Pattern Type Next Required Action

User Pattern Browse for the desired pattern file.

Memory User Pattern Select memory slot (1 - 12).

2^n -1 PRBS Select the pattern size.

2^n PRBS Select the pattern size.

Mark Density Select the pattern size and the mark
density ratio.

Zero Sub Select the zero substitution rate.

Sequence Enable this checkbox if you intend
to download a user-defined
sequence. Patterns generated
within a sequence are defined in
the Sequence Editor.

N O T E Your instrument also contains user patterns that mimic real data packets and are
designed to stress specific characteristics of your device. For more information, see
“Example Patterns” on page 33.

3 If you want to select a different pattern for the error detector,
clear the checkbox Error Detector Pattern tracks the Pattern Generator
Pattern. The Error Detector Pattern tab appears. Switch to this tab
and repeat step 2.

4 Click OK to finish.

The selected patterns are immediately loaded to the pattern
generator and error detector. The types of patterns that are
currently loaded to the pattern generator and the error detector are
always displayed in the lower left corner of the screen.
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Loading Patterns Directly from the Pattern Editor

After you have finished editing a pattern in the pattern editor, you
can load this pattern directly to the pattern generator and error
detector.

N O T E Keep in mind that your modifications in the Pattern Editor do not affect the pattern
at the pattern generator or error detector until you download the pattern to the
pattern generator/error detector.

1 First determine whether the pattern generator and error detector
should use the same pattern. Press the Pattern Select icon in the
Pattern menu.

The PatternSelectForm dialog box opens.

2 Select Error Detector Pattern tracks the Pattern Generator Pattern if you
want both modules to receive the same pattern.

3 Click OK to close this dialog box.

4 The pattern editor now displays the following buttons in the
toolbar:

If you chose that both the error detector and pattern generator
use the same pattern:

Loads the current pattern to both
the pattern generator and error
detector.

If you allowed different patterns for the two modules:

Loads the current pattern to the
pattern generator.

Loads the current pattern to the
error detector.
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User Patterns - Reference

The elements of the pattern editor and all dialog boxes that can be
opened from the pattern editor are described below:

Edit Pattern Window

The Edit Pattern window provides the following convenient pattern
editing functions:

Table 7

Icon Name Description

Toolbar Ctrl Click this icon to switch
the toolbar from two rows
to a single row
appearance, leaving more
space for the pattern data.

New Click this icon to create a
new pattern. See
“Creating New Patterns”
on page 39 for details.

Open Click this icon to open a
pattern from a file. See
“Opening Existing
Patterns” on page 40 for
details.

Save Click this icon to save the
current pattern. If it was
not previously saved, a
Save As dialog box opens
for you to specify name
and path for the file.

To PG Click this icon to send the
pattern from the editor to
the pattern generator.

To ED Click this icon to send the
pattern from the editor to
the error detector.
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Table 7

Icon Name Description

To PGED Click this icon to send the
pattern from the editor to
the pattern generator and
the error detector.

Cut/

Copy/

Paste/

Delete/

Undo

These functions follow
Microsoft Windows
conventions.

Go To Click this icon if you want
to jump to an arbitrary bit
position. See “GoTo Bit
Dialog Box” on page 47
for details.

INS/

OVR

Click this icon to toggle
between the insert and
overwrite editing mode:

With Insert mode you
insert bits at the cursor
position, shifting the rest
of the pattern to the right.

With Overwrite mode you
overwrite the bits at the
cursor position.

Hex/

Bin

Click this icon to toggle
between viewing the
pattern in hex or binary
mode.

Properties Click this icon to change
the properties of the
current pattern. See
“Pattern Properties Dialog
Box” on page 48 for
details.
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Table 7

Icon Name Description

Find Click this icon to open the
Find Pattern Segment
dialog box and search for a
specified segment in the
pattern. See “Find Pattern
Segment Dialog Box” on
page 48 for details.

Insert Click this icon to insert a
block of data in the pattern
at the current cursor
position. See “Insert Block
Dialog Box” on page 48
for details.

Select

All

Click this icon to select all
the bits in the pattern.

Alt Pat

View

Click this icon repeatedly
to view alternating
patterns in the following
ways:

- Pattern A only

- Patterns A and B in
interleaved rows

- Patterns A and B in
horizontally split windows

If only a standard pattern is
selected, this icon has no
function.

Pat

Sel

Click this icon to open the
Pattern Select Form
dialog box. For more
information, see “Loading
Patterns to the Pattern
Generator and Error
Detector” on page 41.
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T I P If you are working on a remote PC, you can use the keyboard shortcuts for Cut, Copy,
and Paste. Also, you can use the clipboard function to copy strings in either binary
or hex format to and from other applications. When pasting them into the pattern
in binary view, a 1 sets a single bit, in hex view, a 1 sets 4 bits.

Pattern Editor Canvas and Status Bar

The pattern editor canvas displays the pattern and offers you to
edit it.

The status bar below the editor canvas provides the following
information from left to right:

• Status Offline, indicating that this is the display of the editor, not
the pattern generator nor the error detector

• Current Position in bits of the cursor in the pattern

• Editing mode ( Overwrite or Insert)

• Display mode ( Hex or Bin)

• Mark Density of the pattern(s)

• Total Length of the pattern (in bits)

The available functions to change the view and to modify the
pattern are described in “Edit Pattern Window” on page 44.

GoTo Bit Dialog Box

This function allows you to set the cursor to an arbitrary position
in the pattern. Enter the bit position (=address) and click Go!. The
cursor is placed in front of the character with the selected bit. You
can continue editing the pattern while this dialog box is still open.
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Pattern Properties Dialog Box

The Pattern Properties dialog box always opens when you create a
new pattern. It can also be used to view or change the attributes
of the currently selected pattern.

T I P You can use your instrument's software keyboard to enter text in the dialog box.
For more information, see “Using the On-Screen Keyboard” on page 387.

This text field allows you to enter a description of the pattern's
characteristics or purpose. It can be up to 256 characters long.

Select Standard if you want to use this pattern as a standard pattern.
Select Alternate if you want to define two alternating patterns A and
B.

This text field allows you to enter the pattern length.

To find out more about appropriate pattern lengths, see “Pattern
Resolutions and Lengths” on page 30.

Find Pattern Segment Dialog Box

The Find Pattern Segment dialog box allows you to search for a
specified bit sequence in the pattern. If you click Next, the next
occurrence of this bit sequence is highlighted.

The search pattern can be entered in either hex or binary format,
independently of the currently displayed format in the pattern
editor. You can continue editing the pattern while this dialog box
is still open.

Looks for the next occurrence of the pattern from the current
position to the end. If there is no further occurrence, the current
selection does not change.

Click this button to close the dialog box.

Insert Block Dialog Box

The Insert Block function provides an easy way to modify parts of
the pattern or the entire pattern at once. This can be used when
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setting up a new pattern. It can also be used as an optional
technique for editing existing patterns.

With the Insert Block dialog box, you define the Range that is to be
modified and an Action that will be done to this range.

The available options for the Range are:

• Select All

Choose this option to select the entire pattern for editing.

• Range

Choose this option to select the range of bits specified by the bit
positions entered in the From and To fields.

• Fill From Cursor to End

Choose this option to select the bits from the cursor location to
pattern end.

• Fill From Start to Cursor

Choose this option to select the bits from pattern start to the
cursor.

The available options for the Action are:

• 0101...0101

Choose this option to fill the range with alternating highs and
lows.

• Invert Bits

Choose this option to invert the high/low logic in the range.

• All Zeros

Choose this option to fill the range with all logic lows.

• All Ones

Choose this option to fill the range with all logic highs.

Status Bar

The types of the patterns that are currently loaded to the pattern
generator and the error detector are always displayed in the left
half of the status bar at the bottom of the screen.
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Select Pattern Dialog Box

This dialog box lets you define the pattern you want to use for
testing. It contains the following elements:

With this checkbox you can determine whether both pattern
generator and error detector use the same data pattern.

If you clear this checkbox, the Error Detector Pattern tab appears,
where you can select a different pattern for the error detector.

The checkbox is automatically cleared when you load a user-defined
sequence to the pattern generator. See “Sequence Mode
Characteristics” on page 58 for details.

You can choose between the following types of patterns:

• User Pattern from File

With this option, you can load a pattern that is stored in a file.
Use the Browse button to select the desired file.

• Memory User Pattern

The Serial BERT  supports 12 so-called memory slots for storing
user patterns. The slots are stored in files named Upat1.ptrn to
Upat12.ptrn. To load a pattern that is stored in one of these
memory slots, choose this option and select the desired slot from
the list.

• 2^n -1 PRBS

Select this option to use a hardware-generated pattern of length
2^n-1. See “How the Hardware Generates PRBS” on page 54
for details.

• 2^n PRBS

Select this option to use a memory-based pattern of length 2^n.

• Mark Density PRBS

Use this options to generate memory-based 2^n PRBS patterns
with specified mark densities. Select the desired value from the
list. The available values are 1/8, 1/4, 1/2, 3/4, and 7/8.

• Zero Sub PRBS

Use the Zero Substitution function to insert a longer row of zeros
into a memory-based 2^n PRBS pattern. The length of the zero
row can be freely specified up to the length of the pattern.
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You can select the pattern size according to your needs. The pattern
lengths available depend on the type of signal you have selected.

Enable this checkbox if you wish to use a user-defined sequence.
The patterns used in a sequence are defined in the Sequence Editor
(see also ).

Only available on the Error Detector Pattern page. Enables the error
detector's bit recovery mode. For details see “Understanding Bit
Recovery Mode” on page 121.

Software-Generated PRBS

Software-Generated PRBS - Concepts

Software-generated patterns are PRBS patterns that can be
modified. They are calculated by the Serial BERT  software and then
loaded to the memory, from which the necessary output is
generated. As such, they are closely related to user patterns, with
the exception that they cannot be edited in the Pattern Editor window.

When to Test with Software-Generated PRBS

You can use these patterns for any application where random data
and an even number of bits is required.

In addition, you can vary the mark density or zero substitution to
test the influence  on the BER . This allows potential problems like
baseline wander, for instance, to be fully characterized.

How the Software Generates PRBS

When you set up a software-generated pattern, the Serial BERT
calculates the required pattern and loads this into the memory.
From here, the memory is read bit by bit (identically as for
memory-based patterns), and the corresponding output is
generated.

See also “How the Serial BERT Generates Memory-Based Patterns”
on page 31.
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Range of Software-Generated PRBS Patterns

The Serial BERT  supports the following 2^n PRBS patterns:

Table 8

n Sequence Length Longest Run of 1's Longest Run of 0's

7 128 7 7

10 1,024 10 10

11 2,048 11 11

13 8,192 13 13

15 32,768 15 15

23 8,388,608 23 23

Zero Substitution Patterns

A potential risk to bit errors are longer rows of zeros within a data
stream. The longest run of zeros in a 2^n PRBS consists of n zeros.

The Zero Substitution function can be used to stress the DUT
additionally by inserting a longer row of zeros in the data stream.
The length of the zero row can be freely specified, up to the length
of the pattern.

The following figure shows an example, where a run of 10 zeroes
is inserted into a PRBS 2^7 pattern.

*ZRUNRun of 0s

0000000 101000100

0000001000000 110PRBN

ZSUB

* Closing bit

Mark Density Patterns

The mark density of a pattern is the portion of bits that are ones.
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A pure PRBS pattern contains an equal number of ones and zeros
and, thus, has an average voltage in the center between high and
low level. Therefore, the mark density of such a pattern is 1/2.

Some devices may have problems processing data streams with
different mark density as this results in other average voltages and,
thus, different electrical conditions.

The ones (mark) density can be varied to put the pattern out of
balance in a randomly distributed way. This may be useful for
systems that are AC-coupled. This helps to check for effects such
as baseline wander.

To test these cases, the Serial BERT  provides PRBS patterns with
the mark densities 1/8, 1/4, 1/2, 3/4, and 7/8.

Software-Generated PRBS - Procedures

The recommended way to load the data patterns to the pattern
generator and error detector is to use the Pattern Select Form dialog
box.

See “Loading Patterns to the Pattern Generator and Error Detector”
on page 41 for details.

Software-Generated PRBS - Reference

Use the Pattern Select dialog box to select the pattern (s) you want
to write to the pattern generator and the error detector . See “Select
Pattern Dialog Box” on page 50 for details.

Hardware-Generated PRBS

Hardware-Generated PRBS - Concepts

This section describes the basics of hardware-generated PRBS 2^n
-1 patterns.
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When to Test with Hardware-Generated PRBS Patterns

You can use the Serial BERT 's hardware-generated PRBS patterns
if you require simple random traffic for testing your device. The 2^n
-1 odd pattern lengths are not related to the divided clock rate.
When using an oscilloscope, this will ensure that the random
contents of the bit stream is sampled.

The spectral contents of PRBS 2^n -1 patterns and the special
property of decimation may also be useful in many applications (for
example, for multiplexer or demultiplexer testing).

How the Hardware Generates PRBS

2^n -1 PRBS is an inverted, hardware-generated pattern that is
created by a series of shift registers with adjustable feedback. The
example below shows the register configuration for a 2^7 -1 (127-
bit) pattern.

The following table describes the operation of XOR'ing two points
for the different patterns.

Table 9

Sequence Length Shift-Register Configuration

27-1 D7 + D6 + 1 = 0, inverted

210-1 D10 + D7 + 1 = 0, inverted

211-1 D11 + D9 + 1 = 0, inverted

215-1 D15 + D14 + 1 = 0, inverted

223-1 D23 + D18 + 1 = 0, inverted

231-1 D31 + D28 + 1 = 0, inverted
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Range of Hardware-Generated PRBS Patterns

The following table lists the hardware-generated 2^n -1 PRBS
pattern lengths that correspond to different n values. This is before
the pattern is finally inverted.

Table 10

n Sequence Length Longest Run of 1's Longest Run of 0's

7 127 7 6

10 1,023 10 9

11 2,047 11 10

15 32,767 15 14

23 8,388,607 23 22

31 2,147,483,647 31 30

Decimation of PRBS Patterns

A special property of 2^n -1 PRBS patterns is that they can be
demultiplexed into the same patterns at slower speeds with
different phases. This is also true for multiplexing. The demux or
mux must have n ports.

Hardware-Generated PRBS - Procedures

The recommended way to load the data patterns to the pattern
generator and error detector  is to use the Pattern Select Form dialog
box.

See “Loading Patterns to the Pattern Generator and Error Detector”
on page 41 for details.
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Hardware-Generated PRBS - Reference

Use the Pattern Select dialog box to select the pattern(s) you want to
write to the pattern generator and the error detector. See “Select
Pattern Dialog Box” on page 50 for details.

User-Defined Sequences

User-Defined Sequences - Concepts

This section describes the basics of user-defined sequences.

A sequence is created and maintained by means of the Sequence
Editor that can be enabled from the Pattern window.

A sequence consists of up to four blocks. Each block can generate
a pause signal (constant 0 or 1), a divided clock signal, a 2^n -1
PRBS, or a user pattern.

Single or multiple blocks can be looped. An overall loop restarts the
sequence after it has come to its end.

When to Use a Sequence

You may wish to test a device that uses a certain protocol for
processing data.

For example, the device might expect synchronization data, a
preamble, payload data, and a suffix.

All this can be provided by a user-defined sequence.

How a Sequence is Defined

The sequence is defined by a SequenceExpression which is
formulated in its own language, checked by the Sequence Editor.

The SequenceExpression specifies:

• the sequence start (and break) conditions

• the blocks, their contents, and trigger output

• the loops
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You can inspect the contents of the SequenceExpression in the
Properties dialog of the Sequence Editor.

The SequenceExpression uses the following keywords:

Version= optional

Description= optional

Start= optional

Block #= repeated for each block, numbered

Loop= repeated for every loop, not numbered

Example of a SequenceExpression:

Version= 1.0
Start= IMM
Block 1= PRBS11, 1024, TrigOn
Block 2= C:\N4903A\Pattern\Upat10.ptrn
Block 3= P0, 512, TrigOff
Loop= B1, B1, 2 

Default is IMM = immediately after downloading the sequence to the
pattern generator. Other options are:

• AuxInHi | AuxInLo: Sequence starts when Auxiliary Input is
high or low.

• AuxInRising | AuxInFalling: Sequence starts with a rising or
falling edge at the Auxiliary Input.

• Manual: Sequence starts when the Start button is clicked.

Default is pattern P0 (Pause0), a length of 512 bits, and Trigger On.
Other options are:

• Patterns: P1 (Pause1), undistorted PRBS, a user pattern from a
file, or a fraction of the clock pulse (divider range: 2 ... 127).

• Length: Must be 512 bits or a multiple thereof. Shorter or longer
user patterns are automatically repeated until the next 512-bit
boundary is reached (see also “How the Serial BERT Generates
Memory-Based Patterns” on page 31).

• Trigger: Refers to the pattern generator's Trigger Out port. If the
Trigger Out is set up to generate a divided clock pulse, the block
setting is ignored.
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But if the Trigger Out is set to "Sequence Trigger" and the block
to TrigOn, a trigger pulse is generated whenever the block starts
or restarts. No trigger is sent if the block is set to TrigOff.

See “Trigger Output - Procedures” on page 89 for information
on how to set the mode of the Trigger Out port.

Default is one overall endless loop for the whole sequence.

• Bn, B m: Define the start and end block of a user-defined loop.

Loops always define the transition from the end of a block to
the beginning of the same or a previous block. It is not possible
to jump into an existing loop. It is also not possible to specify
loops within loops (exept the default overall loop).

• Loop end condition: Default is an INFinite (endless) loop. Other
options are:

– AuxInHi | AuxInLo: Loop continues until Auxiliary Input is
high or low.

– AuxInRising | AuxInFalling: Loop continues until Auxiliary
Input receives a rising or falling edge.

– Manual: Loop continues until the Break button is clicked.

– Counted loop: Loop repeats a specified number of times.

Sequence Mode Characteristics

When a sequence is executed, the pattern generator is in " Sequence
Mode".

This mode differs from usual " Pattern Mode":

• Pattern-related triggers cannot be generated. In sequence mode,
the Trigger Out port can produce either a continuous pulse (a
fraction of the current clock pulse) or a trigger spike at the
beginning of each block that is set to TrigOn. The duration of
that spike depends on several conditions and is therefore
undefined.

• Software-generated PRBS with polynomial 2^n cannot be
referenced in a sequence.

• If several PRBS patterns shall be included, all have to use the
same polynomial.

• Every sequence has to be downloaded to the pattern generator
before it can be executed.

• Every sequence can be stored in a file and recalled from that
file. However, the SequenceExpression does not include user
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patterns. Recalling a sequence from its file may fail if the
referenced user patterns are not available.

A recalled sequence is not automatically downloaded to the
pattern generator.

• In sequence mode, the function "Error Dector Pattern tracks the
Pattern Generator Pattern" is automatically disabled. You have to
download the expected (payload) pattern to the error detector.

• During initialization of the sequence, pure zeros are sent.

User-Defined Sequences - Procedures

You can create a new sequence, save it in a file, or load a saved
sequence from its file.

Creating a New Sequence

If you wish to create a new sequence:

1 Choose Pattern and open the Sequence Editor.

By default, the Sequence Editor shows one block that is
automatically repeated. It has a length of 512 bits and generates
Pause0 data (pure zeros).

2 Click the Properties icon.

In the Properties window, set:

– the sequence start condition

– the number of blocks contained in the sequence (1 to 4)

3 Click Ok to close the Properties window.

4 Specify the data to be generated during execution of a block.

– Click the Edit button of the block.

– Choose from the list. For example, you can select a PRBS
polynomial or browse for a pattern file. A "None" block is
completely ignored.

– If necessary, change the block length. The block length of user
patterns is derived from the file. Remember that such
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patterns are automatically repeated until a multiple of 512
bits is reached.

– Decide on Trigger On or Off. This setting becomes effective if
the Trigger Out port is set to Sequence Trigger (trigger at block
begin).

5 Create loops (if desired):

– Click the out-arrow of a block. A loop condition box labeled
INF appears.

– Click the in-arrow of the same or a previous block. This
closes the loop.

– Click the condition box and choose the appropriate break
condition.

6 Download the sequence to the pattern generator and test it.

7 Save the sequence in a file for later re-use.

Saving the Sequence in a File

To save the present sequence under a new name:

1 In the toolbar, click the Save As icon.

2 Select a suitable directory, for example C:\N4903a\Sequences.

3 Enter a file name.

The filename extension is .seq by default.

If the present sequence was loaded from a file and edited, you can
also click the Save icon. In this case, the saved file is updated.

Loading a Sequence From a File

To recall a sequence from a file:

1 In the toolbar, click the Open icon.

The Open Sequence dialog box opens.

2 Use this dialog box to locate and open the desired sequence. The
browser shows all files with the suffix .seq in the selected
directory.
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N O T E The sequence is shown in the Sequence Editor, but NOT automatically downloaded
to the pattern generator. In contrast to loading a pattern from file, the download of
a sequence requires an additional command.

User-Defined Sequences - Reference

The elements of the Sequence Editor and the dialog boxes that can
be opened from the Sequence Editor are described below:

Sequence Block Display

A new sequence consists of one block that is infinitely repeated
(looped). By default, this block has a length of 512 bits and
generates a Pause0 signal (a continuous stream of zeros). All this
is shown on the display.

The vertical waveform at the left-hand side of the block indicates
the setting of the pattern generator's Trigger Out port. By default,
it generates a pulse, a subrate of the present clock. For information
on how to change the trigger behavior, see “Sequence Trigger at
Block Begin” on page 62.

Number of Blocks

In the Blocks field, you can directly increase (or decrease) the
number of blocks (range is 1 to 4).
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In this example, the number of blocks has been set to three. A
"None" block generates no pattern and is completely ignored
(indicated by a straight vertical blue line).

Sequence Trigger at Block Begin

After downloading the sequence to the pattern generator, you can
also change the behavior of the Trigger Out port (for details see
“Sequence Trigger ” on page 91):

In the example above, the Trigger Out port has been set to Sequence
Trigger mode, and TrigOn is set for each block (as shown by the
vertical trigger indicator).

Edit Button of a Block

To change the contents of a block, click its Edit button. This opens
the Set Data Block Parameter dialog.

Sequence Block Parameters

The Set Data Block Parameter dialog allows you to change the contents
and the trigger generation of a sequence block.

Choices are:

• None: The block may be present in the sequence but is
completely ignored.
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• Pause0: Pure zeros are generated when the block is executed. You
can change the block length, if desired.

• Pause1: Pure ones are generated when the block is executed. You
can change the block length, if desired.

• PRBS: You can choose a PRBS of polynomial 2^n -1. The range
of "n" is 7, 10, 11, 15, 23, or 31. You can change the block length,
if desired.

• Pattern: You can open a browser and search for the file that
contains the pattern. You can search for files with the
extentions .ptrn, .txt, or .dat.

If the pattern file contains two alternate patterns, you can also
specify whether the A or B pattern shall be generated (see also
“Pattern File Specifications” on page 28). If the pattern file
contains just one pattern, your choice is ignored.

You cannot change the block length. It shows the length of the
pattern as stored in the file.

If the pattern length is not 512 bits or a multiple of 512 bits and
this single block is looped, the behavior depends on the loop end
condition.

If the loop end condition is INFinite or determined by the Aux
In port, then the pattern is automatically repeated until 512 bits
or a multiple thereof is reached.

In this case, the duration of the block will be longer than
indicated. For example, a pattern containing 17 bits will be
repeated 512 times and the actual block length will be 8704 bits.
This has an impact on the trigger at block start.

If this checkbox is enabled, a trigger spike will be output at the
pattern generator's Trigger Out connector whenever the execution
of the block begins, provided that the Trigger Out port is set to
Sequence Trigger mode (see also “Sequence Trigger ” on page 91).

Loops Within a Sequence

A loop defines the transition from the end of a block to the
beginning of the same or a previous block. It is not possible to jump
into an existing loop. It is also not possible to specify loops within
loops (exept the default overall loop).

For information on how to create a loop, see “Creating a New
Sequence” on page 59.
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Every loop has a delete button [×] and a loop condition button.

Clicking the delete button [×] removes the loop from the sequence.

The initial (default) setting of the loop end condition is INF(inite),
which means, this loop will continue until the instrument is
switched off. Clicking the loop end condition button allows you to
specify the loop end condition.

Choices are:

• Counted: The loop ends after the specified number of repetitions.
Sequence execution continues with the next block.

• Infinite: An infinite loop can be broken by:

– Aux In High | Aux In Low: The loop ends when Auxiliary Input is
high or low. Sequence execution continues with the next
block.

– Aux In Rising | Aux In Falling: The loop ends when a rising or
falling edge at the Auxiliary Input is detected. Sequence
execution continues with the next block.

– Manual: The loop ends when the Break button of the Sequence
Editor is clicked. Sequence execution continues with the next
block.

N O T E The pattern generator reacts on the end condition as soon as the pattern has
finished.
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Sequence Editor Toolbox

The Sequence Editor toolbox provides the following functions:

Table 12

Icon Name Description

New Click this icon to create a
new sequence. This opens
the Properties dialog. See
“Creating a New
Sequence” on page 59 for
details.

Open Click this icon to open a
sequence from a file. See
“Loading a Sequence From
a File” on page 60 for
details.

Save Click this icon to save the
current sequence in its
original file.

Save As Click this icon to save the
current sequence in a new
file. A Save As dialog box
opens for you to specify
name and path for the file.
See “Saving the Sequence
in a File” on page 60 for
details.

To PG Click this icon to download
the sequence from the
Sequence Editor to the
pattern generator.

From PG Click this icon to upload
the present sequence from
the pattern generator to
the Sequence Editor. This
allows you to inspect and
edit a sequence that has
been loaded with a
program.
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Table 12

Icon Name Description

Properties Click this icon to change
the properties of the
current sequence. See
“Setting Sequence
Properties” on page 66
for details.

Break Click this icon to terminate
an infinite loop that is set
to "manual" break
condition. Sequence
execution continues with
the next block.

Resume Click this icon to interrupt
and re-initialize a running
sequence.

If the sequence start
condition is IMMediate,
the sequence restarts
immediately.

If the sequence start
condition is a signal at the
Aux In port, the sequence
restarts upon the specified
signal.

If the sequence start
condition is "Command",
sequence execution starts
when the Start button is
clicked.

Setting Sequence Properties

For a sequence, you can specify the following:

Choices are:

• Immediate: Sequence starts immediately after downloading it to
the pattern generator.
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• Aux In High | Aux In Low: Sequence starts when Auxiliary Input is
high or low.

• Aux In Rising Edge | Aux In Falling Edge: Sequence starts with a rising
or falling edge at the Auxiliary Input.

• Command: The Sequence Editor shows a Start button. Sequence
execution starts when this button is clicked.

A sequence can contain 1 to 4 blocks.

A field for entering and editing descriptive text.

A window that shows the present SequenceExpression (for details
see “How a Sequence is Defined” on page 56).

You can edit the SequenceExpression in this field. Any changes
override the previous settings.

N O T E If you edit the SequenceExpression manually, take care to adhere to the syntax and
order of the keywords.

Remember that you must download the updated sequence to the pattern generator
if your changes shall take effect.

Start Button

The Start button of the Sequence Editor indicates that the sequence
has been set up for manual start.

Click this button to start the sequence execution.
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3 
Setting up the Pattern Generator

Setting up the Pattern Generator - Concepts

The Serial BERT 's pattern generator generates an output signal
based on a data pattern. It has the following possibilities for
generating an output signal:

• Providing a wide range of clock frequencies

You can use the pattern generator's internal clock or an external
clock for defining the frequency of the outgoing stream.

• Distorting the signal by adding jitter

You can connect an external delay control device (for example a
function generator) to add jitter to the generated signal.

• Adding errors to the output stream

The Serial BERT  can be set up to insert errors into the outgoing
stream either internally, according to an external signal, or
manually (from the operator).

• Run-time switching between two patterns

You can set up two patterns and switch between them during
runtime either automatically, according to an external signal, or
manually.

• Suppressing the output stream

The output signal can be suppressed according to an external
signal.

The pattern generator also provides output ports that let you
connect an external instrument, such as an oscilloscope.

Agilent J-BERT N4903 High-Performance Serial BERT
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Input and Output Ports

Input and Output Ports - Concepts

The pattern generator's input ports are used to set the pattern
generator's clock frequency and to manipulate the output signal
with respect to jitter, error insertion and signal output.

The pattern generator's output ports are used to supply a clock
signal and trigger for another device (for example, for the Serial
BERT's error detector),  and an arbitrary data signal for testing your
device.

The pattern generator has the following inputs and outputs:

Understanding the Pattern Generator's Input Ports

The pattern generator provides the following input ports:

• 10 MHz Ref In

This connector allows you to connect a 10 MHz reference clock.
The Serial BERT  has a 10 MHz Ref In and Out port at the rear
(two BNC connectors).

• Clock In

Allows you to connect a clock signal from another device.

3 Setting up the Pattern Generator

70 Agilent J-BERT N4903 High-Performance Serial BERT

Input Ports

Output Ports



• Error Add

Allows you to connect a device that generates a trigger for
inserting a single bit error in the output stream.

• Delay Control In

Allows you to connect a signal for generating jitter in the data
outputs.

• Aux In

The signal at the Aux In port can be used to switch between
patterns A and B or to "blank" (suppress) the output signal.
When a user-defined sequence is executed, it can also be used
to control the sequence execution.

Understanding the Pattern Generator's Output Ports

The pattern generator provides the following output ports:

• Data Out and Data Out

The data outputs serve as device stimuli and can be set up so
that they are compatible with a variety of logic families. With
respect to Data Out, Data Out  has inverted logic.

• Clock Out and Clock Out

The clock outputs serve as frequency (bit rate) references and
can be set up so that they are compatible with a variety of logic
families. With respect to Clock Out, Clock Out  has inverted logic.

• Trigger Out and Trigger Out

This port allows you to connect a trigger for another device (for
example, an oscilloscope).

• Sub Clock Out and Sub Clock Out

This port allows you to generate a pulse with a frequency that
is a fraction of the present clock. Note that this output is not
phase-synchronized with the clock.

The complementary outputs can be used when:

• additional output capability is needed for an instrument such as
an oscilloscope or digital communication analyzer.

• your device requires differential inputs.

N O T E The pattern generator's Data Out and Clock Out ports must be terminated with
50 Ω if they are not connected.
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Understanding the Output Protection Algorithm

The generator module offers a huge flexibility for external
termination schemes and external termination voltages to address
common technologies. For details, please refer to the Technical Data
Sheet.

An internal protection algorithm continuously monitors the voltages
of clock and data output. It becomes active if the termination
voltage is wrongly adjusted.

N O T E The protection algorithm is not active if the termination voltage is higher than +1.5 V.

The protection algorithm sets the output voltages to safe levels:

• Vhigh = termination voltage +1 V

• Vlow = termination voltage +0.9 V

• termination voltage remains unchanged

As soon as a 50  Ω load and the correct external termination voltage
is detected again, the algorithm automatically switches back to the
user-adjusted output levels. These changes are neither visible in the
user interface nor can they be queried by a remote command.

Example:

User settings (with single ended operation):

Table 13

V high [V] V low [V] Term. [V] Termination of

Out Out

+ 2 + 1.2 - 0.5 50 Ω to - 0.5V wrongly left
open

An open condition is detected and the protection algorithm sets the
following levels:

Vhigh = +0.5 V and V low = +0.4 V

Next the complement output ( Out) is externally terminated with
50 Ω to GND. The protection circuit detects the correct external
terminations and resets the voltages to the initial user settings:

Vhigh = +2 V and V low = +1.2 V
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Understanding the Output Level Parameters

The following figure shows the parameters of a data or clock output
signal.

As shown in this figure, the signal output levels have the following
components:

• Vhi is the upper voltage level of the signal.

• Vlo is the lower voltage level of the signal.

• Vof is the offset of the average voltage level from 0 V.

• Vampt is the amplitude of the signal.

When adjusting the output levels, it is important to understand the
concept of how the Serial BERT  handles voltages.

Typically, during tests, when you adjust the amplitude, you want to
keep the offset constant. This keeps the ideal sampling point within
the eye. The Serial BERT  handles this by keeping V of constant when
Vampt is changed.

On the other hand, you may want to adjust the output voltage level
without changing the amplitude. The Serial BERT  handles this by
keeping V ampt constant when either V of, V hi, or V lo is changed.

The Serial BERT  cannot generate a signal that has voltage levels out
of range. If you try to enter a value for one parameter that would
put another parameter out of limits, the Serial BERT  rejects the
change. This could happen, for example, if V lo is already at the
minimum, and you try to lower either of V hi or V of, or increase
Vampt.
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Understanding Delay and Crossover

The Serial BERT  provides the possibility of modifying the output
data signal by varying the signal's delay to the clock signal, and the
signal's crossover.

The exact time delay through a test setup can vary. The delay
function allows you to compensate for this by adjusting the
frequency reference for the data outputs. This varies the phase
relationship of the data and clock outputs (causes the data pulse to
have a certain time delay after the clock pulse). The higher the
delay, the greater the time difference between the clock signal and
the data signal.

Crossover is the voltage level where the overlapped rising and
falling edges of the logic levels intersect. This adjustment varies the
widths of the logic highs and lows.

The following figure shows examples of crossover at 50 %, 80 %, and
20 %:

Understanding how the Serial BERT Uses Logic Families and
Terminations

The clock and data inputs of your device have load impedances (or
terminations). Clock and data terminations refer to the voltage
levels at the end of these loads. These voltage levels are related to
the logic family of your device. Your device should usually only
receive signals that are compatible with its termination voltage and
logic family.
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When you change a logic family for the data or clock outputs, the
termination voltage normally associated with the logic family is
automatically selected. This is assumed to be the termination of
your device, and will be used to determine the actual output voltage
levels of the pattern generator.

C A U T I O N If you manually change the termination, a warning message is shown, indicating
that the termination is not typically appropriate for the logic family. If you answer
No, the warning message closes with no changes to the terminations. If you answer
Yes, the data termination voltage is applied and the Logic Level is changed to
CUSTOM.

See also “Why Incorrect Terminations Could Damage Your Device” on page 76.

The following table lists the characteristics generally associated with
some logic families. All values are nominal.

Table 14

Logic Family Vhigh[V] Vlow[V] Ampl. [mV] Term. [V]

ECL - 0.95 - 1.7 750 - 2

SCFL 0 - 0.9 900 0

LVPECL + 2.35 + 1.6 750 + 1.3

LVDS + 1.425 + 1.075 350 + 1.250

CML 0 - 0.4 400 0

Terms:

• ECL

Emitter Coupled Logic

• SCFL

Source Coupled FET Logic

• LVPECL

Low Voltage Positive Emitter Coupled Logic (PECL Lite)

• LVDS

Low Voltage Differential Signaling

• CML
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Current Mode Logic

Why Incorrect Terminations Could Damage Your Device

Choosing wrong terminations may cause your device to output
voltage levels that are not as expected. It may also cause excessive
current or current flow in the wrong direction, which can damage
your device.

Note that an internal protection algorithm becomes active if both
the termination voltage is wrongly adjusted and the termination
voltage is below +1.5 V. The protection algorithm sets the output
voltages to safe levels:

• Vhigh = termination voltage +1 V

• Vlow = termination voltage +0.9 V

• termination voltage remains unchanged

AC Coupling and Bias Tees

The pattern generator's outputs are normally DC-coupled; even
when AC termination is selected. For this reason, extreme caution
must be taken when connecting your instrument to a device or test
setup.

The diagram below shows a device that is AC coupled. Notice that
the capacitor is part of the test setup.

You can use an external bias network (also known as a bias tee)
to power your device. You must ensure, however, that the network
is oriented correctly. If it is not, damage may occur to your device
or instrument.

The diagram below shows a bias tee that is positioned correctly.
Notice that the pattern generator's outputs are protected by the
blocking capacitor.
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Input and Output Ports - Procedures

You have to do the following to set up the pattern generator's
output ports:

Setting Logic Levels and Terminations

Before you can start sending signals to your device, you have to set
the logic levels and terminations:

1 Press PG Output Setup in the PG Setup menu.

2 In the Data Logic Level list, select the logic family that is
appropriate for the data input of your device.

3 In the Clock Logic Level list, select the logic family that is
appropriate for the clock input of your device.

When you modify the Data Logic Level or Clock Logic Level, the
instrument automatically sets the appropriate voltage levels and
the Termination voltage.

4 If necessary, change the data or clock termination voltage by
entering a new value. You can also use the front panel knob to
change the value.

The logic level automatically changes to Custom.

C A U T I O N Selecting the wrong terminations may damage your device. See “Why Incorrect
Terminations Could Damage Your Device” on page 76.

5 Connect the DUT's input ports to the Serial BERT 's output ports.
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C A U T I O N Do not apply external voltages to the pattern generator outputs. For more
information, see “AC Coupling and Bias Tees” on page 76.

Output ports of the pattern generator that are not connected to another device must
be terminated with 50 Ohm to prevent the Serial BERT from damage.

Note that for unconnected ports, an internal protection algorithm automatically
reduces the output voltages to safe levels.

Adjust Output Levels (optional)

Data and clock offset and voltage levels can be adjusted. This is
typically done when you want to tune your BER measurement or
stress the device.

You can use the knobs on the Serial BERT 's front panel to fine-tune
the data and clock amplitudes and offsets. If you want to set a
specific value, you can use the numeric keyboard.

To enter specific values for the data and clock outputs from the
keyboard:

1 Press PG Output Setup in the PG Setup menu to access the PG Output
Setup window.

2 Click into the field you want to change.

3 Enter the desired voltage using the numeric keyboard or the
respective front panel knob.

N O T E If the termination voltage is wrongly adjusted or the output ports are not connected,
an internal protection algorithm automatically sets the output voltage levels to safe
levels. Connect the output ports or change the termination voltage before adjusting
the output levels.

See “Understanding the Output Level Parameters” on page 73 for
information about how the Serial BERT  works with output level
parameters.

The following topics tell you how to use the pattern generator's
input ports:

• “Bit Rate - Procedures” on page 85

• “Delay Control Input - Procedures” on page 94

• “Error Addition/Insertion - Procedures” on page 95

• “Pattern Alternation - Procedures” on page 99
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Input and Output Ports - Reference

The pattern generator produces clock and data outputs that serve
as frequency reference and device stimulus for the device under
test.

N O T E The Serial BERT will not allow you to adjust a voltage beyond its limits. The limit is
determined by the Serial BERT's internal hardware. If a limit is encountered, the
Serial BERT sends a message to the status bar. For more information about voltage
limits, see the pattern generator's technical specifications.

Vhi

This text field allows manual entry of the logic high voltage level
and displays the current value.

To modify the value, click inside the text field and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob by the numeric keyboard to fine-tune the value.

See “Understanding the Output Level Parameters” on page 73 for
information about how the Serial BERT  modifies the output levels.

Vof

This text field allows manual entry of the voltage level halfway
between logic high and logic low (the offset) and displays the
current value.

To modify the value, click inside the text field and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob by the numeric keyboard to fine-tune the value.

T I P You can also adjust Vof with the Data Offset knob on the front panel.

See “Understanding the Output Level Parameters” on page 73 for
information about how the Serial BERT  modifies the output levels.
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Vlo

This text field allows manual entry of the logic low voltage level
and displays the current value.

To modify the value, click inside the text field and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob by the numeric keyboard to fine-tune the value.

See “Understanding the Output Level Parameters” on page 73 for
information about how the Serial BERT  modifies the output levels.

Vampt

This text field allows manual entry of the voltage amplitude and
displays the current value.

To modify the value, click inside the text field and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob by the numeric keyboard to fine-tune the value.

T I P You can also adjust Vampt with the Data Amplitude knob on the front panel.

See “Understanding the Output Level Parameters” on page 73 for
information about how the Serial BERT  modifies the output levels.

Delay

This text field allows manual entry of data output delay and
displays the current value in picoseconds.

To modify the value, click inside the text field and either:

• Enter the desired value directly with the numeric keyboard.

• Use the knob by the numeric keyboard to fine-tune the value.

T I P You can also adjust delay with the Data Out Delay knob on the front panel.

Xover

This text field allows manual entry of the crossover percentage, and
displays the current value. To modify the value, click inside the text
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field and enter the desired value directly with the numeric keyboard
or use the front panel knob to fine-tune the value.

Data Polarity Inverted

Select this checkbox to invert the logic of both data outputs.

Data and Clock Logic Levels

You can quickly set up an output signal that is compatible with
your device by selecting a logic family from the Logic Level list.

Select the logic family you want to use for the data and clock
outputs. When you select a family, the corresponding signal voltage
levels and the Termination for this family is automatically selected.

N O T E When you select Custom, there are no changes in the expected terminations.

See “Understanding how the Serial BERT Uses Logic Families and
Terminations” on page 74 for additional information.

Data and Clock Terminations

Use the Data Termination and Clock Termination checkboxes to toggle
between true differential DC coupling and center tapped
termination. In center tapped mode, you can specify the termination
voltage.

The Data Termination and Clock Termination fields are used to set the
termination voltage. When you select a Data or Clock Logic Level, the
terminations are set accordingly. It is recommended that you keep
the default values of the terminations.

See “Understanding how the Serial BERT Uses Logic Families and
Terminations” on page 74 for additional information.

0V (Disable)

C A U T I O N Before clicking this button, ensure that your device's inputs tolerate ground
potential.
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Use this button to clamp both the pattern generator's output ports
(data and clock) to ground. You can see the status of the outputs
in the display area of the pattern generator.

Note that you can also use the buttons below the display to enable
or disable this function for data and clock separately.

This function can be useful in case you want to connect or
disconnect a device to any of the output ports to prevent any
damage.

Output Blanking

When the generator is set up to generate a pattern, use this
checkbox to activate the Aux In port of the pattern generator. You
can then connect a signal to this port and operate the pattern
generator in output blanking mode.

If a logic low signal is supplied to the Aux In port, pattern A is sent
to the output port. If a logic high is supplied, no data is sent to the
output port.

This function is the same as the output blanking function in the
Alternate Pattern Control dialog box (see “Aux In” on page 103 for
details). However, this function also works with standard patterns.

When the generator is set up to generate a sequence, this checkbox
is disabled. You can connect a signal to the Aux In port of the
pattern generator. The reaction on this signal (for example, start
sequence execution, or break loop) is defined in the
SequenceExpression. For details see “User-Defined Sequences -
Concepts ” on page 56.

Bit Rate

Bit Rate - Concepts

Bit rate is defined as bits per second. The pattern generator's clock
rate sets the bit rate and serves as the frequency reference for the
clock and data outputs , your device, and the error detector (if it
receives its clock from the pattern generator) . It can be generated
internally or supplied from an external source.
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When to Use an External Clock Source?

The Serial BERT 's internal clock can be used for most testing
purposes. There are some circumstances, however, when an external
clock source is required:

• Synchronization with an external clock

The Serial BERT  can be connected to an external clock to allow
it to run as part of a larger external system.

• Use of a modulated clock

A frequency- or delay-modulated clock can be used to provide
a small amount of jitter to the clock signal.

• Use of a precision clock

A precision clock with very low phase noise can be used to
enhance the instrument's performance. This is especially
interesting for long-term measurements.

• Testing at bit rates < 620 Mb/s

The Serial BERT 's clock cannot be used for bit rates below
620 Mb/s.

Bit Rate Range

The Serial BERT  provides bit rates from 150 Mbit/s up to 12.5 Gbit/
s, depending on the instrument's options.

However, several specific properties and limitations need to be
taken into account when working at low bit rates. The limitations
apply to the instrument according to the following hysteresis curve:

• If the bit rate falls below 615 Mbit/s, the limitations apply.

• If the bit rate exceeds 620 Mbit/s, the limitations no longer
apply.

The following figure clarifies the behavior in the range between
615 Mbit/s and 620 Mbit/s:

615 Bitrate [Mbit/s]

620

Limitations do not apply
in this range

Limitations apply
in this range
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For the pattern generator the following rules apply:

• Below 620 Mbit/s, the pattern generator can only be operated
with an external clock source, because the internal clock source
can only produce signals higher than 620 Mbit/s.

• The trigger output cannot be set up to trigger on certain pattern
positions or pattern sequences. If this option is enabled (for
example in the user interface), the trigger is sent once for each
pattern, but the bit position cannot be specified.

The option to trigger on the divided clock signal is supported as
usual.

• There are restrictions to the available clock to data delay values.

The pattern generator can vary the clock to data delay only
within a range of -750 ps to 750 ps (relative to the clock signal).
For frequencies above 666 Mbit/s, this range is sufficient to
cover the complete clock cycle (= 1 unit interval).

For lower frequencies, the valid data delay range is smaller than
the clock cycle. The pattern generator cannot generate signals
with a delay outside this range. Therefore, the data delay cannot
be set to all values within the clock cycle.

Clock 500 Mbit/s

Valid Range for
Data Delay

2 ns

Valid Data Delay

0 750 ps-750 ps

If the clock frequency falls below this threshold, the current data
delay value is checked for validity. If the delay does not fall in
the valid range, it will be moved into the valid range. All
subsequent changes to the data delay will be checked for validity
and rejected if invalid.

Spread Spectrum Clocking

A Spread Spectrum Clock (SSC) is widely used for reducing the
peak electromagnetic radiation at the nominal clock frequency. With
SSC, the clock pulse is modulated with a relatively low-frequency
triangle waveform. This broadens the clock signal spectrum and
reduces the peak energy.
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The Serial BERT  has a built-in SSC generator. This is a licensed
option. For information on how to enable this feature, see
“Installing Hardware Options - Procedures” on page 391.

The Serial BERT 's implementation keeps the specified clock rate as
a maximum. It modulates the specified clock rate towards lower
frequencies, as illustrated in the following figure.

Deviation and modulation frequency can be specified.

N O T E SSC and sinusoidal jitter are mutually exclusive. For details see “How the N4903
Generates Jitter” on page 319.

Bit Rate - Procedures

You can use an external clock source or the Serial BERT 's internal
clock to control the bit rate.

To set the bit rate:

1 If the external clock source has a frequency of 10 MHz, connect
the clock source to the pattern generator's 10 MHz Ref In port.
If the clock has another frequency, connect it to the Clock In
port.

2 Click the Bit Rate Setup icon in the PG Setup menu.

3 Select the appropriate clock source:

– Internal Clock Source

This setting uses the internal clock oscillator.

– 10 MHz Reference Clock

This locks the clock generator to an external 10 MHz
reference.
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– External Clock Source

This connects the external clock directly to the clock
generator.

4 If you have chosen an External Clock Source, decide between
manual or automatic mode.

– In automatic mode, the clock rate of the external source is
automatically measured and used. If the source frequency
varies, the generated clock varies as well.

– In manual mode, you can measure and set the rate of the
external clock source by clicking the respective button. If the
source frequency varies, you will be alerted.

5 Select a clock rate:

– For Internal Clock Source, you can either select a clock rate from
the Presets list, or enter a clock rate in the Value and Units field.

– For 10 MHz Ref Clock Source, the clock rate connected to the
10 MHz Ref In port must be 10 MHz.

The selected clock rate applies to the pattern generator. This is
also the clock rate generated at the pattern generator's Clock Out
port.

If the error detector receives its clock from the pattern
generator, it runs at the same clock rate.

6 If you wish to use the pattern generator's Sub Clock Out port,
set the Subrate Clock Divider to a suitable value (between 2 and
128).

Bit Rate - Reference

The Bit Rate Setup window contains the following elements:

Clock Source

Clock source can be one of the following:

• Internal: The clock generator uses the internal oscillator.

• 10 MHz Ref: The clock generator uses the 10 MHz Reference that
must be connected to the 10 MHz Ref Input.

• External: The pattern generator uses the external clock that must
be connected to the Clock Input. You can choose between
“Automatic and Manual Mode” on page 87.
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Automatic and Manual Mode

The Manual checkbox is available if you have chosen an external
clock source.

In automatic mode, the external clock frequency is continually
measured. When the external clock frequency changes, the bit rate
changes as well.

In manual mode, you can enter the expected frequency or press the
Measure & Set button. Measure & Set requires that the external clock
generator is connected and active. Its frequency is measured once
and determines the bit rate. When the external clock frequency
changes, PG Clock Loss is signaled.

Value and Units

This text field allows manual entry of the clock rate value. Click
inside this text field and use the numerical keypad or front panel
knob to enter a clock rate value. Complete the entry with a
frequency unit by pressing the G/n, k/m, M/µ, or X1 front panel key.

Preset List

The Preset list contains clock rate values that are commonly used
by the pattern generator.

Click a preset to select it for the pattern generator clock rate.

Double-click a preset to modify it.

Add Preset Button

Click this button to open the Enter Bit Rate dialog box and add a new
clock rate to the preset list. In this dialog box, you can enter a
value, unit and text description of the new clock rate.

Delete Preset Button

Select a preset clock rate in the Preset list and click this button to
remove it from the list. You can only delete presets that are user-
defined.
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Sub Rate Clock Divider

This setting controls the pattern generator's Sub Clock Out port.

The Sub Clock Out port is differential, always active, and generates
a fraction of the current clock. The range of the divider is 2, 3, 4,
5, ... 128.

Spread Spectrum Clock

Spread Spectrum Clocking is a licensed option. This setting controls
the pattern generator's spread spectrum (SSC) clocking feature.

When the SSC is enabled, it impacts the Data Out, Clock Out, Sub
Clock Out, and Trigger Out ports.

You can set the deviation from the specified clock frequency
towards lower frequencies.

For example, if you have set a bit rate of 8.5 GHz, a deviation of
0.5 % would result in a time-linear clock frequency variation
between 8.500 GHz and 8.4575 GHz.

The modulation frequency is generally around 30 kHz.

Clock Rate Indicators

The PG (Pattern Generator) and ED (Error Detector) clock rate
indicators in the status bar display their current clock rate.

• The ED clock rate is measured from the incoming clock signal
or derived from the data signal.
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Trigger Output

Trigger Output - Concepts

The pattern generator's Trigger Out port can be used to send a
reference signal (or trigger) to external devices like an oscilloscope
or digital communication analyzer.

In pattern mode, the pattern generator sends a trigger signal that
is at least 32 bits long. See also “How the Serial BERT Generates
Memory-Based Patterns” on page 31 for details.

In sequence mode, the pattern generator can send a trigger signal
whenever a block of the sequence starts or restarts. See also
“Sequence Block Parameters” on page 62 for details.

Several options are available for the trigger signal. As an example,
you can send the trigger as a divided clock signal or as an indicator
when the data pattern starts.

Trigger Output - Procedures

To set up the pattern generator's Trigger Output port:

1 Connect the external instrument to the Trigger Out port.

2 Click Trigger Output in the PG Setup menu.

3 Select the trigger pattern that you want to be generated.

See “Trigger Output - Reference” on page 90 for descriptions
of the available trigger signals.

N O T E If you have downloaded a user-defined sequence of patterns to the pattern
generator, the pattern-related settings are ignored. In this case, you can either set
up the Trigger Out port to generate a subrate of the present clock or to signal the
beginning of a sequence block (see also “Sequence Block Parameters” on page
62 for details).
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Trigger Output - Reference

You can always generate a divided clock signal at the Trigger Out
port. But if you wish to use the Trigger Out port for controlling
external equipment, please note that you can also generate a
divided clock signal at the pattern generator's Sub Clock Out port.

The alternate trigger signals refer to patterns and are not generated
in sequence mode.

To support the generation of a trigger spike at the beginning of a
sequence block, the Trigger Output can be put into Sequence mode.

Clock Divided by n

Select this option to send a trigger signal from the Trigger Out port
at every nth clock pulse. Note that the trigger signal itself consists
of n/2 bits high followed by n/2 bits low. For example, Clock divided
by 8 works as shown below.

Clock

Trigger Out

Alternate Pattern Trigger Level

N O T E This option applies for alternating patterns only.

Select this option to set the trigger level high whenever alternate
pattern B is sent.

The trigger output for 1024-bit patterns looks as follows:

Data Out A A B A B B A

Trigger Out

N O T E This pattern must be at least 1024 bits long.
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Alternate Pattern Trigger Pulse

Select this option to send a trigger pulse whenever the pattern being
sent changes (A to B or vice versa). For patterns with a length
divisible by 512, there is one trigger pulse sent for every pattern
repetition.

Data Out

Trigger Out

A B A B B

If the length of the pattern is not divisible by 512, a trigger is sent
whenever the pattern reaches a 512-bit RAM boundary.

Sequence Trigger

This checkbox becomes available after a user-defined sequence has
been downloaded to the pattern generator.

Click this checkbox to switch the Trigger Out port from Clock divided
by n to Sequence mode.

In Sequence mode, the Trigger Out can generate a spike whenever
the execution of a block starts or restarts. Whether that happens
for a particular block or not is defined for each block individually
in the SequenceExpression. See also “Sequence Block Parameters”
on page 62.

Pattern Trigger Position

N O T E This option is not available for alternate patterns.

Select this option to send a trigger signal that is synchronized to a
certain position in the pattern. Depending on the type of pattern
currently loaded in the pattern generator, you have to specify the
trigger position either according to Bit Position or N-bit Trigger
Pattern:

• Bit Position

If a memory-based pattern is loaded in the pattern generator,
you have to specify the bit in the pattern that sends the trigger.
The bit position can be in the range 0 ... Pattern Length - 1.

For pattern lengths that are divisible by 512 (such as 2^n PRBS
patterns), the trigger repetition rate is one pulse per pattern
repetition.
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Data Out

Trigger Out

Bit Pos.

A A A

For pattern lengths that are not divisible by 512 (such as some
memory-based patterns), a trigger signal is sent once at the
corresponding bit when the pattern reaches the 512-bit
boundary. If, for example, the pattern is 384 bits long, a trigger
signal is sent every 4th pattern repetition.

Data Out

Trigger Out

Bit Pos.

A0 A1 A2

A A A A A A A A A A A A

If the entered number is greater than the pattern length, the
entry is adjusted to the pattern length - 1. If you load a pattern
that is shorter than the entry in this field, the trigger will be set
to the next to the last bit in the pattern.

• N-bit Trigger Pattern

This option is used for hardware-generated PRBS patterns. You
can specify a pattern with n bit length. A trigger pulse is sent
when this pattern is found in the PRBS. The trigger repetition
rate is one pulse per 512 pattern repetitions.

Example:

Pattern length: 2^7-1 (127) bits

N-bit pattern: 1110001

Data Out

Trigger Out

10 1 . . . .1 1000100 10 11 1000100 . . . .

• Shift Trigger Position

Clicking the left and right buttons will move the bit trigger
position back and forward by one bit.
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Delay Control Input

Delay Control Input - Concepts

The Serial BERT  features a wide bandwidth voltage controlled delay
line in its pattern generator data path, which can be used to delay
the data relative to the clock. The delay is controlled by an external
signal connected to the Delay Ctrl In connector on the pattern
generator front panel.

The delay control input is intended primarily for jitter tolerance
testing, where a data signal with a defined amount of jitter is
needed. Random jitter (RJ) can be created by applying high
bandwidth white Gaussian noise, periodic deterministic jitter (DJ)
with sinusoidal (SJ) or rectangular/triangle signals (PJ).

The delay control input is most useful for the generation of high
frequency, low amplitude jitter. Higher amounts of jitter at lower
frequencies (wander) can be generated by supplying an FM
modulated clock to the pattern generator's clock input (Clk In) in
external clock mode.

N O T E At an Serial BERT on which the calibrated and integrated jitter injection option J10
is installed, the delay control input is rarely used as explained above. The option
J10 includes all the jitter sources required for jitter tolerance tests. For details see
“Jitter Tolerance Tests - Concepts ” on page 313.

The delay control input is equipped with overvoltage protection. If
the applied voltage is too high, the input is automatically disabled,
and the following dialog appears:

You can enable the input after reducing the voltage to safe level.
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Delay Control Input - Procedures

N O T E The following procedure does not apply to an Serial BERT on which the calibrated
and integrated jitter injection option J10 is installed. For such instruments refer to
“Jitter Setup - Procedures” on page 324.

To set up a jitter tolerance test on an instrument without option
J10:

1 Press PG Output Setup in the PG Setup menu.

2 Disable the Delay Control In port by clearing the Delay Control
Input checkbox.

3 Connect the device that supplies the jitter signal to the Delay
Control In port.

4 Enable the port again by selecting the Delay Control Input checkbox.

T I P While monitoring the BER you can use this checkbox to switch jitter on and off and
view the effect on the BER.

Delay Control Input - Reference

This checkbox in the PG Output Setup window is used to disable or
enable the Delay Control In port, where you can supply an external
signal to add jitter to the output signal.

N O T E This checkbox is not available on instruments on which the calibrated and integrated
jitter injection option J10 is installed. On such instruments, the Delay Control In port
is enabled or disabled from the Jitter Setup window.
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Error Addition/Insertion

Error Addition/Insertion - Concepts

To test error correction algorithms, alarms and other functions that
are imbedded in the data pattern, you can insert logic errors
(flipped bits) into the pattern.

The instrument provides several options (in the pattern generator's
Error Add dialog box) for inserting error bits manually or
automatically.

Error Addition/Insertion - Procedures

You have the following options for inserting errors into the output
data stream:

Manually Inserting Errors

To manually insert a single error into the output stream:

1 Click the Error Add button at the top of the screen to insert one
single bit error in the output stream.

This button is active unless you define a fixed internal error
rate. The maximum number of errors that this function supports,
is one error per 128-bit block.

2 If you want to disable all other error insertion functions, so that
only manual error insertion is possible, click the Error Add Setup
icon in the PG Setup menu to open the Error Add Setup dialog box.

3 Select Off and click OK to close the dialog box.
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Using an External Signal for Inserting Errors

To configure the Serial BERT  to insert a single error into the output
stream according to an external signal:

1 Connect an external instrument to the Error Add port.

The signals received at this port must be TTL-compatible.

2 Click the Error Add Setup icon in the PG Setup menu.

3 Select External (Error Add)and click OK to close the dialog box.

Now, upon a rising edge of the signal at the Error Add port, an
error will be generated in the output stream by flipping a single bit
within a bit block of 128 bits (resulting in a maximum BER of 1/128
or 10 -2).

T I P You can use an external signal to set up a bit error rate to fit your needs. The
frequency of the external signal can be calculated by multiplying the desired bit
error rate by the clock frequency.

If, for example, you want a bit error rate of 3x10-7 and you are running a test at 12.5
䠠 Gb/s, the frequency of the external signal is:

3x10-7 x 12.5x109 = 3750 Hz

Using the Serial BERT to Insert Errors

To configure the Serial BERT  to automatically insert errors in the
output stream to achieve a desired bit error rate:

1 Click the Error Add Setup icon in the PG Setup menu.

2 Select Internal.

3 Use one of the following options to define the Error Insertion
Rate:

– Error Rate allows you to select a BER from a list.

– Bits between Errors allows you to specify how many regular
(correct) bits are sent without errors before inserting the next
error.

4 Click OK to close the dialog box.
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T I P To find out how your DUT reacts on very small bit error rates, set up the pattern
generator to enter errors once every 10-12 bits and run a longer accumulative test.
You can then find the DUT's true error rate by calculating the difference between
the bit error rate set up in the pattern generator and the accumulated bit error rate
found by the error detector.

N O T E If you set up too high an error rate, the error detector will not be able to synchronize
to the incoming pattern. When setting up an error rate, always make sure that the
synchronization threshold is higher than the bit error rate.

Error Addition/Insertion - Reference

The following functions are available to insert errors in the bit
stream:

Error Add Button

The Error Add button in the top right corner is used to insert a single
bit error in the data stream.

This button is always active, even if other error insertion
mechanisms are running. The maximum number of errors that this
function supports is one error per 128-bit block.

Error Add Setup Dialog Box

The Error Add Setup dialog box provides the following configuration
options:

External (Error Add)

With this option selected, when a rising edge is detected at the
Error Add port, an error will be generated in the output stream by
flipping a single bit within a bit block of 128 bits.

The signals received at this port must be TTL-compatible.

Setting up the Pattern Generator 3

Agilent J-BERT N4903 High-Performance Serial BERT 97



Internal

Select this option to use internal error insertion functions:

• Error Rate

Allows to select from a preset bit error ratio from 1.000E-02 to
1.000E-09. Errors will be added to the output pattern to produce
this error ratio.

• Bits Between Errors

Allows you to enter the number of valid bits between two errors.
This is the inverse of the bit error ratio.

Off

Select this option turn off all internal add rates and external error
inputs. This allows you to manually add single errors by pressing
Error Add on the main display. This flips a single bit in the output
stream.

Pattern Alternation

Pattern Alternation - Concepts

This section explains the basic purpose of alternating patterns. Two
alternate patterns can be stored in one pattern file.

Note that you can also generate a sequence of up to four alternating
patterns (see “User-Defined Sequences - Concepts ” on page 56).

Standard and Alternating Patterns

With the Serial BERT , you have full control on the data stream that
is sent by the pattern generator to your device under test. You can
use standard patterns to specify a test data pattern that is sent to
your DUT repeatedly.

Or, you can use alternating patterns to specify two patterns that
are sent to the DUT alternately. To implement alternating patterns,
the instrument's user pattern memory is split into two portions; one
for pattern A and one for pattern B.
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The differences between these patterns are:

• Standard patterns consist of one single pattern that is
repeatedly sent. Any arbitrary pattern up to 32 䠠 Mbit length can
be set up. However, there are no further configuration
possibilities. This pattern is sent as long as the output port is
enabled.

See for more details.

• Alternating patterns consist of two patterns, one of which is
pattern A (the A half), the other is pattern B (the B half). Both
patterns are of equal length, each up to 16Mbit.

The Alternate Pattern Control dialog box lets you control when which
pattern is sent. See for details. See the online Help for details.

When to Use Alternating Patterns

Alternating patterns can be used:

• To systematically insert errors in the bit stream at particular
positions.

The error detector expects pattern A only. If you set up pattern
B so that there are only minor differences, when you run the
test, the error detector will detect the changed bits as errors.

• To see how long it takes your DUT to settle.

You can set up an easy-to-process output stream as the standard
pattern, and a difficult output stream as the alternate pattern
(for example, all 0s for the standard pattern, and alternating 1s
and 0s as the alternate pattern). You can then track how long it
takes for your DUT to recover after the alternate pattern has
been sent.

Pattern Alternation - Procedures

The Alternate Pattern Control dialog box controls how the output
stream switches between the standard pattern and the alternate
pattern.
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You have the following possibilities for setting up alternating
patterns:

Setting Up a Periodical Output

To configure the pattern generator to generate periodical data
output:

1 Press the Alt. Pattern and Aux Inicon in the PG Setup menu to open
the Alternate Pattern Control dialog box.

2 Select one of the following options:

– Continuous A

Only pattern A is output repeatedly.

– Continuous B

Only pattern B is output repeatedly.

– Alternate AB

The output stream switches between pattern A and pattern B.

– Single Shot B

With this option selected, the Insert B button is enabled.

3 Select OK when your selection is complete.

Manually Inserting Pattern B into the Output Stream

You can insert a single shot of pattern B into the continuous stream
of pattern A:

1 Press the Alt. Pattern and Aux Inicon in the PG Setup menu to open
the Alternate Pattern Control dialog box.

2 Select Single Shot B and click OK to close the dialog box.

3 During the test run, press the Insert B button on the screen.

This inserts a single occurrence of pattern B into the output stream
of pattern A.
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Inserting Pattern B via External Signal

You can configure the Serial BERT  to insert pattern B into the
continuous output stream of pattern A according to an external
signal:

1 Connect an external instrument to the Aux In port.

The signals received at this port must be TTL-compatible. The
granularity for the insertion of pattern B via external signal is
512 bits.

2 Press the Alt. Pattern and Aux In icon in the PG Setup menu to open
the Alternate Pattern Control dialog box.

3 In the Aux In section, define whether the Serial BERT  should
insert pattern B in Level Sensitiveor Edge Sensitive mode.

See “Aux In” on page 103 for more information on the different
available modes.

4 Click OK to close the dialog box.

Suppressing the Outputs via External Signal

You can configure the Serial BERT  to suppress the output according
to an external signal:

1 Connect an external instrument to the Aux In port.

The signals received at this port must be TTL-compatible. The
granularity for the insertion of pattern B via external signal is
512 bits.

2 Press the Alt. Pattern and Aux In icon in the PG Setup menu to open
the Alternate Pattern Control dialog box.

3 In the Aux In section, select Output Blanking.

See “Aux In” on page 103 for more information on the different
available modes.

4 Click OK to close the dialog box.
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Pattern Alternation - Reference

The Serial BERT  offers the following options for alternating between
pattern A and pattern B:

N O T E These functions are only available if Alternate Pattern is selected in the Pattern
Properties dialog box.

Continuous A

Select this option to send out only pattern A repeatedly.

A0 A1 A2

A A A A A A A A A A A AData Out

Continuous B

Select this option to send out only pattern B repeatedly.

B0 B1 B2

B B B B B B B B B B B BData Out

Alternate AB

Select this option to alternately send out patterns A and B (A, B,
A, B...).

Data Out

B0

B B B B

A0 A0

A A A A A A A A

B0

B B B B

Single Shot B

Select this option in the Alternate Pattern Control dialog box to enable
the Insert B button on the main display.

When you press the Insert B button, pattern B is inserted into the
continuous output of pattern A.
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Data Out A A A A A A A A B B B B A

A0 A0 B0 A0

A A A

Insert B pressed

Aux In

In this section you can enable the Aux In port to control the output
pattern. Aux In can receive signals that control alternate patterns
or blank the output.

The signals received at this port must be TTL-compatible. The
granularity for signals at this port is 512 bits.

The following options are available for Aux In:

• Disable

With this option selected, the signal at the Aux In port will be
ignored.

• Level Sensitive

– If Aux In is logic high, pattern B is sent.

– If Aux In is logic low, pattern A is sent.

Aux In

Data Out A A B A B B B

• Edge Sensitive

Pattern A is sent out until a rising edge at Aux In is detected.
Then, at the next complete repetition of pattern A, a single
occurrence of pattern B is inserted into the output.

Aux In

Data Out A A B A B A A

• Output Blanking

Pattern A is sent when the signal at Aux In is low. Pattern B is
not sent in this mode.

Data Out

Aux In

A A A A

If Aux In is pulled to logic high and a standard pattern is selected,
no output pattern will be sent.
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N O T E Due to the pattern generator behavior, the patterns may be repeated up to 512 times
before alternating. See “How the Serial BERT Generates Memory-Based Patterns”
on page 31 for details.
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4 
Setting up the Error Detector

Setting up the Error Detector - Concepts

The error detector analyzes an incoming bit stream, compares it to
the expected pattern, and locates any inconsistencies. The error
detector requires the following settings to work correctly:

• The expected pattern

The error detector needs to "know" which data to expect so that
it can detect bit errors.

• Correct input and output terminations to the DUT

This ensures that your DUT cannot be damaged due to incorrect
terminations.

• Correct clock frequency

Required to recognize the bit rate in the data stream.

• Appropriate sampling point

The sampling point defines where the error detector tries to
differentiate between 0s and 1s in the data stream. This is
necessary so that the error detector recognizes the data bits
correctly.

• Synchronization to the incoming pattern

The expected pattern must be synchronized to the incoming
pattern so that the error detector can find any discrepancies.

The error detector provides the following functions to enable you
to perform tests:

• Automatic pattern synchronization

The error detector shifts the incoming data stream bitwise to
match it to the expected data pattern. A correct BER can only
be measured with matching patterns.

• Error accumulation
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You can specify whether a test runs for a specified time or until
a specific number of errors has occurred. This lets you carry out
longer tests while logging the results to a file.

• BER location mode

You can specify whether all errors are counted or only the errors
that occurred on a particular bit position or range of positions.

• Audio warnings

You can set up the audio warnings so that the instrument beeps
when a certain BER is exceeded.

• Trigger output for external measurement instruments

This allows you to connect other devices for further error
analysis.

N O T E When the Bit Recovery Mode (BRM) option is installed, the error detector is able
to detect bit errors without expecting any particular pattern. This feature allows you
to investigate the behavior of the DUT when the sampling point is moved.

Inputs and Outputs

Inputs and Outputs - Concepts

The error detector (ED) provides input and output ports for
running tests and for connecting external equipment.

The error detector has the following inputs and outputs:
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Understanding Error Detector Input Ports

The error detector has the following input ports:

• Clock In

This port needs to be connected to a clock signal unless you use
the error detector in Clock Data Recovery (CDR) mode, where it
derives the clock frequency from the data port. See “Clock Setup
- Concepts ” on page 112 for more details.

• Data In and Data In

This port is connected to the data signal and the inverted data
signal.

• Gate In

This port has two different functions.

– In normal mode it can be used to enable and disable the error
counter. Errors are only counted when this signal is low.

The error counter can only count errors in 128-bit data
blocks. Thus, the signal at the Gate In port must be low for
at least 128 bits to enable the counter. The following figure
illustrates the effect of error gating. Errors are only counted
in the gray blocks.

Gate In

Expected Data on
Data Input

minimum signal
length not matched

only 128bit
granularity

A A
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– The burst sync mode is a special operating mode for
measuring data in bursts of bits, rather than one continuous
stream of bits.

In this case, the signal at the Gate In port controls the timing
of synchronization and error counting for each burst.

Understanding Error Detector Output Ports

The error detector provides several output ports that are used to
connect it to other devices for further error analysis:

• Trigger Out

Use this port to send a trigger signal to another connected
device, such as an oscilloscope.

• Error Out

This signal can be used to trigger an external instrument to help
in error analysis. When any number of errors are located within
a 128-bit data block, a single trigger pulse is sent. If continuous
errors are detected, the error out signal would be a clock signal.

Error Out

Error
detected

Data IN A

n Errors within
128bit granulation

(n<128)

single error
marking

A

n Errors exceeding 128bit
granulation (n>128)

• Aux Out

This port can be used to output the clock signal or the data
signal to another connected device.

The following figure shows how the clock signal is directed to
Aux Out in Clock mode:
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CLK IN

DATA IN

AUX OUT

CDR

CLOCK MODE

Recovered CLK

Comparator

0/1 Threshold

internal
Signal

Analyzer

Data In Port Termination

To ensure a valid setup and to protect the devices from damage,
proper termination must be specified for both Data In connections.
You can specify the termination by entering the termination voltage
in the respective field.

C A U T I O N Selecting the wrong termination may damage your device.

Why Can Wrong Terminations Damage Your Device?

Choosing wrong terminations may cause your device to output
voltage levels that are not as expected. It may also cause excessive
current or current flow in the wrong direction, which can damage
your device.

N O T E The clock termination is set to 50 Ohm, AC-coupled, and cannot be changed.
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Inputs and Outputs - Procedures

To select the termination for the error detector:

N O T E Prerequisite: You must know the termination voltage of the data signal that your
DUT sends to the error detector.

1 In the ED Setup menu, press Sampling Point Setup to access the
Sampling Point Setup window.

2 Click the Edit button. This opens the ED Input Setup dialog.

3 In the Termination field, enter the termination voltage that is
appropriate for the incoming data signal.

You can use the front panel knob or the numeric keypad to enter
the value.

C A U T I O N Selecting the wrong termination may damage your device.

4 Select the Data Inverted checkbox if your device inverts data.

You can now physically connect the DUT to the error detector.

Data Input Setup - Reference

The ED Input Setup dialog is accessed from the Sampling Point Setup
window. It is used to set up the error detector's data input port:

Input

The selection in this list defines how the signals arriving at the Data
In and Data In  connectors are interpreted. The following options
are available:

• Differential

If differential mode is selected, both input ports need to receive
a signal. The actual data signal is measured as the voltage
difference between the two incoming signals.
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• Normal

In normal mode, only the Data In port receives the data signal,
the Data In  port is inactive.

• Complement

In complement mode, only the Data In  port receives the data
signal, the Data In port is inactive.

Data Inverted

Activate this checkbox to invert the polarity of the error detector
reference pattern. This function is required if your device inverts
data.

Threshold

Only available, if the input is set to normal or complement mode.

Choices are:

• Averaging: The 0/1 threshold voltage is derived from the input
signal via a low-pass filter. This will work fine for most
applications.

• Manual input: Enter a value for applications that do not provide
a continuous data stream at the input (for example, any
application using bursts), because the averaged 0/1 threshold
voltage will drift from the correct level when there is no input.
The manually set threshold voltage must of course be within the
input range.

Termination

In this field, enter the termination voltage that is appropriate for
the incoming data signal. This selection should be made before the
device is connected to the analyzer.

If the input is set to differential mode, a termination voltage can
only be set for a device that is DC-connected.

C A U T I O N Selecting the wrong terminations may damage your device.

The Data In port is connected to a 50 Ohm load impedance (or
termination) within the error detector. Data termination refers to
the voltage level at the end of this load. The logic output from a
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device requires any connected equipment, including the error
detector, to have a specific termination voltage.

Input Range

Before you can synchronize the error detector to the incoming data
stream, you need to define the voltage range within which the eye
is located.

Both the high and low level of the data signal must be within this
range to find the eye.

N O T E The input voltage range is 2V. When you modify either the high or low voltage, the
other voltage is automatically adjusted.

N O T E See “Sampling Point Setup - Reference” on page 124 for a complete description of
all parameters of the Sampling Point Setup window.

Clock Setup

Clock Setup - Concepts

To measure the Bit Error Rate with the error detector, the bit rate
of the data stream must be known. Depending on the options the
instrument is delivered with, you could use either an external clock
source for the error detector (for example, the clock from the
pattern generator), or extract the clock signal from the incoming
data (CDR mode).

CDR mode does not work for all kinds of data patterns. For
example, if the device under test sends only blocks of ones and
zeros, there are no transitions in the data stream and the Serial
BERT cannot recover the clock.

Also, if you are testing bursts, there are some special considerations
for setting up CDR. See the following sections for details.
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How does Clock Data Recovery Work?

In CDR mode, the CDR has to recover the clock from the incoming
data. To do this, the hardware has to decide whether the voltage at
the input connector is a logical '1' or '0' and then recover the clock
from the detected transitions.

Because the regular threshold voltage is not only used to determine
the optimum sampling for the data, but also to perform
measurements such as eye diagram or output level measurements,
it is not possible to use it for the clock recovery.

For this reason, the clock recovery circuitry has it's own comparator
for the incoming data. This comparator also needs to know the
threshold voltage (0/1 decision threshold).

The threshold voltage can be derived from the input signal via a
low-pass filter. This will work fine for most applications. But
applications that do not provide a continuous data stream at the
input (for example, any application using bursts) cannot use this
low-pass filter, because the threshold voltage will drift from the
correct level when there is no input. In such cases, the threshold
can be specified manually. It is then no longer derived from the
input signal (see the following figure). The manually set threshold
voltage must of course be within the input range.

The difference between the data path and the CDR path is that the
comparator of the CDR is always single-ended. Thus, this
comparator always needs a threshold voltage that lies between the
high and low levels of the incoming signal.

The differential threshold of the data path comparator has no
relation to the single-ended threshold of the CDR path comparator.
This means that in differential mode, the two thresholds will be
different and in single-ended mode (either normal and complement)
they will/can be equal (except during measurements).

The following figure shows a simplified block diagram. It does not
reflect the different input modes (especially the differential case),
but it matches both single-ended cases.
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Bit Rate Range

The Serial BERT  provides bit rates from 150Mbit/s up  to 12.5 Gbit/
s, depending on the instrument's options .

However, several specific properties and limitations need to be
taken into account when working at low bit rates. The limitations
apply to the instrument according to the following hysteresis curve:

• If the bit rate falls below 615 Mbit/s, the limitations apply.

• If the bit rate exceeds 620 Mbit/s, the limitations no longer
apply.

The following figure clarifies the behavior in the range between
615Mbit/s and 620 Mbit/s:

615 Bitrate [Mbit/s]

620

Limitations do not apply
in this range

Limitations apply
in this range

For the error detector the following rules apply:

• For low frequencies, you cannot use the automatic data
alignment functions ( Auto Align and Data Center). Instead you need
to align the error detector manually. For instructions, please
refer to the Online Help, go to the Error Detector Setup section,
select Sampling Point Setup, and switch to the Procedures
information.

• There are restrictions to the available sampling point delay
values.
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The error detector can vary the sampling point delay only within
a range of 0ps to 1.6129ns (relative to the clock signal). For
frequencies above 620 Mbit/s, this range is sufficient to cover the
complete clock cycle (= 1 unit interval).

For lower frequencies, the maximum sampling point delay is
smaller than the clock cycle. Therefore, the sampling point
cannot be set everywhere within the clock cycle.

Clock 500 Mbit/s

Valid Range for
Sampling Point

2 ns

Valid Sampling Point

0 1.6129 ns

If the clock frequency falls below this threshold, the current
sampling point delay value is checked for validity. If the delay
does not fall in the valid range, it will then be moved into the
valid range. All subsequent changes to the sampling point delay
will be checked for validity and rejected if invalid.

If you cannot find the optimum sampling point in the valid range
of sampling points, you can switch from the rising to the falling
clock edge. For this purpose activate the Clock Falling Edge
checkbox on the Sampling Point Setup screen of the error detector
setup.

Clock 500 Mbit/s

Rising Edge
Sampling Point Delay

Falling Edge
Sampling Point Delay

2 ns

Covered Range

With this method you can still place the sampling point
anywhere in the clock cycle to find the optimum sampling point,
even at low frequencies.

Clock 310 Mbit/s

Covered Range

3.226 ns

However, if the bit rate falls below appr. 310 Mbit/s, even with
this method gaps occur in the range of possible sampling points.
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Clock 150 Mbit/s

Covered Range
with Gaps

6.66 ns

Gap Gap Gap Gap Gap

As a result, you might not be able to find the optimum sampling
point, if it falls in one of the gaps.

Clock Setup - Procedures

To set the clock rate:

1 Press Clock Setup in the ED Setup menu.

2 Specify whether you are using an External Clock Source or Clock
Data Recovery (CDR).

3 If you are using CDR, you need to approximately specify the
clock rate in the Clock Rate field (with an accuracy of 0.01%).

4 If you are measuring bursts, deactivate Auto Threshold and set the
threshold manually. You can also press the Measure button to
measure the current DC level at the CDR input and set the
measured value as CDR threshold.

5 Clock rates that are frequently used can be saved as presets in
the Preset list.

The Preset list always displays the presets within a certain
frequency range. Use the CDR Range selection list to display the
presets of another range.

To select a clock rate from the Preset list, click on it. The clock
rate appears in the Clock Rate field.

Clock Setup - Reference

The Clock Setup window contains the following elements:

Error Detector Bit Rate

The bit rate of the data reaching the error detector is displayed in
the lower right corner of the user interface.
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The bit rate of the error detector is set by the clock signal received
by the error detector. If the output bit rate of your device is not
equal to its input bit rate, the pattern generator and error detector
will be operating at different frequencies.

Clock Mode

The error detector supports two different clock modes:

• External Clock Source

If this mode is selected, the Serial BERT  uses the clock signal
that is connected to the Clock In port.

• Clock Data Recovery

If this mode is selected, the Serial BERT  derives the exact bit
rate from the incoming data stream. To make this function work,
the approximate clock rate must be specified in the Clock Rate
field (with an accuracy of 0.01%).

Clock Rate

This field is used to specify the approximate clock rate for CDR
mode. Serial BERT  needs this value to be about 0.01% accurate to
find the actual bit rate in the data stream.

Use the numeric keypad to enter the value followed by the unit that
you can select with the G/n, M/μ, k/m, and X1 keys on the front
panel.

Alternatively, you can select a value from the Preset list.

CDR Range

Use this field to select the range of clock rate values that is
displayed in the Preset list.

Preset List

The Preset list contains clock rate values that are commonly used
by the error detector. It always displays the values that are in the
range selected with CDR Range.

Click a preset to select it for the error detector clock rate.
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Double-click a preset to modify it.

Add Preset

Use the Add Preset button to add a new preset to the Preset list. You
can then enter a value, a unit, and a short description for this new
preset.

Delete Preset

Use the Delete Preset button to delete the currently selected preset
from the list.

Auto Threshold

If the Auto Threshold option is selected, the Serial BERT  continuously
analyzes the incoming data stream to detect the voltage level that
is optimal for the derivation of the clock signal.

This function is recommended for all applications where a valid
data stream is continuously arriving at the error detector.

For measurements with partly invalid data, such as burst tests, this
function may cause a clock loss. In such cases, deactivate Auto
Threshold and

• enter a fixed voltage level manually, or

• press the Measure button to measure the voltage level of the
incoming signal while a burst signal is applied.

Once the level is defined, it remains fixed for the following
measurements.

Note that the entered voltage level has to be within the input range
of the error detector. If the value lies outside this range, the change
is rejected and an error message is displayed.
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Sampling Point Setup

Sampling Point Setup - Concepts

This section provides basic information on the sampling point setup
and eye diagrams.

How Does the Sampling Point Setup Work?

The sampling point of a data signal is defined by two values: a point
in time and a voltage level. Each bit of the data signal is sampled
at this point in time and in reference to this voltage level. The point
in time (in reference to the clock signal) is referred to as the data
input delay, and the voltage level is referred to as the 0/1 decision
threshold.

The location of the sampling point is the decision factor as to
whether the incoming bits are identified as logic 0's or 1's. To
measure the accurate bit error ratio at the input port, false readings
of logic 0's or 1's must be avoided. Therefore, the sampling point
must be set to the optimum location within the data eye.

The functions within the Sampling Point Setup window allow you to:

• Prepare the error detector for the incoming data signal regarding
the connector termination.

• Graphically display the eye diagram in terms of voltage, input
delay and a BER threshold.

• Adjust the location of the sampling point.

What is an Eye Diagram?

An eye diagram provides a way to view all possible transitions
between adjacent bits of a data stream by overlaying them on the
display of a high-speed oscilloscope. It is typically produced by
triggering the oscilloscope with a synchronous clock signal.

When the oscilloscope is triggered by a clock signal, data patterns
will not be examined. Instead, if persistence is set high enough, the
shape of an "eye" will be observed. The eye is bounded by overlaid
logic 1 and 0 voltages (top and bottom) and multiple 0 to 1 and 1
to 0 transitions (left and right).
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Different portions of the bit pattern

Eye diagram
Overlay of all

portions of the bit pattern

The sampling point of the error detector must be set within the data
eye. The error detector uses the eye diagram to graphically display
the location of the sampling point. Additionally, the appearance of
the eye is useful for determining the quality of the data signal.

The height and width of the eye in the eye diagram are also
displayed in the diagram. Rise time, overshoot, and jitter are not
displayed in the diagram. Note that the diagram does not reflect the
different shapes of signals in RZ or R1 pulse format.

What is an Eye Edge?

In the eye diagram, the eye has 4 edges. An eye edge is defined as
a data input delay value or 0/1 threshold voltage value in the data
eye that meets the following conditions:

• The instantaneous bit error ratio (BER) is greater than or equal
to the alignment BER threshold.

• An adjacent point has an instantaneous BER that is less than
the alignment BER threshold.
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Understanding Bit Recovery Mode

In bit recovery mode (BRM), the error detector does not expect any
particular pattern. Nevertheless, it detects bit errors.

In bit recovery mode, the error detector uses two sampling points.
The second sampling point is not visible. Both are set to the
expected optimum position when the Auto Align button is pressed
(with respect to clock rate, signal voltages and offset, decision
threshold, and so on).

The bits received at this sampling point are considered to be
correct.

You can now move the visible sampling point and investigate the
behavior of the DUT in detail. The error detector compares the bits
at your sampling point with the bits recognized at the hidden
sampling point. As you move the visible sampling point, the
indicated BER will increase.

N O T E The indicated BER is a relative BER. It approaches the absolute BER if the error ratio
at the initial sampling point is very low. It is identical with the true BER if the signal
at the initial sampling point is errorfree.
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In bit recovery mode, some restrictions apply:

• Synchronization is impossible, because no particular data is
expected. Sync now and auto synchronization functions are disabled.

• Burst mode is disabled.

• Error Location Capture cannot be used.

• The function Error Detector Pattern tracks the Pattern Generator Pattern
is disabled. This function is not re-enabled when the BRM is
terminated.

BRM indicators:

• The mode is indicated in the status panel and in the BER Bar.

• The mode is indicated in all screen dumps and log files.

• The Measurement User Interface shows when this mode is used.

Sampling Point Setup - Procedures

In most cases you will set up the sampling point automatically.
Even if you wish to make some manual adjustments, it is
recommended to start with automatically aligning the sampling
point.

N O T E Before adjusting the sampling point, make sure the pattern synchronization mode
is set up properly. See “Pattern Synchronization - Procedures” on page 143 for
details.

How to Set the Optimum Sampling Point Automatically

1 Click the Sampling Point Setup icon in the ED Setup menu.

2 Select an appropriate BER threshold from the BER Threshold list.

3 Press Auto Align to automatically set the optimum sampling point.

You can stop the search for the optimum sampling point at any time
by pressing Cancel.

How to Adjust the Data Input Delay

1 Press the Sampling Point Setup icon in the ED Setup menu.

2 Select the Avg. 0/1 Threshold checkbox to use a good start point
on the vertical voltage axis.

4 Setting up the Error Detector

122 Agilent J-BERT N4903 High-Performance Serial BERT



3 Click Data Center to move the sampling point horizontally towards
the center of the eye at the selected voltage. You may click
Cancel at any time.

4 Now you can use the numeric keypad or front panel knob to
manually adjust the value in the Data Delay field.

The Sample Point in the eye diagram moves horizontally as you
change the value.

T I P While adjusting the data input delay, you can monitor the BER bar on the analyzer
display, or listen to the BER warning tones. Higher BERs may indicate that you are
measuring at the edges of the data eye.

N O T E Pattern synchronization can be lost during sampling point adjustment. If Auto
Sync is enabled, the Serial BERT will resynchronize the patterns automatically. If
the manual synchronization mode is selected, you need to synchronize the error
detector by clicking the Pattern Sync icon and then the Sync Now button.

How to Adjust the 0/1 Decision Threshold

1 Press the Sampling Point Setup icon in the ED Setup menu.

2 Clear the Avg. 0/1 Threshold checkbox.

3 Click 0/1 Threshold Center to move the sampling point vertically
towards the center of the eye at the selected delay. You may
click Cancel at any time.

4 Now you can use the numeric keypad or front panel knob to
manually adjust the value in the 0/1 Threshold field.

The Sample Point in the eye diagram moves vertically as you
change the value.

T I P While adjusting the 0/1 threshold, you can monitor the BER bar on the analyzer
display, or listen to the BER warning tones. Higher BERs may indicate that you are
measuring at the edges of the data eye.

N O T E Pattern synchronization can be lost during sampling point adjustment. If Auto
Sync is enabled, the Serial BERT will resynchronize the patterns automatically. If
the manual synchronization mode is selected, you need to synchronize the error
detector by clicking the Pattern Sync icon and then the Sync Now button.
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How to Enable the Bit Recovery Mode

The bit recovery mode (BRM) allows you to measure the relative
BER without knowing the incoming data pattern.

To enable the bit recovery mode:

1 Press the Sampling Point Setup icon in the ED Setup menu.

2 Click the Bit Recovery Mode button.

The Sync Now button is no longer available.

Note that you can also enable the bit recovery mode from the
Pattern window. Click the Pattern Select icon and then the Error
Detector Pattern tab. If this tab is not available, disable the
checkbox Error Detector Pattern tracks the Pattern Generator Pattern.

3 Click the Auto Align button.

Sampling Point Setup - Reference

N O T E Depending on the options of your Serial BERT, some of the following functions may
not be valid for your instrument. See “Introduction to the Serial BERT - Concepts ”
on page 9 and “Which Features are Available?” on page 12 for a description of the
available options.

The Sampling Point Setup window provides the following elements:

0/1 Threshold

The 0/1 decision threshold is the reference voltage level for the
evaluation of the incoming data signal. At the sampling point, the
data signal voltage ist compared to the 0/1 decision threshold.
Signals greater than this threshold will be measured as a logic 1;
signals below this threshold will be measured as a logic 0.

N O T E 0/1 Threshold cannot be used while Avg. 0/1 Threshold is selected.

The 0/1 Threshold field allows the manual entry of the 0/1 threshold,
and displays the current value in millivolts.
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You can adjust the 0/1 threshold in the following ways:

• Click inside the text field and use the numeric keypad or front
panel knob to enter a value.

• Click anywhere in the sampling point display. The sampling
point will be moved to that location.

• Turn the Decision Threshold knob on the front panel. A small
window appears, displaying the threshold value. This knob can
be used at any time, while in any window.

Data Delay

The data input delay defines the point in time (in reference to the
clock signal) at which the incoming data signal is measured.
Specifically, it is the time delay from the active clock edge to the
time at which the data is actually sampled.

This field allows the manual entry of the data input delay, and
displays the current value in picoseconds. This delay can be set as
high as 1 bit period or 10 ns (10,000 ps), whichever is less.

You can adjust the data input delay in the following ways:

• Click inside the text field and use the numeric keypad or front
panel knob to enter a value.

• Click anywhere in the sampling point display. The sampling
point will be moved to that location.

• Turn the Data In Delay knob on the front panel. A small window
will appear, displaying the delay value. This knob can be used
at any time, while in any window.

Clock Falling Edge

Activate this checkbox to move the sampling point from the rising
edge to the falling edge of the clock signal. This function is useful
when the maximum data input delay adjustment is not large enough
to move the sampling point to the desired location. This occurs at
very low frequencies only. See “Bit Rate Range” on page 114 for
more information.

Auto Align

Click this button to automatically set the optimum sampling point.

This routine will not stop if the optimum sampling point cannot be
found. If no optimum sampling point is found after a reasonable
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time, you can click Cancel. The status message bar will indicate if
this function is unsuccessful.

The following settings may affect the result of the auto align
function:

• Data Inverted

• BER Threshold

T I P Alternatively, you can also press the Auto Align button on the front panel.

Sync Now

Click this button to manually start a pattern synchronization. See
“What Type of Synchronization Should You Use?” on page 134 for
information on when you should use this function.

Note that this button is not available in bit recovery mode.

0/1 THReshold Center

Starts an auto-search function that sets the 0/1 threshold to the
optimum point of the incoming data eye on the vertical voltage axis
without changing the data input delay. This function can be used
for determining the optimum 0/1 threshold for asymmetric data
eyes, or for patterns with an unequal mark density.

The status message bar will indicate if this function is unsuccessful.
This function clears the Avg. 0/1 Threshold checkbox.

N O T E This function uses the alignment BER Threshold to determine the top and bottom
eye edges.

Data Center

This button starts an auto-search function that aligns the data
signal with the clock signal so that the error detector samples at
the optimum point of the data eye in the time axis. This
automatically compensates for delays in the clock/data paths,
preventing unnecessary errors. The 0/1 decision threshold is not
changed. The status message bar will indicate if this function is
unsuccessful.
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N O T E Ensure that the received clock frequency is stable before using Data Center.

T I P The clock/data alignment process time is pattern dependent, and with some large
user patterns the alignment can take several minutes. If you encounter such a long
time with a user pattern, it may be possible to first perform clock/data alignment
on a pure PRBS pattern. This generally does not affect alignment accuracy, and can
minimize measurement time.

This tip does not apply in cases of severe pattern dependent jitter or with devices
that do not work with PRBS patterns.

N O T E This function uses the alignment BER threshold to determine the left and right eye
edges.

Cancel

Click this button to cancel the Auto Align, 0/1 Threshold Center, or Data
Center functions while they are in progress. The following
parameters will be returned to their previous value or status:

• Auto Align Canceled

– Data Delay and 0/1 Threshold values returned to previous.

– Status of Data Inverted and Avg. 0/1 Threshold checkboxes
returned to previous.

• 0/1 Threshold Center Canceled

– 0/1 Threshold value returned to previous.

– Status of Avg. 0/1 Threshold checkbox returned to previous.

• Data Center Canceled

– Data Delay value returned to previous.

BER Threshold

In this list, select an alignment BER threshold that is appropriate
for your application.

The alignment BER threshold is the pre-defined threshold used by
the Data Center, 0/1 Threshold Center, and Auto Align functions to define
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the edges of the data input eye in the time and voltage axes. You
may wish to change the threshold for the following reasons:

• Choosing smaller alignment BER thresholds will cause the auto-
search functions to set more accurate sampling points. However,
if the BER threshold is set lower than the residual BER of the
measurement, the auto-search functions will fail. 1E-7 is the
smallest BER threshold available.

• Running the auto-search functions and viewing eye results at
different BER thresholds will allow you to see the eye margin at
specific BERs. You can also construct basic eye contour
information.

Avg. 0/1 Threshold

Activate this checkbox to make the error detector continuously set
the 0/1 threshold level to the average DC voltage level of the
incoming data signal.

N O T E Manual 0/1 threshold changes are impossible while this function is selected.

This function is useful for providing a "starting point" for sampling
somewhere within the data eye on the vertical voltage axis. It is
recommended to use this prior to clock/data alignments.

When used with the following patterns, this function may provide
a 0/1 threshold that requires no further adjustment:

• 2^n-1 PRBS patterns

• Patterns with 50% mark densities (large amplitudes and no
excessive noise)

Bit Recovery Mode

Click this button to put the error detector in bit recovery mode
(BRM). For details on BRM see “Understanding Bit Recovery Mode”
on page 121.

Then, click Auto Align to set the sampling point.

Sampling Point Display

This area of the Sampling Point Setup window graphically illustrates
the parameters of the current sampling point and data eye. Click
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anywhere in the sampling point display to set the sampling point
to that location.

A green area in the display indicates the voltage range specified in
the Input Range fields for non-differential modes (Normal and
Complement). The Serial BERT  is searching this range to find the
eye when calculating the optimum sampling point.

Return to Results

Click this button to return the 0/1 Threshold and Data Delay to the
values measured during the last auto alignment. The Data Inverted
and Avg. 0/1 Threshold checkboxes will be returned to their previous
state.

Trigger and Aux Output

Trigger and Aux Output - Concepts

The error detector has a Trigger Out and an Aux Out port that you
can use to send signals to other external devices such as an
oscilloscope.

The Trigger Out can be set up to send a trigger to an external
device either according to the clock, or according to the data
pattern being generated.

The Aux Out can be set up to either send the error detector's clock
signal directly from Clk In port, or the error detector's clock signal
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recovered from Data In port, or the input data passed over a
comparator.

Trigger and Aux Output - Procedures

To set up the trigger and auxiliary outputs:

1 Press Trigger and Aux Out in the ED Setup menu.

2 For the Trigger, select one of the two options:

– Clock Divided by n

Sends a trigger signal every 4, 8, 16, 20, 32, 64, or 128 bits.

– Pattern

A trigger is sent, every time the complete pattern was
received.

3 For the Aux Out, select whether the Clock signal or the Data signal
is supplied.

If Clock is selected, the clock signal used by the error detector is
output directly at Aux Out.

If Data is selected, the input data is output over a comparator at
Aux Out.

The comparator is controlled by the 0/1 threshold. This lets you
use an oscilloscope to determine if the 0/1 threshold is correctly
set. If the 0/1 threshold is set below or above the data eye, the
output at Aux Out will be constant high or low, respectively.

4 Click OK to finish the Trigger and Aux Out setup.

Trigger and Aux Output - Reference

The available options in the ED Trigger & Aux Output window are:

Trigger

You have two options to configure the signal at the Trigger Out port:

• Clock Divided by n

The trigger is set every n bits.
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Clock

Trigger Out

• Pattern

The trigger signal is sent every time when the complete pattern
has been received. This refers to the single pattern repetitions,
not the 512-bit blocks.

Note, that the length of the trigger signal is at least 40 bits and
divisible by 4.

Aux Out

You have two options to set up the signal at the Aux Out port:

• Clock

This option supplies the clock signal to the Aux Out port.

• Data

This option supplies the data signal via a comparator to the Aux
Out port.

The comparator is controlled by the 0/1 threshold. This lets you
use an oscilloscope to determine if the 0/1 threshold is correctly
set. If the 0/1 threshold is set below or above the data eye, the
output at Aux Out will be constant high or low, respectively.

Pattern Synchronization

Pattern Synchronization - Concepts

The Serial BERT  calculates bit error rates by comparing the
received data with the expected data patterns. To do this, it needs
to know where the start of the pattern is located in the data stream.
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Introduction to Pattern Synchronization

Pattern synchronization (sync) refers to aligning the incoming data
pattern with the internal reference pattern. This is accomplished in
one of two ways:

For 2^n-1 PRBS patterns, bits from the incoming data pattern
"seed" the error detector's pattern generator, causing it to generate
a precisely aligned internal reference pattern.

For software-generated and user patterns, a 48-bit pattern from the
pattern is used as a detect word. Optimally, this detect word should
be unique within the entire pattern. The error detector searches for
this detect word within the incoming data stream, and uses the
point in the data stream as a reference, and compares all following
bits with the pattern. If the measured BER is better than the
synchronization BER, the error detector is synchronized.

There are thus three possible outcomes for a synchronization:

• Single instance of the detect word in the data stream

Detect Word
48 bits

Detect Word
48 bits Detect Word

48 bits

Reference
Point

Correct Sync

Expected
Pattern

Incoming
Bit stream

• Multiple instances of the detect word with correct
synchronization
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Detect Word
48 bits

Detect Word
48 bits

Detect Word
48 bits

Detect Word
48 bits

Detect Word
48 bits

Reference
Point

Correct Sync

Expected
Pattern

Incoming
Bit stream

• Multiple instances of the detect word with false synchronization

Expected
Pattern

Detect Word
48 bits

Detect Word
48 bits

Incoming
Bit stream

Detect Word
48 bits

Detect Word
48 bits

Detect Word
48 bits

Reference
Point

False Sync

If the error detector attempts to synchronize on the incorrect detect
word, the BER will be unacceptably high, and, if automatic
synchronization is selected, the error detector attempts another
resync.
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The detect word on which the error detector attempts to resync is
chosen strictly by chance. So if there are two instances of the detect
word in the pattern, the error detector has a 50% chance of
selecting the correct one.

The more instances of the detect word exist in the pattern, the
higher are the chances for incorrect synchronization. The software
attempts in any case to identify a 48-bit pattern that occurs as
seldom as possible in the pattern. For very large patterns, this can
unfortunately take a very long time, and the software ends the
search if it expects that it would take longer to find an adequate
detect word than it would to attempt to synchronize. If the search
for a detect word is ended, the most unique detect word identified
is used.

Patterns must always be synchronized in order to do accurate BER
testing. If patterns are out of alignment by just one bit, errors can
be as high as 50% (5E-1) for PRBS patterns, and 100% (1E+0) for
custom patterns.

By default, the error detector is in automatic sync mode with a sync
threshold of 1E-3. This setting is recommended for most
applications, and usually allows the synchronization function to be
"transparent", requiring no attention. However, for special
applications, changes can be made to the sync mode and sync
threshold.

What Type of Synchronization Should You Use?

The type of synchronization you use affects how errors are
measured and displayed. A Sync Loss is recognized when the BER is
greater than the sync threshold. This can be caused by a high error
rate, pattern misalignment, or clock loss. Choose the sync mode
setting that is appropriate for the type of errors you anticipate.

• Automatic Sync with a sync threshold BER of 1E-3 is
recommended for most applications.

With this mode selected, the synchronization algorithm starts
whenever the BER exceeds the threshold. However, it is not
possible to make accurate BER measurements higher than the
sync threshold.

• Manual sync can be used for synchronizing once, confirming
proper pattern alignment, and then measuring BERs higher than
the sync threshold. This is useful for the following applications:

– To monitor the integrity of clock signals. You may wish to
measure BERs that exceed the sync threshold to confirm
clock slip.
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– To collect data for constructing eye contour information. You
may wish to move the sampling point to locations in the data
eye that have BERs exceeding the sync threshold.

This mode doesn't allow the analyzer to automatically
synchronize if the BER becomes greater than the sync threshold.
For example, the analyzer will not re-synchronize after
momentary clock loss.

N O T E Adjusting the data input delay may cause momentary clock loss. If you select
Manual Sync mode, this may also result in sync loss.

• Burst sync mode is a special operating mode for measuring data
in bursts of bits, rather than one continuous stream of bits.

For more information, refer to “Introduction to Burst Sync
Mode” on page 137.

N O T E If the error detector is in Manual Sync mode, it is recommended that you keep an
eye on the SYNC LOSS light at the top of the instrument. There are various actions
that can lead to loss of synchronization. Check the SYNC LOSS any time you make
changes to the instrument.

What is False Synchronization?

For patterns other than PRBS, the error detector may gain sync at
a point in the pattern that meets the sync threshold, but is not the
correct point where the internal reference pattern and the received
data pattern match. This is called false synchronization.

N O T E False synchronization cannot occur with PRBS patterns because a 1 bit
misalignment would cause a measurement of 50% or more errors. Thus, the BER
during a misalignment would always be greater than the sync threshold BER.

For example, consider a pattern of 1000 ones and 1000 zeros as
shown in the following figure. With reference alignment 1 the
patterns are totally out of phase and the error detector is measuring
100% errors. But as the reference moves closer to optimum
alignment, the percentage of errors gradually approaches zero
(reference alignment 2 and 3). For exact alignment, the sync
threshold must be set lower than the BER caused by a 1 bit
misalignment, in this case 1E-3.
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How Can You Tell if Your Synchronization is False?

You may suspect false synchronization under the following
conditions:

• You are using a pattern other than PRBS and the error detector
gains sync, but it measures a constant, fixed error ratio.

• You are using a pattern other than PRBS and the error detector
gains sync, but auto-search functions (Auto Align, Clock/Data
Center, 0/1 Threshold Center) repeatedly fail.

In a false sync, the sync threshold BER of 1E-3 may be met, but
eye edges at BER 1E-3 (required by an auto-search function)
may not be found. This is because BERs less than 1E-3 do not
exist within the data eye.
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If you suspect a false sync, try re-synchronizing at a sync
threshold BER lower than the fixed error ratio. If sync is
acquired without the problems listed above, then your previous
sync was false. Your current sync should be on an exact pattern
alignment.

N O T E While auto-search functions are in progress, the sync threshold BER is changed to
the same value as the alignment BER threshold. If you are using these functions
and want to consistently re-synchronize at a lower sync threshold, you must set the
alignment BER threshold to the same value as the sync threshold BER.

Introduction to Burst Sync Mode

The burst sync mode is a special operating mode for measuring data
in bursts of bits, rather than one continuous stream of bits.

The burst sync mode measures bit error rates for each burst of data
after the error detector synchronizes to the incoming pattern. The
signal at the Gate In port controls the timing of synchronization and
error counting for each burst.

This function is useful, for example, to analyze recirculating loop
data. With a recirculating loop you can simulate very long cable
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connections like transoceanic cables. Data is sent into a looped
cable drum and after a certain number of loops it is diverted into
the error detector. This way, only a short burst of valid data
reaches the Serial BERT  followed by a long break. Therefore, the
error detector needs to be synchronized at the beginning of every
burst.

How Burst Sync Mode Works

The following figure presents the basic order of events that make
up a burst mode measurement. It also illustrates how the
instrument operates while in burst mode.

Gate In?

no

CDR?

yes

yes

Sync?

CDR Settling Time

Synchronization Time

no

BER
OK?

success

failed

Total Burst + 1

Bad Burst +1

Incr. Bit Counters

yes

no

Register Incoming Bits

Gate In?

no

yes

1

2

3

45

6

7

N O T E Burst mode requires a complete measurement setup, including an external input
for the Gate In port. This input is used for the sync alignment.

1 Burst sync is started when the Gate In signal goes low,
indicating that a burst is arriving at the Data In port.
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2 If the error detector is in CDR mode, it first tries to generate a
clock from the data. A short time interval is required to stabilize
the clock (the CDR settling time).

Note that if the error detector is in CDR mode, it is necessary
to set a CDR threshold. This is the BER threshold that the error
detector uses to verify that the input pattern is synchronized.
See “How does Clock Data Recovery Work?” on page 113 for
more information.

If an external clock is used, there is no delay. The clock signal
must however be continuous.

3 The error detector can then synchronize to the incoming signal.
For PRBS, the first received bits are used to seed the
synchronization. If there is an errored bit in this phase, the
synchronization fails (bad burst).

For memory-based patterns, a unique 48-bit detect word is used
for the synchronization. This pattern should be available one
time only in the pattern. If the detect word is not found,
synchronization fails (bad burst).

4 If synchronization has been established, the received data is
analyzed until the signal at Gate In goes high, indicating the end
of the burst. The data should continue arriving at Data In slightly
longer than the Gate In signal.

5 In case of failed synchronization, the total burst counter and bad
burst counter are incremented. The bit counters (total count,
error count, etc.) are not incremented.

6 At the end of the burst, the data is analyzed: the bits are
counted, as are the errors (total, errored 0s, errored 1s).

If the BER is higher than the Burst Sync Threshold (in the Pattern
Sync Setup dialog box), the burst is considered a bad burst, and
the total burst count and bad burst count are incremented.

7 For good bursts, the total burst count is incremented, and the
bits are analyzed (bits and errors counted). The BER is also
shown in the user interface.

Timing of the Signal at Gate In

The timing of the signal at Gate In is critical to the successful use
of burst mode. If the signal is not timed optimally, the resulting
BER will be either too high, or the sync ratio (good bursts / total
bursts) will be too low.

The signal at Gate In has to start early enough for the error
detector to get the clock (the CDR settling time) and synchronize to
the pattern. And it has to stop before the burst ends, but should

Setting up the Error Detector 4

Agilent J-BERT N4903 High-Performance Serial BERT 139



stay low as long as possible without hitting the maximal length
limitation (to extend the time where bits can be counted).

The following figure illustrates how the duration of the Gate In
signal can influence the bit count time (the time where bits are
actually counted).

Data Input

Gate Input

CDR Settling Time
Synchronization Time

Bit Count Time

Burst

Gate Active

Valid after Gate

Begin Margin End Margin

Gate
Passive

Gate Active is the interval in which the Gate In signal is active.

The Bit Count Time is the part of the burst from which the bits
can actually be counted. The remainder of the burst is covered by
the Begin Margin and End Margin.

The CDR Settling Time is the time that the error detector requires
in CDR mode to get the clock from the data stream.

The Synchronization Time is the time the error detector requires
to synchronize to the pattern. This time depends on the pattern
type (PRBS or memory-based).

The Valid after Gate indicates the minimum length of data that has
to arrive at Data In after the Gate In signal is deactivated.

There is no requirement how long a signal should be available at
Data In before gating starts (the data should simply be stable). A
pause is however required after the gating to allow the error
detector to evaluate the results. This time is known as Gate
Passive.

The following is a summary of the values of these parameters for
the Serial BERT :
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Table 15

Parameter Values

Bit Count Time Min.: 1536 bits

Max: 4 Gbits

The optimal length is dependent on the
BER threshold.

CDR Settling Time CDR mode: 2 microseconds

Non-CDR mode: 0

Synchronization Time Hardware PRBS: 1536 bits

Memory-based patterns: Min. 15 kbits
(depends on when and how often the
unique word occurs)

Valid after Gate CDR mode: 1.5 microseconds

Non-CDR mode: 1536 bits

Gate Passive CDR mode: 2560 bits or 1.5 microseconds
(whichever is larger)

Non-CDR mode: 2560 bits

The following values can be derived from these parameters:

Table 16

Parameter Values

Begin Margin CDR Settling Time + Synchronization
Time

End Margin Valid after Gate

Bit Count Time Burst Length - Begin Margin - End Margin
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Table 16

Parameter Values

Gate Active Begin Margin + Bit Count Time

Optimizing the Timing

There are three things to watch when optimizing the timing for
burst sync mode:

• BER

The bit error rate increases when the gate closes too late. The
duration of the signal should typically be reduced.

• Burst sync ratio

The burst sync ratio is an indication of how much of the burst
signal is in synchronization (and can therefore be used for
counting bit errors). The higher the value, the better.

• Bad burst count

The bad burst count counts the number of bursts that are invalid
(for example, because synchronization failed or the BER of a
synchronized burst exeeds the sync threshold).

The following describes how changing the Gate In start and end
points can affect the evaluation of bursts.

Starting too soon: If the Gate In signal is applied too soon, the
error detector will either not be able to recover the clock or
synchronize the pattern, and will thus mark the burst as a bad
burst (thus increasing the bad burst count). You can typically
reduce the bad burst count by starting the gating period later.

Burst

Attempted Settling Time ends here

Start too soon
CDR Settling Time

Synchronization Time

Settling/Synchronization fail hereGate Input

Data Input

Starting too late: If the Gate In signal is applied too late, the Bit
Count Time will be shortened, and thus the burst sync ratio will be
low (which forces the measurement of more bursts to obtain the
necessary level of reliability).
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Data Input

CDR Settling Time
Synchronization Time

Burst

Gate Input

Start too late

Bit Count Time
End
Margin

Ending too soon: If the Gate In is deactivated too soon, the same
problems will occur as with starting the gate too late (see previous
point).

Data Input Burst

Gate Input

End too soon
CDR Settling Time

Synchronization Time

Bit Count Time
End
Margin

Ending too late: If the Gate In signal is deactivated too late, the
last received bits will not be part of the burst. Thus, the BER will
increase. If the BER is higher than the Burst Sync Threshold, the
burst will be considered a bad burst.

Data Input Burst

Gate Input

End too late
CDR Settling Time

Synchronization Time

Bit Count Time

Pattern Synchronization - Procedures

To synchronize the incoming pattern to the expected pattern:

1 Press Pattern Sync in the ED Setup menu.

2 Select the synchronization mode ( Normal or Burst sync mode).

3 If you selected Normal synchronization mode, choose whether you
want Automatic or Manual synchronization.

4 Specify the Sync Threshold at which the pattern will be recognized
at synchronized.

5 In Manual synchronization mode use the Sync Now button to start
the pattern synchronization. This is recommended whenever you
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did changes to the pattern setup, the voltage levels or the
hardware connections (for example, altered cable lengths).

6 Press OK to confirm your settings.

Pattern Synchronization - Reference

The error detector can synchronize the data patterns in the
following ways:

• In Normal Sync Mode, you can choose between

– Automatic Sync

With this option selected, the error detector constantly tries
to synchronize the patterns when the BER threshold is
exceeded.

– Manual

Manual synchronization can be selected, for example, if the
signal delay is very unstable, and you want to avoid that the
re-synchronization process affects the measurement results.

• Burst Sync Mode

Click this button to enable the Burst Sync Mode. Burst mode
operates as follows: For each burst of data, BER measurements
are only made after the error detector synchronizes to the
incoming pattern. The signal at the Gate In port controls the
timing of synchronization and error counting for each burst.

The Sync Threshold defines when the error detector assumes the
patterns to be synchronized. The Serial BERT  shifts the received
pattern bitwise until the measured BER is below this threshold.

Error Accumulation

Error Accumulation - Concepts

The Serial BERT  instantly starts measuring the BER when the error
detector receives data. However, to perform tests that can be
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repeated and compared, you can collect the measurement data in
several ways and save it to a log file.

The available options are to test:

• for a specified time,

• until a certain number of errors occurred,

• until a specified number of bits have been sent,

• until you stop it manually.

Error Accumulation - Procedures

To set up the Serial BERT  for error accumulation:

1 Press the Accumulation Setup icon in the ED Setup menu

2 Select the desired Activation Mode for the type of test you want
to run ( Manual, Single, or Repeat test).

3 If you selected a Single or Repeat test, you need to specify the
accumulation Period (certain Time, Number of Errors, or Number of
Bits).

4 Use the Measurement Logs area to specify whether you want save
the results in a log file.

5 The log files will be saved in the Log Directory displayed at the
bottom of the dialog box. Use the Browse button to select a
different directory.

6 Click OK to apply your selections and close the Accumulation
Setup dialog box.

For more information on how to run error accumulation tests, see
“Accumulated Measurements - Procedures” on page 301

Error Accumulation - Reference

The Accumulation Setup window contains the following elements:
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Activation Mode

• Manual

Activate this option to configure the error detector to start and
stop accumulation when the front panel buttons are pressed.

• Single

Activate this option to configure the error detector to accumulate
over one accumulation period and then stop.

• Repeat

Activate this option to configure the error detector to accumulate
over repeated accumulation periods, whereby one period follows
another immediately. There is no "dead time" between the end
of one period and the start of the next.

N O T E Repeat will not create multiple measurement log files. The data for all repeating
periods will be saved to the same log file.

The accumulation mode cannot be changed while accumulation is running.

Measurement Log

• Prompt for File Name

Click this option if you want to be prompted for a measurement
log file name before each accumulation period begins. With this
option you can select a new file name for each test run.

• File Name

Click this option if you want to enter a file name for
measurement logs before starting the accumulation. With this
option you will overwrite the measurement log file with each
new test run. However, in Repeat mode, the results of all
repetitions will be appended to this file and no information is
lost.

• No Logging

Click this option to turn off measurement logging. Serial BERT
will not save the test results.

Period

The accumulation period cannot be specified for Manual tests.

• Time
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Select this option to configure the error detector to accumulate
bit errors for a specific period of time.

You can enter the desired time period in the Days, Hr (Hours),
Mn (Minutes), and Sec (Seconds) fields. You may use the numeric
keypad or front panel knob. The minimum value is 1 second and
the maximum value is 99 days, 23 hours, 59 minutes, and 59
seconds. When the selected time has elapsed, the accumulation
ends.

• Number of Errors

Select this option to configure the error detector to accumulate
bit errors until a specified number of errors has been measured.

The number of errors can be set to 10, 100, or 1000. When the
selected number of errors has occurred, the accumulation ends
after the next full second.

• Number of Bits

Select this option to configure the error detector to accumulate
bit errors until the specified number of bits have been examined.

The number of bits can be set from 1E7 to 1E15. When the
selected number of bits have been exceeded, the accumulation
ends.

N O T E The actual test period may contain more bits than specified.

N O T E The accumulation period cannot be changed while accumulation is progress.

Browse

Click this button to browse for the directory where you wish to save
the measurement log files.

N O T E Changes to the parameters of the accumulation setup do not take effect until the
start of the next accumulation.
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BER Location

BER Location - Concepts

The Serial BERT  can be run in BER location mode. In this mode,
the errors are not counted on all bits of the data signal, but on a
particular bit or block of bits in the pattern. You can specify which
bit position(s) are considered during the measurement.

This allows, for example, to calculate the BER for the header bits
or the payload of a data stream exclusively.

BER Location - Procedures

To set up the BER location mode, do the following:

1 Press the BER Locationicon in the ED Setup menu.

2 Select whether you want to locate errors on All Bits, on a
particular Block of bits, or on a Single Bit in the pattern.

If you select Block or Single Bit, enter the bit positions in the
respective fields.

3 Click OK to finish the BER location mode setup.

BER Location - Reference

The Bit Error Location Mode dialog box offers the following options:

With this option, all errors are counted.

With this option, only errors occuring in the block between the
specified Start Bit and Block Lengthare counted.
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With this option, only errors occuring at the specified position are
counted.

The following legend applies for the above graphics:

Evaluated bits
Not evaluated bits

Audio Signals

Audio Signals - Concepts

The use of warning tones is convenient when you want to monitor
the instantaneous BER over a longer time without constantly
watching the display.

With the Audio dialog box, you can adjust the sound volume as well
as some conditions when to play a sound is played.

Audio Signals - Procedures

To set up the warning sounds, do the following:

1 Press the Audio icon in the ED Setup menu.

2 Check the Audio on checkbox to switch on the sounds.
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T I P To switch the audio signals on and off, you can also use the Audio On/Off front
panel button.

3 Use the Main Volume slider to adjust the volume.

After adjusting the slider, a test tone is played at the new
volume.

4 Click the respective radio button if you want to play the sound

– whenever the BER exceeds the threshold specified in the BER
Alarm Threshold field. Enter an appropriate value in this field.

T I P You can always adjust the BER Alarm Threshold by clicking and dragging the small
yellow marker in the BER bar in the top left corner.

– on All Error Rates greater than zero.

5 Click OK to finish the audio setup.

Audio Signals - Reference

The Audio dialog box contains the following elements:

Audio on

Select this checkbox to enable the audio function.

Clear this checkbox if you want to switch off the audio function.

You can also use the Audio On/Off button on the front panel to
accomplish the same function.

Main Volume

Click any point on the slider or drag it to change the main volume
level. You will hear a test tone at the new volume level.

Audio on BER Alarm

Click this option to make the analyzer play warning tones when a
specific BER is exceeded.

The BER Alarm Threshold is the threshold at which tones are produced.
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Enter the BER threshold in the following format: (number)E
(exponent). For example, 1.5E-3.

T I P You can always adjust the BER Alarm Threshold by clicking and dragging the small
yellow marker in the BER bar in the top left corner.

Tones on All Error Rates

Click this option to make the analyzer produce warning tones when
any BER greater than zero is measured. The pitch will increase or
decrease as the BER increases or decreases.
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5 
Advanced Analysis

Advanced Analysis - Concepts

The Serial BERT  offers several different kinds of advanced
measurements for various purposes:

This type of measurement is used to measure the timing and jitter
behavior for a device under test (DUT). It uses a bit error rate
(BER) measurement to evaluate the shape of the eye for the output
signal of the DUT. It also analyzes the jitter, separates the random
jitter and deterministic jitter components, and estimates the total
jitter.

A direct result is the determination of the optimum sampling point
delay for receiving data from the DUT with maximum confidence.

DUT Output Timing/Jitter includes the Fast Total Jitter
measurement that can be used to measure the total jitter for devices
which generate a very low error density in a reasonable time span.

The Output Levels measurement allows you to characterize the
behavior of the output levels of a device under test (DUT). The
sampling delay is fixed. The error detector's decision threshold is
automatically swept within a user-defined range.

A direct result is the determination of the optimum decision
threshold level for receiving data from the DUT with maximum
confidence.

The Eye Opening measurement generates a three-dimensional bit
error rate (BER) diagram as a function of the sample delay and the
sample threshold. With this measurement, the complete eye of the
DUT output signal is measured. The results comprise the voltage
and timing of the eye opening and the optimum sampling point.

Agilent J-BERT N4903 High-Performance Serial BERT
User Guide

s Agilent Technologies 153

S
DUT Output Timing/Jitter

Output Levels

Eye Opening



The Error Location Capture measurement allows to capture the
actual position of errored bits in a memory-based pattern. The
instrument searches for the first bit errored in the incoming
bitstream and marks it in the pattern. The address of the errored
bits can be displayed after the error is located.

The Fast Eye Mask measurement is first of all meant for production
and screening tests. It allows to determine very quickly whether the
eye opening seen at the output signal of a device is within
specifications, that means, within certain timing and voltage limits.

This is achieved by measuring the bit error rate at a limited number
of test points.

The Eye Diagram allows a quick check for the DUT’s signal output,
and determines the signal quality. Due to the higher sampling depth
of a BERT value, the eye contour lines display the measured eye at
a deeper BER level, for accurate results.

The Spectral Jitter measurement allows you to analyze the jitter
inherent in the output signals of your device under test (DUT) as a
function of the frequency. This measurement can be used for
investigating the behavior of the DUT, for example to identify
crosstalk effects.

Before you can run any of these advanced measurements you have
to properly set the required parameters. After the test is complete
you can view the results.

General Requirements

For any measurement to yield reasonable results the following
requirements apply:

• The error detector must be correctly set up and synchronized
with the pattern sent from the DUT output port.

• Ideally, the sampling point should be aligned to the optimum
sampling point (for example, with the Auto Align function).

• For low bit rates below appr. 620 Mbit/s only the Error Location
Capture measurement works.

Please refer to “Bit Rate Range” on page 114 for a detailed
explanation of the limitations at low bit rates.
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If the Serial BERT 's pattern generator is used to send a data pattern
to the DUT, then also the following to conditions must be met:

• An appropriate pattern is selected.

• The pattern generator is correctly set up.

For examples, refer to the descriptions of the different
measurements.

Optimizing Parameters

If the presented measurement results do not answer your questions
adequately, you can easily modify the setup parameters in the
Properties dialog box. When changing the measurement settings after
the measurement has been run, please note:

• Parameters that affect the data capture.

Changes on the Parameters page take only effect if you run the
measurement again.

• Parameters that change the display of the measured data.

Changes on the Pass/Fail, View, Graph, and Color tabs only affect
the display of the results. There is no need to repeat the
measurement.

Saving Measurements for Later Analysis

You can save a completed measurement for later analysis. This
includes the settings you selected for the measurement and the
measured data. This allows you to load the measurement at a later
stage and inspect all data in detail. You can also change display
parameters to evaluate this data even more thoroughly.

N O T E When saving the measurement, the following settings are not saved:

• selected pattern

• settings of the pattern generator

• settings of the error detector

To save these settings, see “Saving Instrument States” on page 397.

Besides saving a measurement as a file, you can also export the
data to any spreadsheet application.
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Advanced Analysis - Procedures

This section describes some basic functions  that apply to all
measurements.

If you want to store the measurement results for later use, you can
either save them as an .mcp file (to be opened in the Serial BERT
software) or as a .txt file for spreadsheet applications.

How to Save Measurements

To save a measurement as an .mcp file for later use in the Serial
BERT user interface:

1 After your measurement has finished and the results are
displayed, select Save Measurementfrom the Analysis menu.

2 Select a proper file name and location and press the Save button.

How to Export Measurements

To export the measurement data into a .txt file for later use in
external spreadsheet applications:

1 After your measurement has finished and the results are
displayed, select Export Data from the Analysis menu.

2 In the Export dialog box, select the path and file name for the .txt
file.

Alternatively, you can activate the Clipboard checkbox to copy the
data to the clipboard. In this case you can then paste it into any
other application.

3 Press the Format Options button to open the Export/Logfile Format
dialog box.

4 Make further selections for the format of the exported data.
Press OK to close the dialog box.

5 Press OK to export the data to the specified destination.

How to Compare Measurement Results

If you intend to repeat a measurement with different settings, you
may wish to preserve the current results for easier comparison. This
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can be done with all measurements (except Error Location Capture)
by copying the results.

1 In the lower left-hand corner of the measurement window, select
the measured terminal by tipping on it.

2 Select Copy from the Edit menu.

If you have a mouse connected to your Serial BERT , you can
directly copy the measurement via the context menu.

3 Open the Edit menu (or context menu) once more and select
Paste.

This inserts a copy of the chosen measurement results. For an
Output Levels measurement, this looks as shown below:

4 Repeat the measurement with modified parameters and observe
the new results.

5 To distinguish the two graphs, change the color of one graph by
tipping the red Color field.

You can now directly compare the graphical and numerical
results of the two Output Levels measurements.

How to Rename Copied Measurements

To rename a copied measurement for easy distinction:

1 Highlight the copied measurement.

2 Press Enter (or choose Rename from the context menu).

3 Change the name and press Enter.
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How to Load Measurements

To load previously saved measurements:

1 Select Load Measurement from the Analysis menu.

2 Use the file dialog box to locate the desired .mcp file and press
Open to load the measurement.

The respective screen of the Analysis panel opens and you can view
the measurement.

How to Change Measurement Properties and the Graphical Display

The various tabs in the Properties dialog box allow you to specify
the parameters for the measurement. The available options are not
the same for all measurements. See the Reference information of
the respective measurement type for details.

To modify the measurement properties:

1 Press the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required
settings:

– Parameters tab

The settings made on the Parameters tab define how the data
is collected. If you make changes here, you need to run the
measurement again.

– Pass/Fail tab

On the Pass/Fail tab, you can specify the conditions that must
be met by the DUT to pass a test. Changes here do not
require a new test run. The data will be newly calculated and
the results will be displayed.

– View tab , Graph tab,  and Color tab

With the functions on these tabs, you can modify the
graphical display of the results at any time without rerunning
the measurement. This allows you to analyze the results in
different ways and with different preferences.

3 After you have made your changes on the various tabs, press
Apply to employ the settings without leaving the Properties dialog
box. Or press OK to confirm the modifications and close the
Properties dialog box.
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How to Change the Colors of the Graph

You can customize the colors of the graphical display. This function
is common to all measurements:

1 In the Properties dialog box, switch to the Colors tab.

Depending on the current measurement type, you can change:

– BackColor: The background color of the graphs (default is
white)

– BERMarkerColor: The color of the BER Threshold indicator
(default is red)

– ForeColor: The foreground color of the scales and frame of the
graphs (default is black)

– FreqRangesColor: Color of the selected frequency ranges
(default is light yellow)

– GridColor: The color of the dashed grid lines (default is gray)

– PowerMarkerColor: The color of the Noise Threshold marker
(default is red)

2 Select the color that you want to change from the list of used
colors to the left.
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3 Use the Color Set and the Color Palette to select the new color.

4 To view the results of your changes, press Apply.

This immediately updates the measurement window, where you
can see the new colors.

5 Press OK to close the Properties dialog box.

Advanced Analysis - Reference

This section covers reference information such as definitions of
important parameters and the descriptions of supplementary
functions.

Exporting Result Data

If you want to use the measurement results with other applications,
you can export the data to a file via Analysis - Export Data....

The contents of the resulting file may look as follows:

Date:;02/11/05 03:33:17
Version:;1.0
Type:;TM Fast Eye Mask SB-Electrical
UI:;9.6969E-011
Threshold Units:;Volts
Delay:;Relative
[1:1] SerialBERT;;;
Delay;Threshold;BER(All);
 
-3.878757E-011;1.504954E-001;2.497699E-001;
3.878757E-011;1.504954E-001;2.499503E-001;
-1.551503E-011;3.504954E-001;4.922570E-001;
1.551503E-011;3.504954E-001;4.952636E-001;
-1.551503E-011;-4.950459E-002;0.000000E+000;
1.551503E-011;-4.950459E-002;0.000000E+000;
 ;;;
This file can be imported into spreadsheet applications such as
Microsoft Excel, for example. Use the semicolons as delimiters for
the rows or columns.
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Timing Unit Definitions

The timing unit specifies the timebase for the measurements. It is
possible to switch between the unit interval (UI) or seconds for the
time scale. The timebase is set on the View page of the Properties
dialog box.

The following figure and table shows the relationship between UI
and seconds for a 500MHz signal:

An example of the measured range of time expressed in the
different units is listed below:

Table 17

Timebase Earliest
Sampling

Optimum
Sampling
Point

Latest
Sampling

Time rel. -1.5 ns 0 ns +1.5 ns
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Table 17

Timebase Earliest
Sampling

Optimum
Sampling
Point

Latest
Sampling

abs. 54.2 ns 55.7 ns 57.2 ns

Unit interval rel. -0.75 UI 0 UI +0.75 UI

abs. 27.1 UI 27.85 UI 28.6 UI

The Unit Interval

Unit interval values are a convenient way to express time values in
a dimensionless form. One unit interval is the equivalent of one
clock period. To convert a time value to a unit interval value, divide
it by the pulse period or multiply it by the clock frequency.

At 100MHz, the pulse period is 1/100 × 10 -6s = 10 -8s = 10ns; this is
the unit interval (UI). For example, a value-in fact, any parameter
that is specified in time units-of 37ns is equivalent to 37ns/
10ns=3.7UI (time values are expressed as multiples of the unit
interval).

This makes it easy to analyze measurements at different
frequencies: Ifthe measured phase margin is 8ns at 100MHz
(1UI=10ns), and 4ns at 200MHz (1UI=5ns): The phase margin is
0.8UI in both cases, and it is immediately obvious that it does not
depend on the system frequency.

The same is true for the delay resolution parameter in the DUT
Output Timing/Jitter and Eye Opening measurements: If you specify
the delay resolution as 0.01UI, the measurement software will
always measure 150 points across the bathtub, no matter what
system frequency you choose (only if edge optimization is switched
off, of course). However, if you specify the resolution in time, the
number of measured points will change inversely proportional to
the system frequency (doubling the frequency results in half the
number of measured points).

Syntax Requirements

All time-related entries understand both time and unit interval
notation, regardless of the UI/time selection made in the View tab
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of the Properties dialog box. You can enter 17s, 5ns or 0.01UI at any
time. On run, the Serial BERT  will automatically convert all entries
to time values, using the current unit interval. So, the UI is handy
if you want to set values independently from the system frequency.

All voltage-related entries understand 23mV, 0.01V, and so on.

All power-related values can be entered as 50mW, 0.04W, 6dBm,and so
on.

All dimensionless quantities understand decimal notations
(10000000, 0.0003, for example) and scientific/engineering notation
(1e9, 1.7e-3, for example).

Marker Definitions

Markers are available for all measurements except of the Fast Eye
Mask. They make the analysis and tracing of the results more
comfortable. Markers can be switched on or off at any time when
results are available in the graphical view. For the DUT Output
Timing/Jitter measurement, the software provides two types of
markers.

The following illustration shows the definitions for the markers and
the values that can be derived from the marker position.

The following values are displayed for the current marker positions:

Table 18

Value Description

Upper Right Time and BER of the upper right
intersection of the displayed marker lines
(X2 and BER1)
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Table 18

Value Description

Lower Left Time and BER of the lower left
intersection of the displayed marker lines
(X1 and BER2)

Delta Distance between the two vertical
marker lines on the time axis (X2-X1) and
distance of the two horizontal marker
lines on the BER axis (BER1-BER2)

The markers can be moved to keep track of the data.

A Gaussian marker is available for the following measurements:

• DUT Output Timing/Jitter measurement

• Output Levels measurement

The Gaussian marker allows to measure the normal distribution of
measurement results.

The distribution of random values is called normal, if it can be
described by the following formula:
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This formula describes a bell-shaped Gauss curve. If μ is zero and
σ varied, you would get the curves illustrated in the figure below:

The height and position of a normal distribution can be specified
in terms of two parameters: μ and σ. The parameter μ is the mean,
the parameter σ is the standard deviation.

The Gaussian marker shows such a curve. Position, height, and
width of this curve can be changed by dragging the handles, and
the actual parameter values are displayed.

The marker has three handles that can be dragged: two for adjusting
its width, one for changing its height and position.

The following figure shows an exemplary DUT Output Timing/Jitter
measurement result with a Gaussian marker.

The marker readout provides the following information:
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Table 19

Parameter Symbol Meaning

Mu μ Mean.

DUT Output Timing/Jitter
measurement:

The position of the marker
center on the time scale.

Output Levels
measurement:

The position of the marker
center on the vertical
threshold scale.

Sigma σ Standard deviation. The
RMS value of the marked
area.

Kappa κ Linear scaling factor.

A Gaussian marker is used when the jitter graph is displayed. It is
most useful if deterministic jitter is present. In this case, the jitter
graph shows more than one peak (see also “Estimated Total Jitter”
on page 172).

The jitter values Mean, RMS, and Peak-Peak refer to the whole
jitter. The Gaussian marker allows to measure the normal
distribution of individual jitter peaks. You can thus determine how
parts of the jitter histogram contribute to the overall jitter values.

You may have measured a bathtub curve like the one shown below:
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As the bathtub borders are not uniform (both have two edges), the
linear derivative (the jitter) will show two peaks:

If you switch to linear scale and enable the marker, you can see its
bell shape.

You can measure the random jitter distribution of each peak as well
as the distance between the peaks, which means the deterministic
jitter.

You can also use the marker with logarithmic scale. In this case, it
appears as a parabolic curve:

A Gaussian marker is used when the dBER vs. Threshold Graph is
displayed. This graph shows the relationship between the decision
threshold and the absolute values of the derivative of the bit error
rate (dBER/dTh). A linear scale reveals the distribution more clearly
than a logarithmic scale (see “dBER vs. Threshold Graph” on page
202).

In the example below, μ (Mu) and σ (Sigma) will be the same as
the Level and Standard Deviation results calculated by the
measurement.
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But your dBER distribution may also look like this:

The measurement will calculate the Level and Standard Deviation
results from all data points. The marker allows you to measure the
μ (Mu) and σ (Sigma) of the individual peaks.

DUT Output Timing/Jitter

DUT Output Timing/Jitter - Concepts

This type of measurement is used to measure the timing and jitter
behavior for a device under test (DUT). It uses a bit error rate
(BER) measurement to evaluate the shape of the eye for the output
signal of the DUT. It also analyzes the jitter, separates the random
jitter and deterministic jitter components, and estimates the total
jitter.

A direct result is the determination of the optimum sampling point
delay for receiving data from the DUT with maximum confidence.

DUT Output Timing/Jitter includes the Fast Total Jitter
measurement that can be used to measure the total jitter for devices
which generate a very low error density in a reasonable time span.
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Output Timing Characteristics

The sampling point is swept automatically within a 1.5 clock period
to generate a " bathtub" curve. The resulting graph is centered
around the optimum sampling point of the port.

Inaddition, the results are available in a tabular view. If a clock
signal is defined, the software measures the data to clock alignment
and displays the absolute delay.

Jitter Characteristics

The DUT Output Timing/Jitter measurement calculates the jitter
histogram as the absolute of the derivative of the measured bit error
rate (jitter= d BER/dt).

The jitter histogram allows to separate and calculate the different
components making up the jitter:

• Random Jitter (RJ)

• Deterministic Jitter (DJ)

• Estimated Total Jitter (TJ)

The peak-to-peak, RMS, and mean values are displayed in the result
table. They can also be displayed graphically.

“Jitter Measurement Parameters” on page 188 describes how these
components are calculated.

A dedicated Gaussian marker allows to investigate the jitter graph
in detail and to measure the contribution of certain sections or
jitter peaks to the overall results.

You can set several signal parameters, the values to be displayed
and the output format according to your needs.

Fast Total Jitter Measurement Characteristics

This measurement is an alternative to the standard jitter
measurement. It can be used to measure the total jitter at very low
bit error ratios.

Whereas usual jitter measurements at a BER around 10 -12  can take
days (due to the huge number of bits that has to be compared for
each measurement point), the Fast Total Jitter measurement can,
for example, determine the total jitter at a BER of 10 -12  in less than
20minutes (at a data rate of 10 Gbit/s).

For details refer to “Explanation of the Fast Total Jitter
Measurement” on page 173.
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Example Results

The following illustration shows the resulting graph of a typical
DUT Output Timing measurement:

The following figure shows a typical jitter histogram with two peaks
indicating the presence of random and deterministic jitter:

For a detailed explanation of the Fast Total Jitter measurement
results see “Explanation of the Fast Total Jitter Measurement
Results” on page 189.

Understanding the Jitter Calculation

After the output timing behavior of the DUT is measured, the Serial
BERT calculates the different jitter components:

To understand the RJ and DJ results, it is helpful to first
understand how the software generates the results:

1 The bathtub curve is measured.
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2 All measurement points that have BER between the BER
Threshold and Minimum BER for RJ/DJ Separation are transformed
into Q-space.

The Q-factor describes the signal-to-noise ratio at the decision
circuit. It is described in “Understanding the Q-Factor Results”
on page 211.

3 Linear regression is performed for both the left and right edges.

4 The mean and sigma are calculated for both lines:

– RJ is calculated as the mean of the two sigmas.

– DJ is calculated as the period minus the difference of the two
means.

5 The estimated TJ is calculated:

– Linear regression is used to extrapolate the bathtub curve to
lower BER values.

– The intersections of the resulting lines with the Residual BER
for RJ/DJ Separation are located.

– The eye opening is calculated.

The estimated TJ is the period minus the width of the eye
opening.

The illustration below shows a jitter curve where both RJ and DJ
are present. It also shows how the TJ peak-to-peak and RMS are
calculated.
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The Estimated Total Jitter (TJ) allows you to predict the jitter
expected for very low bit error rates that would take a long time
to measure. It is obtained by extrapolating the measured BER
curves.

The TJ is estimated by extending the BER curves (based on the
points detected between the BER Threshold and the Minimum BER for
RJ/DJ Separation) to the Residual BER for RJ/DJ Separation level. The
estimated TJ is the period minus the width of the measured eye.

N O T E The following graphic is not available from the measurement software. It is inserted
here to show how the TJ period is calculated.
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Explanation of the Fast Total Jitter Measurement

The Fast Total Jitter measurement is an optimized method to
determine the total jitter for devices that generate a very low error
density (BER well below 10 -10).

To measure (not estimate) the total jitter for a device with a BER
of 10 -12  with conventional methods, one usually needs to compare
more than 10 12bits for each sample point. To measure a full eye
opening this way with appropriate timely resolution takes time
(maybe days or weeks, depending on the data rate), and the
probability of seeing one or no error in 10 12 bits is not higher than
37percent.

If one would compare 10 13 bits for the same device, the probability
of seeing ten errors is even lower (12 %), but the probability of
observing no error is almost zero.

The Fast Total Jitter measurement implements a method that
reduces the measurement time considerably  and provides a higher
accuracy. It is based on statistical and probability calculations.

The method was presented at the DesignCon 2005 and is described
in "Total Jitter Measurement at Low Probability Levels, using Optimized BERT
Scan Method", included as 5989-2933EN.pdf.

We will not go into the details but provide an introduction.
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Quite often, we do not need to measure the exact BER, but can stop
the measurement if we are sure that the BER is above or below a
threshold. In a jitter tolerance test, for example, we need just to
assure that the device under test operates with a BER better than
let us say 10 -12 ; whether the true BER is 1.1 × 10 -13  or 2.7 × 10 -15

is irrelevant .

To abort the measurement for a single point and proceed to the
next, we need two limits that tell us whether the BER is above or
below the given threshold.

These limits have been calculated from the error probability density
functions applicable to BER measurements. The equations were
solved for a level of confidence of 95%. The calculations have led to
the following table:

Table 20

95% confidence level lower limits, BER
> 10-12

95% confidence level upper limits, BER
< 10-12

Min number of
errors

Max number of
compared bits (×
1012)

Max number of
errors

Min number of
compared bits (×
1012)

1 0.05129 0 2.996

2 0.3554 1 4.744

3 0.8117 2 6.296

4 1.366 3 7.754

5 1.970 4 9.154

6 2.613 5 10.51

7 3.285 6 11.84

The BER threshold of 10 -12  and hence the setting of the
multiplication factor to 10 12 is just an example-by changing the
exponent, the table applies analog to other thresholds.

The following figure shows a plot of this table.
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Note that there is a gap where the BER is so close to 10 -12  that we
cannot decide. For example, if we compared 3 × 10 12 bits and got
two errors (a measured BER of 0.667 × 10 -12), we are in the
"uncertain" white area on the graph.

In such a case, we need to transmit more bits until the number of
bits either reaches the upper limit (6.296 × 10 12), or until we see
more errors. If the actual BER is very close to 10 -12 , however, we
are unable to apply a lower or upper limit to the BER, no matter
how many bits we transmit. Whether such a test fails or passes
depends entirely on the application.

Once we are able to decide for a measured point whether its BER
is above or below the BER threshold, we can determine the total
jitter at the intersection of the BER threshold with the bathtub
curve.

Since we are unable to find a single point on the slope where the
BER is exactly 10 -12 , we search for an interval that brackets the
point at which the BER is equal to 10 -12 . This is illustrated for the
left-hand slope in the following figure.
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We do not need to know the exact BER values at x+ and x-. It is
sufficient to assure that BER(x-) is greater than 10 -12  and BER(x+)
is lower than 10 -12  at a confidence level of 95 %.

The algorithm then assumes that x L (for the left-hand slope of the
bathtub curve) is in the middle of the bracketing interval. After
repeating the procedure to determine x R (for the right-hand slope),
it calculates the total jitter peak-to-peak like in the standard
timing/jitter measurement.

The duration of a Fast Total Jitter measurement depends on:

• the BER threshold

• the bit rate

• the sample delay step size

• the contribution of random jitter

• the contribution of deterministic jitter

Compared to a conservative bathtub measurement, the Fast Total
Jitter measurement can reduce the measurement time by more than
a factor of 40.

Typical test times are approximately 20 minutes at 10Gbit/s and
slightly more than one hour at 2.5 Gbit/s for a measurement at the
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10-12  BER threshold with an overall confidence level better than
90%.

DUT Output Timing/Jitter - Procedures

This section shows how to set up and use the DUT Output Timing/
Jitter measurement. As an example, we measure the output timing
and jitter behavior of a shielded cable.

This requires the following steps:

• Preparing the measurement (see “How to Prepare the DUT
Output Timing/Jitter Measurement” on page 177)

• Executing the measurement (see “How to Execute the DUT
Output Timing/Jitter Measurement” on page 178)

• Optimizing the view of the results (see “How to Optimize the
View of the Results” on page 179)

How to Prepare the DUT Output Timing/Jitter Measurement

To use the DUT Output Timing/Jitter measurement to test a
shielded cable:

1 Disable the pattern generator outputs by pressing the 0V
(Disable) button in the PG Output Setup screen.

2 Use a shielded cable to connect the pattern generator's Data Out
port and the error detector's Data In port.

3 Terminate all non-connected pattern generator output ports with
50 Ω.

4 Use a shielded cable to connect the pattern generator's Data Out
port and the error detector's Data In port.

5 Switch to the Pattern menu and press Pattern Select. Select an
appropriate pattern, for example a pure 2^15-1 PRBS, for both
the pattern generator and the error detector.

6 For the pattern generator setup you need to specify the logic
levels and the bit rate. Select LVPECL levels and Gb Ethernet
(1.06250 G b/s) as clock speed. See “Setting up the Pattern
Generator - Concepts ” on page 69 for more information.

7 Set up the error detector so that the input range and the
termination matches the pattern generator's levels:

– Select an Input Range from 1V to 3V

– Set the Data Termination to 1.3V
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– Set the Clock Setup to Clock Data Recovery to get the error
detector's clock from the incoming data stream.

8 Enable the pattern generator outputs by pressing the 0V
(Disable) button.

9 Press Sync Now and then Auto Align to find the optimum sampling
point. Check that the synchronization and the alignment were
successful. None of the error indicators at the top of the user
interface should show red and the resulting BER should be zero.

How to Execute the DUT Output Timing/Jitter Measurement

To run the DUT Output Timing/Jitter measurement:

1 Switch to the Analysis area. If the Output Timing screen is not yet
displayed, press the Output Timing icon.

2 Press the Start button to execute the measurement.

The measurement software runs the measurement and displays the
results. The following illustration shows the bathtub curve of the
measured bit error rate and-in the tabular view-the calculated
results for the Optimal Sampling Delay, the Skew and the Phase
Margin.
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How to Optimize the View of the Results

After you have run a measurement, the resulting graph and the
calculated numerical values are displayed. To improve the results,
you can change the measurement parameters:

1 Press the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required
settings:

– Parameters tab

These settings are used for data collection. Changes here
require the test to be run again. See “Parameters Tab” on
page 180 for details.

– Pass/Fail tab

These settings determine whether the calculated results are
recognized as passed or failed. However, a new test run is not
required when doing changes here. See “Pass/Fail Tab” on
page 181 for details.

– View tab, Graph tab, and Color tab

All settings on these tabs only affect the way the data is
displayed. You do not need to run the measurement again.
See “View Tab” on page 183, “Graph Tab” on page 185, and
“How to Change the Colors of the Graph” on page 159 for
details.

3 Press OK when you have made all required changes to close the
Properties dialog box.

DUT Output Timing/Jitter - Reference

The DUT Output Timing/Jitter measurement returns the results in
a graphical and in a numerical form. The following sections describe
the results:

• They provide explanations of the measured parameters and the
display options that are specific to this measurement.

• Additionally, some information is provided to explain the
theoretical background behind the jitter calculations.

T I P You have access to the user documentation (including User's Guide) over the
instrument's Start menu: Start->Programs->N4900 Series Documents.
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Properties that can be specified on the various tabs of the 
Properties dialog box:

Parameters Tab

N O T E If you modify the parameters on this page, you have to rerun the measurement to
update the results.

Set the criteria for moving to the next sample point:

• Number of Compared Bits

After this number of compared bits, the measurement stops for
the current sample point and moves to the next one.

• Number of Errors

After this number of errors, the measurement stops for the
current sample point and moves to the next one. Thisallows you
to speed up the measurement. You can switch off this option if
only the number of compared bits is important.

N O T E The measurement moves to the next sample point when the first of the two criteria
is reached.

Both numbers are ignored if the Fast Total Jitter measurement is selected.

Set the criteria for the sample delay:

• Resolution

Specifies the time distance between sampling points. A smaller
value yields more sampling points in a unit interval. You can
enter the resolution in UI or ps, ns, s, .... The timebase of the
display is set on the View tab.

If the resolution used for the measurement is not high enough,
the bathtub curve does not clearly show the edges. For example,
you may wish to change the Resolution from 0.01 to 0.005 and
run the measurement again.

• Optimization

You can choose between Edge Resolution Optimization, Fast Total Jitter
at BER, or None.

– Edge Resolution Optimization

Turns the resolution optimization on or off. If this option is
enabled, the Serial BERT  intelligently sets a resolution so that

5 Advanced Analysis

180 Agilent J-BERT N4903 High-Performance Serial BERT



there are more sampling points at the edges. This can greatly
improve the results without dramatically increasing the
duration of the test.

The following illustration shows a diagram with default
resolution and no edge resolution optimization:

The following illustration shows a diagram with high
resolution and edge resolution optimization. For the areas of
the diagram with edges, additional sampling points are taken,
resulting in a much better display of the signal shape:

– Fast Total Jitter at BER

This enables the Fast Total Jitter measurement. Before
enabling this measurement, you need to know the BER floor
of the device and to specify a BER threshold that is above
that floor. For details see “Explanation of the Fast Total Jitter
Measurement” on page 173.

Pass/Fail Tab

The Pass/Fail tab of the Properties dialog box allows you to specify
the criteria to decide whether the DUT passes or fails the test. You
can change pass/fail criteria without rerunning a test. The software
only uses the criteria to rate the results of a measurement.

N O T E The pass/fail criteria do not control measurement execution. The measurement run
will be completed even if the measurement fails for one or more of the criteria.
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You can set pass/fail limits individually for the output timing
parameters and the jitter measurement parameters:

• For information on the DUT Output Pass/Fail criteria, see also
“Output Timing Measurement Parameters” on page 187.

• For information on the Jitter Pass/Fail criteria, see also “Jitter
Measurement Parameters” on page 188.

N O T E If the results of a Fast Total Jitter measurement are displayed, only the appropriate
parameters are compared and flagged:

• Phase Margin

• Optimal Sample Delay

• Total Jitter Peak to Peak

• Fast Total Jitter Uncertainty

Other pass/fail limits may be enabled but are ignored.

In the tabular view, each of the calculated values will be marked
with an
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icon if it failed the test.

The following illustration shows a DUT Output Timing/Jitter
measurement that has failed the criterion for the phase margin.

View Tab

The graph shows either the bathtub curve or the jitter distribution
vs. time.

The BER graph (the bathtub) shows the BER vs. sample delay.

The BER graph can be viewed in either linear and logarithmic view.
The logarithmic view is shown above.

The DUT Output Timing/Jitter measurement calculates the jitter
histogram as the absolute of the derivative of the measured bit error
rate (jitter=dBER/dt).
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N O T E Because the right-hand slope of the tub does not provide additional information on
the jitter, the measurement's jitter display shows only the portion at the left-hand
side of the optimum sampling point.

The jitter histogram allows you to visually inspect the jitter
components:

• Random Jitter (RJ)

• Deterministic Jitter (DJ)

• Estimated Total Jitter (TJ)

“Jitter Measurement Parameters” on page 188 describes how these
components are calculated.

A Gaussian marker is available in this view to help analyze the
jitter components. See “The Gaussian Marker” on page 164 for
details.

Furthermore, the following parameters can be set on the View tab
of the Properties dialog box:

You can analyze for:

• All Errors

To calculate the BER values from all bits/errors.

• Errors if 0s Expected

To calculate the BER values if "0" is expected, but "1" received.

• Errors if 1s Expected

To calculate the BER values if "1" is expected, but "0" received.
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You can calculate measurement parameters for:

• 0 Errors

To calculate the parameters for 0 errors.

If this is selected, RJ/DJ separation is not available.

• BER Threshold

To calculate the parameters for the given BER threshold. This is
the BER level for which output timing numerical values (phase
margin, skew, etc.) are calculated. It is also the upper limit of
the BER range for RJ/DJ separation.

The BER threshold influences some of the parameters of the DUT
Output Timing measurement. You can also drag and drop the
horizontal BER threshold in the graphical display to change this
value.

• Min BER for RJ/DJ Separation

Lower limit of the BER range for RJ/DJ separation.

• Residual BER for Estimated Total Jitter

BER level for which the estimated total jitter is calculated. See
“Estimated Total Jitter” on page 172 for details on how it is
used.

You can select the number of Decimal Places to be displayed in the
table.

Graph Tab

On the Graph tab, you can use the several options to optimize the
graphical display according to your needs.

Choose between Unit Interval and Seconds to select the timebase for
the display's x-axis.

Choose between Logarithmic and Linear to select the scale for the
display's y-axis.

For example, a DUT Output Timing measurement displayed on a
linear scale may look like this:
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To analyze the graphs at a particular point, you can use the
markers. Additionally, you can display all related values for the
markers in the marker readout.

Pressing the Reset Markers button will set the markers back to the
default positions.

Several zoom factors are available. When you show the zoom graph,
you can also allow the zoom graph to track the mouse (or your
finger, if you are working directly on the Serial BERT ).

If you want to see the points that have actually been measured,
choose Show Measured Points.
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Explanation of the Numerical Results

The measurement provides numerical results for:

The output timing measurement parameters are defined in the
following table:

Table 21

Parameter Description Definition

Optimal Sample Point
Delay

The average of the left (A)
and right (B) bathtub/BER
threshold intersections.

(A+B)/2

Phase Margin The period of time where
the bit error rate is lower
than the BER threshold.

B-A

The A and B values are the left and right intersections of the
bathtub curves with the BER threshold. Obviously, all values change
if the BER threshold is modified.

The following illustration shows an example for a measurement.
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N O T E This graphical view is not available in the measurement software.

The jitter measurement parameters are defined in the following list.

N O T E All jitter measurement parameters (except the Total Jitter RMS and Total Jitter
Mean) change with the BER threshold.

• Total Jitter RMS

The average of the left and right jitter histogram root mean
squared values.

• Total Jitter Peak-to-Peak

Peak-to-peak value for total jitter. Calculated as the pulse period
(unit interval) minus the Phase Margin.

• Jitter Mean

Mean value for total jitter. Calculated as the weighted average of
the left edge jitter histogram.

• Random Jitter RMS

The total jitter component with Gaussian distribution. After
transforming a contiguous range of measured points into Q space
and performing a linear regression, it is calculated as the mean
of the sigmas of the two straight lines. The contiguous range is
limited by the the BER Threshold and the Min. BER for RJ/DJ
Separation threshold.

• Deterministic Jitter

The total jitter component with non-Gaussian distribution. After
transforming a contiguous range of measured points into Q space
and performing a linear regression, it is calculated as the period
minus the difference between the means of the two straight lines.

• Estimated Total Jitter

A forecast of the expected jitter for very low bit error rates.
After extrapolating the measured BER curves, it is calculated as
the period minus the expected width of the eye opening.

• No. of points

This is the number of points that has been measured between
the BER Threshold and the Min. BER for RJ/DJ Separation threshold.
It is displayed for both slopes. This number has to be greater
than 2 for the RJ, DJ, and estimated TJ values to be applicable.
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• R^2 values

The R^2 values are calculated for both slopes of the bathtub
curve. They are a measure of how well the transformed points
between BER Threshold and Min. BER for RJ/DJ Separation fit to the
linear regression. They have to be greater than 0.75 for the RJ,
DJ, and estimated TJ values to be applicable.

Unavailable Values

Under certain circumstances, some numerical results are not
available. This is indicated by <invalid> or <not applicable> in the
numerical results table below the measurement graphic.

• <invalid>indicates that the value could not be calculated. This is
the case, for example, for phase margin, when the BER threshold
is set to high values and does not intersect with the bathtub
curve.

• <not applicable> indicates that the value could be calculated,
however is not shown because quality criteria are not met. This
is the case, for example, for RJ/DJ results, when the r^2 value
of one or both edges is <0.75. Even though RJ/DJ values can be
calculated in this case, they are not shown because confidence
in the results is too low.

Explanation of the Fast Total Jitter Measurement Results

The Fast Total Jitter measurement provides both graphical and
numerical results:

The example below shows a copied result, and the display of
measured points was enabled.

The results of the recent measurement are disabled, because they
refer to a standard "bathtub" measurement that provides many more
results. By actuating the Show indicator, you can inspect both
alternatively.
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The result graph shows you the points in time that have been
investigated and whether the actual BER at these points was higher
or lower than the BER threshold specified for the measurement. The
grey area in the middle indicates the uncertainty band (see
“Explanation of the Fast Total Jitter Measurement” on page 173).

N O T E The test will fail, if the BER floor is not well below the BER threshold specified for
the measurement.

The Fast Total Jitter measurement result parameters are
summarized in the following list:

• Phase Margin

The period of time where the bit error rate is lower than the
Total Jitter BER Threshold.

• Total Jitter Peak-Peak

Peak-to-peak value of the total jitter. Calculated as the pulse
period (unit interval) minus the Phase Margin at the Total Jitter BER
Threshold.

• Total Jitter Uncertainty

The maximum of the uncertainties of both slopes. Measured as
the time between a point with a BER greater than the specified
Total Jitter BER Threshold and the next point with a BER less than
the specified Total Jitter BER Threshold (left slope) and vice versa
(right slope).

• Total Jitter BER Threshold

The BER threshold specified for the measurement.

• Optimal Sample Point Delay
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The mean value of the left and right bathtub/ Total Jitter BER
Threshold intersections.

Output Levels

Output Levels - Concepts

The Output Levels measurement allows you to characterize the
behavior of the output levels of a device under test (DUT). The
sampling delay is fixed. The error detector's decision threshold is
automatically swept within a user-defined range.

A direct result is the determination of the optimum decision
threshold level for receiving data from the DUT with maximum
confidence.

Three Available Views

The Output Levels measurement provides three different graphical
views to visualize the calculated results:

• BER versus Threshold

This graph shows the relationship between the analyzer decision
threshold and the resulting BER. It presents the raw data.

• dB Histogram versus Threshold
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This graph shows the relationship between the analyzer decision
threshold and the derivative of the bit error rate (dBER/dTh). A
Gaussian marker allows you investigate the peaks of this graph.

• Q from BER versus Threshold

This graph shows the extrapolation of the Q-factor and the
optimum threshold level from a limited number of measured
points.

Example Results

The following illustration shows the BER versus Threshold graph of a
simple Output Levels measurement:

Changing Properties

If you change the measurement settings after the measurement has
been run, please note:

• Parameters that affect the data capture.

Changes on the Parameters tab take only effect if you run the
measurement again. To remind you that the present results have
not been obtained with the modified settings and that you should
repeat the measurement, the result display shows a yellow bar.

• Parameters that change the display of the measured data.

Changes on the Pass/Fail, View, Graph, and Color tabs only affect
the display of the results. There is no need to repeat the
measurement.
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Variable Decision Threshold Method

The method used by this measurement is commonly known as
Variable Decision Threshold Method. It provides a "vertical"
analysis of the eye opening seen by the receiver. This method allows
you to determine more than just the actual levels.

The Output Levels measurement also calculates the Q-factor (a
measure that describes the quality of the received signal) and
derived values. These results can assist you in characterizing the
device. They can also enable you to predict very low bit error rates
that would take a long time to be measured.

Output Levels - Procedures

This section shows you how to set up and perform an Output Levels
measurement. As an example, we measure the output level behavior
of a shielded cable.

This requires the following steps:

• Preparing the measurement (see “How to Prepare the Output
Levels Measurement” on page 193)

• Executing the measurement (see “How to Execute the Output
Levels Measurement” on page 194)

• Improving the Display (see “How to Improve the Output Levels
Display” on page 196)

• Changing the Properties (see “How to Change the Output Levels
Properties” on page 197)

• Using the different views (see “How to Use the Different Views”
on page 197)

How to Prepare the Output Levels Measurement

To prepare an Output Levels measurement to test a shielded cable:

1 Disable the pattern generator outputs by pressing the 0V
(Disable) button in the PG Output Setup screen.

2 Use a shielded cable to connect the pattern generator's Data Out
port and the error detector's Data In port.

3 Terminate all non-connected pattern generator output ports with
50 Ω.

4 Use a shielded cable to connect the pattern generator's Data Out
port and the error detector's Data In port.
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5 Switch to the Pattern panel and press Pattern Select. Select an
appropriate pattern for this test. We use a pure 2^23-1 PRBS
segment.

6 For the pattern generator setup you need to specify the logic
levels and the bit rate. Select ECL levels and a clock speed of
1250 M Hz in this example. This corresponds to a clock period
of 0.8ns. See “Setting up the Pattern Generator - Concepts ” on
page 69 for more information.

7 Set up the error detector so that the input range and the
termination matches the pattern generator's levels:

– Select an Input Range from -2V to 0V

– Set the Data Termination to -2V

– Set the Alignment BER Threshold to 1E-6.

– Set the Clock Setup to Clock Data Recovery to get the error
detector's clock from the incoming data stream.

8 Enable the pattern generator outputs by pressing the 0V
(Disable) button.

9 Press Sync Now and then Auto Align to find the optimum sampling
point. Check that the synchronization and the alignment were
successful. None of the error indicators should show red.

The resulting BER should be zero.

How to Execute the Output Levels Measurement

To run the Output Levels measurement:

1 Switch to the Analysis panel and then press the Output Levels icon.

2 Press the Properties button to open the Properties dialog box.

3 On the Parameters tab, set the Sample Threshold parameters to
suitable values that fit to the expected signal levels, for example,
-1.85V to -0.85V. Set the Resolution to 10 mV.
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In this example, we expect the signal voltages to be between
-1.75V and -0.95V. The Sample Threshold values proposed above
cover this range well.

The Resolution is the distance between the measurement points
when the threshold moves from the low to the high level. A
resolution of 10mV results in 100 measured points per Volt.

Note that we have disabled the Edge Resolution Optimization.

4 Press OK to close the Properties dialog box.

5 Press the Start button to execute the measurement.

The measurement is run, and the result window shows the bit
error rates measured at 100 threshold levels from -1.85V up to
-850mV.
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How to Improve the Output Levels Display

You can change the display of an existing measurement, for
example, if you wish to see more details to investigate the graph.

This can be done on the Graph tab of the Properties dialog box:

1 Press the Properties button. If you have a mouse connected to
your Serial BERT , you can also click the right mouse button on
the graph and select Properties from the context menu.

2 Switch to the Graph tab.

3 As an example, select Show Measured Points.

With this option selected, all measured points are indicated in
the graph with small squares.

The headline of the graph tells the number of data points
included in the display: 101. This corresponds to the chosen
threshold resolution of 100 steps per Volt. With this number of
measured points, you do not get very precise results during the
measurement, but it is quickly finished.

Depending on your personal needs, you can trade measurement
precision against test time.

4 Several more options are provided on the Graph tab for you to
adjust the display as you want. For instance, you can use
markers for analyzing the graph or open a zoom window for
viewing the details. To find more information, refer to “Graph
Tab” on page 204.
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How to Change the Output Levels Properties

In the example measurement, we have set the focus on speed: 100
threshold levels and 1,000,000 compared bits per measuring point.
You may wish to obtain more precise results.

1 Press Properties and switch to the Parameters tab.

2 Increase the Number of Compared Bits to 100,000,000.

Remember: One failure per 1 million bits yields a BER resolution
of 10 -6 . One failure per 100 million bits yields a BER resolution
of 10 -8 .

3 Decrease the Resolution (the threshold step size) to 2mV.

This gives us 500 steps per Volt.

4 Press OK to confirm your changes.

5 Press the Start button to repeat the measurement with the new
parameters.

The measurement now takes more time than the previous, but it
is also much more precise.

When you move the BER Threshold bar, you will see that some of the
calculated values change. This is explained in “Explanation of the
Numerical Results” on page 205.

How to Use the Different Views

To switch between the different views of the Output Levels
measurement:

1 Press Properties and switch to the View tab.

2 Select dB Histogram versus Threshold.

This gives you another view of the measured data.

3 Switch to the Graph tab and select Linear Scale.

The data remains the same, but a linear scale makes it easier to
see the distribution.
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This graph shows the absolute values of the derivative of the bit
error rates over the thresholds (dBER/dThreshold). It visualizes the
data that forms the basis for the calculations of the level and noise
values.

The graph provides a special marker that allows you to estimate the
data distribution by approximating it by means of a Gaussian
normal distribution.

The Output Levels measurement provides a third graphical display:
the Q from BER versus Threshold graph. This graph refers to the Q-factor
calculations. For details on these calculations see “QBER vs.
Threshold Graph” on page 203 and “Understanding the Q-Factor
Results” on page 211.

Output Levels - Reference

The Output Levels measurement returns the results in a graphical
and in a numerical form. The following sections provide
explanations of the measured parameters and the display options
that are specific to this measurement. Additionally, some
information is provided to explain the theoretical background
behind.

The properties of the Output Levels measurement can be specified
on the various tabs of the Properties dialog box.

Parameters Tab

N O T E If you modify the parameters on this page, you have to rerun the measurement to
update the results.

Set the criteria for moving to the next sample point:

• Number of Compared Bits
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After this number of compared bits, the measurement stops for
the current sample point and moves to the next one.

• Number of Errors

After this number of errors, the measurement stops for the
current sample point and moves to the next one. Thisallows you
to speed up the measurement. You can switch off this option if
only the number of compared bits is important.

N O T E The measurement moves to the next sample point when the first of the two criteria
is reached.

Set the criteria for the sample threshold:

• Resolution

Specifies the distance between the sampling points. The lower
this value is, the more sampling points you have in the selected
voltage range. The minimum step width is hardware-dependent.
At the time being, the minimum is 1 mV.

• Low Level

This is the lower end of the measured voltage range.

• High Level

This is the upper end of the measured voltage range.

• Edge Resolution Optimization

Turns the resolution optimization on or off. If this option is
enabled, the Serial BERT  intelligently sets a resolution so that
there are more sampling points at the edges. This can greatly
improve the results without dramatically increasing the duration
of the test.

In the following example, a step width of 2 mV was used. This
has led to 502 data points per Volt.

If Edge Resolution Optimization is enabled, the software first scans
the threshold range in relatively coarse steps and determines the
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areas where the signal produces no edges-that means, where the
BER is nearly constant.

Then, the algorithm uses the specified step width for measuring
the regions where the BER changes, and a much lower resolution
(about one tenth) for measuring the regions where the BER is
constant.

This reduces the number of data points to 145, as shown in the
figure below.

As you can see from the figures above, Edge Resolution
Optimization does not sacrifice the precision of the measurement.
But it can reduce the measurement duration considerably,
especially if you compare a large number of bits at a low data
rate.

Pass/Fail Tab

The Pass/Fail tab of the Properties dialog box allows you to specify
the criteria to decide whether the DUT passes or fails the test. You
can change pass/fail criteria without rerunning a test. The software
only uses the criteria to rate the results of a measurement.

N O T E The pass/fail criteria do not control measurement execution. The measurement run
will be completed even if the measurement fails for one or more of the criteria.

You can set pass/fail limits individually for level, noise, and Q-
factor parameters.

• To set the Level Pass/Fail criteria, see also “Level Results” on page
205.

• To set the Signal/Noise Pass/Fail criteria, see also “Noise Results”
on page 206.

• To set the Q Factor Pass/Fail criteria, see also “Q-factor Results”
on page 207.

Your setup may finally look as shown below:
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In the following figure, you can see how errors are flagged.
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If you compare the Low Level result with the limit we have set on
the Pass/Fail tab, you will find that the measured result fails the
upper pass/fail limit for this parameter.

View Tab

The graph shows either the BER vs. Threshold, the dBER vs. Threshold,
or the QBER vs. Threshold.

This graph shows the relationship between the analyzer decision
threshold and the measured BER.

The BER considers all errors. It is calculated as:

This graph shows the relationship between the analyzer decision
threshold and the absolute values of the derivative of the bit error
rate (dBER/dTh).

It is recommended to view this graph with a linear scale because a
linear scale reveals the distribution more clearly:

This distribution can often be approximated by a Gaussian normal
distribution. With a Gaussian marker you can measure the mean
and standard deviation of the normal distribution (see also “The
Gaussian Marker” on page 164 and “Graph Tab” on page 204).
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This graph shows the extrapolation of the optimum Q-factor and
the optimum threshold level from a limited number of measured
points.

The measured data points to be used for the calculation have to be
within a contiguous BER range. This range is defined by specifying
the Min BER for Q (lower threshold) and the BER Threshold (upper
threshold). Both thresholds can be set in the lower section of the
View tab.

The Q-factor can only be calculated if for both high and low lever
rails two or more points fall within the defined BER range. For
reliable results use at least five measured points.

To ensure proper settings, activate the Show Measured Points function
on the Graph tab and switch to the BER vs. Threshold graph. Move the
upper BER threshold marker (vertical line) so that a sufficient
number of measured points is included for the calculation:

From these points, the following QBER vs. Threshold graph is
generated:

This graph illustrates the calculation of the Q-factor (65 in the figure
above) as the best fit line through the calculated points. This
method makes the calculation reproducible. For details see “Q-
factor Results” on page 207.

Furthermore, the following parameters can be set on the View tab
of the Properties dialog box:
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You can calculate measurement parameters for:

• BER Threshold

This is the bit error rate threshold at which the Threshold
Margin is determined. It is also the upper threshold for the Q-
factor calculations.

The BER Threshold is displayed in the BER vs. Threshold graph.
There, it can be positioned with the mouse (or your finger, if
you are working directly on the Serial BERT ).

• Min BER for Q

This is the lower threshold for the Q-factor calculations.

You can select the number of Decimal Places to be displayed in the
table.

Graph Tab

On the Graph tab, you can use the several options to optimize the
graphical display according to your needs.

Choose between Logarithmic and Linear to select the scale for the
display's x-axis.

The scale of the QBER vs. Threshold graph is always linear.

Ratios in the numerical results (such as SNR) can be displayed
linearly or logarithmically in dB.

To analyze the graphs at a particular point, you can use the
markers. Optionally, you can display all related values for the
markers in the marker readout.

Pressing the Reset Markers button will set the markers back to the
default positions.

Linear markers are available for the BER vs. Thresholdgraph and the
QBER vs. Threshold graph. A gaussian marker is available for the dBER
vs. Threshold graph. See “Marker Definitions” on page 163 for details.

Several zoom factors are available. When you show the zoom graph,
you can also allow the zoom graph to track the mouse (or your
finger, if you are working directly on the Serial BERT ).
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If you want to see the points that have actually been measured,
choose Show Measured Points.

N O T E If you have a mouse connected to your Serial BERT, you can access many
parameters and display options conveniently from the context menu. This looks as
shown below:

Explanation of the Numerical Results

The result parameters are divided into three groups:

The level result parameters are summarized in the following table:

Table 22

Parameter Name Pass/Fail

High Level min/max

Low Level min/max

Mean Level min/max

Amplitude min/max

Threshold Margin min

For all parameters, pass/fail limits can be set, as indicated in the
table.

The level parameters are defined as follows:

• High Level
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The High Level is the mean of the upper dBER/dTh distribution.
It is calculated as:

• Low Level

The Low Level is the mean of the lower dBER/dTh distribution.
It is calculated as:

• Mean Level

The Mean Level is the middle between the High and Low Levels,
calculated as:

• Amplitude

The Amplitude is the difference between its High and Low
Levels.

• Threshold Margin

The Threshold Margin is the distance between the upper and the
lower BER curves at the position given by the BER Threshold
setting.

The noise result parameters are summarized in the following table:

Table 23

Parameter Name Pass/Fail

High Level Std. Dev

Low Level Std. Dev

Peak Peak Noise max

Signal/Noise Ratio (RMS) min

Signal/Noise Ratio (Peak Peak) min

For some of these parameters, pass/fail limits can be set, as
indicated in the table.
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The noise parameters are defined as follows:

• High Level Std. Dev.

The standard deviations are derived from the dBER/dTh
histogram.

The High Level Standard Deviation is calculated as:

where Mean is the High Level of the terminal.

• Low Level Std. Dev.

The Low Level Standard Deviation is calculated as:

where Mean is the Low Level of the terminal.

• Peak Peak Noise

The peak-to-peak Noise is calculated as:

Note that the Threshold Margin depends on the position of the
BER Threshold.

• Signal/Noise Ratio (RMS)

The RMS Signal-to-Noise Ratio is calculated as:

• Signal/Noise Ratio (Peak Peak)

The peak-to-peak Signal-to-Noise Ratio is calculated as

Note that the Peak Peak Noise depends on the position of the
BER Threshold.

The Q-factor result parameters are summarized in the following
table:
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Table 24

Parameter Name Pass/Fail

Q Factor min

Q Optimum Threshold min/max

Q Residual BER max

Q High Level

Q High Level Std.Dev

Q High Level Nr. Points

Q High Level R^2

Q Low Level

Q Low Level Std.Dev

Q Low Level Nr. Points

Q Low Level R^2

For some of these parameters, pass/fail limits can be set, as
indicated in the table.

The numerical Q-factor parameters are defined as follows:

• Q Factor

The Q-factor is calculated as:

where μ1,0 is the mean level of the 1 and 0 rails, respectively,
and σ1,0 is the standard deviation of the noise distribution on
the 1 and 0 rails.

• Q Optimum Threshold

The Q Optimum Decision Threshold is calculated as:
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Optimum Decision Threshold =
s0m1 + s1m0

s1 + s0

• Q Residual BER

The Q Residual BER is the expected BER at the Optimum
Decision Threshold. It is calculated as:

e
Qopt  2p

-(Q 2/2)
BER =

Numbers below 1e-255 are expressed as zero.

• Q High Level

The Q High Level is the mean, calculated from the linear
regression curve for the high level data:

m =
-A
B

• Q High Level Std.Dev

The Q High Level Standard Deviation is the σ (Sigma), calculated
from the linear regression curve for the high level data:

s =  -
1
B

• Q High Level Nr. Points

This is the number of data points used for the calculation of the
Q High Level value. It depends on the setting of the BER
Threshold and also on the setting of the Min BER for Q parameter.

The minimum for calculating Q-factor values is two points. It is
recommended to use more than 5 points.

• Q High Level R^2

The R 2 parameter is an indicator that shows how well the
converted data points fit to the straight line. It is calculated as:

R2 =
SXY -

(SX)( SY)
n

2

SX 2 - (SX)2

n SY 2 - (SY)2

n
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The R 2 parameter should be examined before trusting the Q-
values. Its maximum value is 1.0. It must be seen in conjunction
with the number of data points.

For example: Two data points always fit perfectly well, but the
resulting Q-factor calculations are not reliable. On the other
hand, 50 data points may reveal a poor R 2 value. This tells you
that the linearization is prone to errors.

If the R 2 value falls below 0.75, the Q-factor calculations are not
applicable.

• Q Low Level

The Q Low Level is the mean, calculated from the linear
regression curve for the low level data:

m =
-A
B

• Q Low Level Std.Dev

The Q Low Level Standard Deviation is the σ (Sigma), calculated
from the linear regression curve for the low level data:

s =  -
1
B

• Q Low Level Nr. Points

This is the number of data points used for the calculation of the
Q Low Level value. It depends on the setting of the BER
Threshold and also on the setting of the Min BER for Q parameter.

The minimum for calculating Q-factor values is two points. It is
recommended to include more than 5 points.

• Q Low Level R^2

See the definition of "Q High Level R^2".

Unavailable Values

Under certain circumstances, some numerical results are not
available. This is indicated by <invalid> or <not applicable> in the
numerical results table below the measurement graphic.

• <invalid>indicates that the value could not be calculated. This is
the case, for example, for phase margin, when the BER threshold
is set to high values and does not intersect with the bathtub
curve.
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• <not applicable> indicates that the value could be calculated,
however is not shown because quality criteria are not met. This
is the case, for example, for RJ/DJ results, when the r^2 value
of one or both edges is <0.75. Even though RJ/DJ values can be
calculated in this case, they are not shown because confidence
in the results is too low.

Understanding the Q-Factor Results

The variable decision threshold method used by the Output Levels
measurement makes it possible to determine the Q-factor of a
signal.

N O T E The Q-factor method and the related calculations have been published under Margin
Measurements in Optical Amplifier Systems by Neal S. Bergano, F. W. Kerfoot, and
C. R. Davidson in IEEE Photonics Technology Letters, Vol. 5, No. 3, March 1993.

Mathematical Background

Bit errors are caused by noise, and the Q-factor describes the
signal-to-noise ratio at the decision circuit.

It is possible to calculate the Q-factor from a limited number of
measured BER vs. threshold data points. It is also possible to
calculate expected bit error rates from the Q-factor. This is a
method for predicting very low bit error rates (typically below
10-11) that would take a long time to measure.

The Q-factor is calculated as:

where μ1,0 is the mean level of the 1 and 0 rails, respectively, and
σ1,0 is the standard deviation of the noise distribution on the 1 and
0 rails.

The μ1,0 and σ1,0 values are calculated from a selected range of data
points. This calculation is correct if the noise distribution has
Gaussian characteristics. Then, the bit error rate can be expressed
as:
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where D is the decision threshold, μ1,0 and σ1,0 are the mean and
standard deviation of the 1 and 0 rails, and erfc (x) is the
complementary error function.

This formula is the sum of two terms. It considers the probabilities
of deciding that a "0" has been received when a "1" was sent, and
that a "1" has been received when a "0" was sent.

For the following calculations, the assumption is made that the BER
is dominated by only one of the terms noted above, depending on
whether the threshold is closer to the 1 or 0 rail.

For the complementary error function

1
2p

erfc(x) =
x

8

-b 2/2
e db

1
x   2 p

-x 2/2e

an inverse logarithmic approximation exists:

erfc(x)1
2

Log
-1

1.192 - 0.6681x - 0.0162 x2

where x = Log(BER).

This function, applied to the high level and low level data points,
yields new threshold vs. value combinations.

In the area of low BER (typically below 10 -4), these new data pairs
should fit to two straight lines, although a couple of assumptions
and approximations have been made.

To determine the gradient and offset of these lines, a linear
regression is performed. This is illustrated in the figure below.

A straight line can be expressed as:
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Y = A + BX

where Y is the inverse error function of BER, and X is D, the
decision threshold.

The following calculations are performed for the high and low level
data:

SXY - (SX)(S Y)
n

SX2 - (SX)2

n
B =

SY
nA = - B S  X

n

where n is the number of respective data points.

The results of the linear regression are displayed in the QBER vs.
Threshold graph.

This graph shows two straight lines. The intersection of these lines
marks the Q-factor and the Q optimum Threshold.

Mathematically, the standard deviation and mean values are
calculated as:

s =  -
1
B

m =
-A
B

This calculation leads to the values of μ1,0 and σ1,0.
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Notes on the Q-Results

You can specify the range of data points used for these calculations
by means of the Min BER for Q and BER Threshold parameters (see also
“View Tab” on page 202).

For example, you can calculate the Q-factor from relatively few data
points with measured bit error rates between 1e-10 and 1e-5. The
calculation tells you the optimum decision threshold and also the
BER expected when the error detector uses this threshold.

To measure such small bit error rates, you have to compare an
adequate number of bits. Depending on the DUT characteristics, you
may also have to use a very fine step size for the threshold
variation.

On the other hand, such a comparison may make it easier to
understand the dependencies.

If you set the BER Threshold to a position that gives you only a few
data points, you will find:

• The Q-factor is relatively high.

• The R 2 values are excellent (greater than 0.95).

• The mean levels and standard deviations returned by the Q-
factor calculations differ from the measured values.
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The QBER vs. Threshold graph may look as shown below:

If you increase the BER Threshold to include more points, you will
find:

• The mean levels and standard deviations returned by the Q-
factor calculations approach the measured values.

• The Q-factor decreases.

• The R 2 values deteriorate.

The latter is caused by increasing nonlinearity. This can be
inspected in the QBER vs. Threshold graph.

N O T E The Q-factor calculations are disabled and flagged as "not applicable" if the R2 value
falls below 0.75.

The R 2 value can also be seen as an indicator of how well the noise
distribution fits to Gaussian shape. It will not fit, for example, if
the received signal is dominated by cross-talk or modal noise.
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Eye Opening

Eye Opening - Concepts

The Eye Opening measurement generates a three-dimensional bit
error rate (BER) diagram as a function of the sample delay and the
sample threshold. With this measurement, the complete eye of the
DUT output signal is measured. The results comprise the voltage
and timing of the eye opening and the optimum sampling point.

To get the result, the sampling delay and the input threshold of the
signal are shifted within 1.5 signal periods and a user-defined
voltage range. The results comprise the voltage and timing of the
eye opening and the optimum sampling point.

An example, that illustrates the general principle of the Eye
Opening measurement is shown in the figure below.

In detail, the measurement is not that simple and more precise as
it derives the contour of the eye from the bit error rates that have
been measured.
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Three Available Views

The Eye Diagram can be visualized in three different ways:

• Contour Plot

The contour plot shows discrete lines of equal bit error rate-just
like the contour lines on a map. The color of a line indicates the
respective BER value. This graph is useful to visualize in which
areas the BER changes-a homogeneous BER field will give you
no lines at all.

• Pseudo Color Plot

This plot visualizes the BER by a continuous color gradient. It
uses different colors for the regions between the lines of equal
BER. This is useful to get an immediate visual impression of the
distribution of the BER in the eye diagram.
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• Equal BER at BER threshold

This graph displays only one curve for the chosen bit error rate
threshold.

Example Results

The following figure shows the graphical result of a typical Eye
Opening measurement:

Eye Opening - Procedures

This section shows how to set up and perform an Eye Opening
measurement. As an example we measure the eye diagram of a
shielded cable.
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This requires the following steps:

• Preparing the measurement (see “How to Prepare the Eye
Opening Measurement” on page 219)

• Executing the measurement (see “How to Execute the Eye
Opening Measurement” on page 220)

• Optimizing the view of the results (see “How to Optimize the
View of the Results” on page 221)

• Using the color bar (see “How to Use the Color Bar” on page
221)

• Adding or changing colors (see “How to Add or Change Colors”
on page 222)

• Changing the BER threshold (see “How to Change the BER
Threshold” on page 223)

• Changing the BER range of a color (see “How to Change the BER
Range of a Color” on page 223)

How to Prepare the Eye Opening Measurement

To prepare an Eye Opening measurement to test a shielded cable:

1 Disable the pattern generator outputs by pressing the 0V
(Disable) button in the PG Output Setup screen.

2 Use a shielded cable to connect the pattern generator's Data Out
port and the error detector's Data In port.

3 Terminate all non-connected pattern generator output ports with
50 Ω.

4 Switch to the Pattern panel and press Pattern Select. Select an
appropriate pattern, for example a pure 2^15-1 PRBS, for both
the pattern generator and the error detector.

5 For the pattern generator setup you need to specify the logic
levels and the bit rate. Select ECL levels and a clock speed of
1250 MHz in this example. This corresponds to a clock period of
0.8ns. See “Setting up the Pattern Generator - Concepts ” on
page 69 for more information.

6 Set up the error detector so that the input range and the
termination matches the pattern generator's levels:

– Select an Input Range from -2V to 0V

– Set the Data Termination to -2V

– Set the Alignment BER Threshold to 1E-6.
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– Set the Clock Setup to Clock Data Recovery to get the error
detector's clock from the incoming data stream.

7 Enable the pattern generator outputs by pressing the 0V
(Disable) button.

8 Press Sync Now and then Auto Align to find the optimum sampling
point. Check that the synchronization and the alignment were
successful. None of the error indicators should show red.

The resulting BER should be zero.

How to Execute the Eye Opening Measurement

To run the Eye Opening measurement:

1 Switch to the Analysis panel and then press the Eye Opening icon.

2 Press the Start button to execute the measurement.

The measurement is run and the display is continually updated. The
following illustration shows the eye diagram of the measured bit
error rate and-in the tabular view-the calculated results for the
Time Eye Opening, the Threshold Eye Opening, the Optimal Sample Delay and
the Optimal Sample Threshold.
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How to Optimize the View of the Results

After you have run a measurement, the resulting graph and the
calculated numerical values are displayed. To improve the results,
you can change the measurement parameters:

1 Press the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required
settings:

– Parameters tab

These settings are used while the measurement is running.
Changes require to run the test again. See “Parameters Tab”
on page 225 for details.

– Pass/Fail tab

These settings determine whether the calculated results are
recognized as passed or failed. However, a new test run is not
required when doing changes here. See “Pass/Fail Tab” on
page 226 for details.

– View tab, Graph tab, and Color tab

All settings on these tabs only affect the way the data is
displayed. You do not need to run the measurement again.
See “View Tab” on page 228, “Graph Tab” on page 230, and
“How to Change the Colors of the Graph” on page 159 for
details.

3 Press OK when you have made all required changes to close the
Properties dialog box.

How to Use the Color Bar

The color bar at the right-hand side of the diagram shows the
assignment of BER thresholds to colors. These colors can be
changed. In addition, the color bar provides some useful options for
controlling the display.
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How to Add or Change Colors

If you have a mouse connected to your Serial BERT , you can add
a color to the color bar or change a color:

• From the context menu of the color bar, choose from the
following display options:

Table 25

Option Description

Gradient

Add color... To add an additional color to the
color gradient at the cursor
position. The BER range for this
new color will be assigned
automatically.

Update Plots Dynamically

Rainbow To display a large variety of colors
for the bit error ranges.

5 Advanced Analysis

222 Agilent J-BERT N4903 High-Performance Serial BERT



Table 25

Option Description

Yellow-Blue To display a color gradient from
color1 to color2 for the bit error
ranges.Green-Blue

Red-Green

Black-White

White-Black

How to Change the BER Threshold

The red slider indicates the present BER threshold. To use another
value as threshold:

• Move the slider with the mouse (or your finger, if you are
working directly on the Serial BERT ).

This is particularly useful if you have set the display to show Equal
BER at BER Threshold. By moving the slider, you can investigate the
eye openings at destinct BER thresholds.

N O T E If no slider for the BER threshold is displayed, make sure that you have enabled the
BER Threshold option on the View tab and that a suitable BER is entered.

How to Change the BER Range of a Color

The bit error ranges are set automatically, but you can change these
areas. To do so:

• Move the handles of a color with the mouse (or your finger, if
you are working directly on the Serial BERT ).

This is particularly useful if you have set the display to show the
Pseudo Color Plot.

By default, you may see a graph like the one below:
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Now you may wish to know more precisely what happened between
yellow and red. After extending the range of yellow, such
information becomes available.

Eye Opening - Reference

The Eye Opening measurement returns the results in a graphical
and in a numerical form. The following sections provide
explanations of the measured parameters and the display options
that are specific to this measurement. Additionally, some
information is provided to explain the theoretical background
behind.

Properties that can be specified on the various tabs of the 
Properties dialog box:
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Parameters Tab

N O T E If you modify the parameters on this page, you have to rerun the measurement to
update the results.

Set the criteria for moving to the next sample point:

• Number of Compared Bits

After this number of compared bits, the measurement stops for
the current sample point and moves to the next one.

The default is 1 million bits. That means, you can measure a bit
error rate down to 10 -6  (one error per million).

A smaller number reduces the duration of the whole Eye
Opening measurement. A larger number increases the precision
of the measured bit error rates.

• Number of Errors

After this number of errors, the measurement stops for the
current sample point and moves to the next one. Thisallows you
to speed up the measurement. You can switch off this option if
only the number of compared bits is important.

N O T E The measurement moves to the next sample point when the first of the two criteria
is reached.

Set the criteria for the sample delay:

• Resolution

Specifies the distance between sampling points. The lower this
value, the more sampling points you have in a unit interval. You
can enter the resolution in UI or ps, ns, s, .... The timebase of
the display is set on the View tab.

The default is 0.01 UI, that means, 100 points per unit interval
will be measured.

• Edge Resolution Optimization

Turns the resolution optimization on or off. If this option is
enabled, the Serial BERT  intelligently sets a resolution so that
there are more sampling points at the edges of the eye. This can
greatly improve the results without dramatically increasing the
duration of the test.

Set the criteria for the sample threshold:

• Resolution
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Specifies how many measurement points are taken within the
sample voltage range. Enter the value in mV.

• Low Level

Specifies the lower limit of the measurement voltage range. Enter
the value in mV. This value should be slightly lower than the
lowest expected signal voltage.

• High Level

Specifies the upper limit of the measurement voltage range.
Enter the value in mV. This value should be slightly higher than
the highest expected signal voltage.

Pass/Fail Tab

The Pass/Fail tab of the Properties dialog allows you to specify the
criteria to decide whether the DUT passes or fails the test. You can
change pass/fail criteria without rerunning the test. The software
only uses the criteria to rate the results of a measurement.

N O T E The pass/fail criteria do not control measurement execution. The measurement run
will be completed even if the measurement fails one or more of the criteria.

You can set several pass/fail limits. For an explanation of the Eye
Opening Pass/Fail criteria, see “Measurement Parameters” on page
231.
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In the tabular view, each of the calculated values will be marked
with an

icon if it failed the test.

The following illustration shows an Eye Opening measurement that
has failed the criteria for the eye opening voltage.
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View Tab

The graph shows either a Contour Plot, a Pseudo Color Plot, or only
one curve for the selected bit error rate threshold.

The contour plot shows discrete lines of equal bit error rate-just
like the contour lines on a map. The color of a line indicates the
respective BER value. This graph is useful to visualize in which
areas the BER changes-a homogeneous BER field will give you no
lines at all.

This plot visualizes the BER by a continuous color gradient. This is
useful to get an immediate visual impression of the distribution of
the BER in the eye diagram.
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It shows the contour line at the BER threshold.

Furthermore, the following parameters can be set on the View tab
of the Properties dialog box:

You can analyze for:

• All Errors

To display all errors.

• Errors if 0s Expected

To display the errors if "0" is expected, but "1" received.

• Errors if 1s Expected

To display the errors if "1" is expected, but "0" received.

You can calculate measurement parameters for:

• 0 Errors

To calculate the parameters for 0 errors.

• BER Threshold

To calculate the parameters for the given BER threshold. The
BER threshold influences all parameters of the Eye Opening
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measurement. You can also drag and drop the horizontal BER
threshold in the graphical display to change this value.

You can select the number of Decimal Places to be displayed in the
table.

Graph Tab

On the Graph tab, you can use the several options to optimize the
graphical display according to your needs.

Choose between Unit Interval and Seconds to select the timebase for
the display's x-axis.

To analyze the graphs at a particular point, you can use the
markers. Additionally, you can display all related values for the
markers in the marker readout.

Pressing the Reset Markers button will set the markers back to the
default positions.

Several zoom factors are available. When you show the zoom graph,
you can also allow the zoom graph to track the mouse (or your
finger, if you are working directly on the Serial BERT ).

If you want to see the points that have actually been measured,
choose Show Measured Points. The MUI uses linear interpolation for
the graph.

If you want to display the BER threshold contour line, choose Show
BER Threshold. The BER threshold is set on the View tab or by the
slider in the Color Bar.
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N O T E If no slider for the BER threshold is displayed, make sure that you have enabled the
BER Threshold option on the View tab and that a suitable BER is entered.

Explanation of the Numerical Results

Additionally to the graphical results, the measurement provides
numerical results:

Measurement Parameters

The measurement parameters are defined in the following List:

• Time Eye Opening

This is the maximum extension of the BER threshold contour
line in sample delay direction (eye width).

Note:Thisvalue is different from the horizontal extension of the
BER threshold bounding box.

• Threshold Eye Opening

This is the maximum extension of the BER threshold contour
line in sample voltage direction (eye height).

Note:This value is different from the vertical extension of the
BER threshold bounding box.

• Optimal Sample Delay

This is the sample delay coordinate of the center of a bounding
box around the BER threshold contour line.

• Optimal Sample Threshold

This is the sample voltage coordinate of the center of a bounding
box around the BER threshold contour line.

Unavailable Values

If you make a measurement that results in an incomplete eye (no
closed contour line at the BER threshold), the numerical results
cannot be calculated. In this case, the software will issue a warning
message.

If this happens, you should first of all check the settings of the low
and high decision threshold voltages.
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Understanding the Result Parameters

All result parameters are calculated from the BER threshold contour
line and its bounding box. So, all parameters change with the BER
threshold.

The result display of the Eye Opening measurement shows the
maximum eye opening time, the maximum eye opening voltage, and
the position of the optimum sampling point.

These parameters are derived as illustrated in the figure below:

Error Location Capture

Error Location Capture - Concepts

The Error Location Capture measurement allows to capture the
position of an errored bit in a memory-pased pattern. The
instrument saves the position of the errored bit and writes a bit
sequence neighbouring the errored bit to a file.
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This feature can be used to find rare or random errors. A DUT
could have problems handling long series of zeroes. Error Location
Capture can be used to locate the bit errors in such cases.

N O T E The measurement run is aborted by various actions, like selecting a new pattern or
starting synchronization or alignment.

Example Results

The following figure shows the results of a typical Error Location
Capture measurement:

Important Requirements

In order to perform Error Location Capture measurements, the
following requirements have to be met in addition to the ones listed
in “General Requirements” on page 154:

• Only memory-based patterns with a unique 48-bit pattern
(detect word) are allowed.

• No alignment features can run during error location capture:
Auto Align, 0/1 Threshold Center, Data Center

• No other advanced measurement (Output Timing, Output Levels,
etc.) can be running.
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• Error Location Capture can only run when the BER Location
Mode is set to more than one bit (for example, all bits, or a block
with a length > 1).

Error Location Capture - Procedures

This section shows how to set up and perform an Error Location
Capture measurement. As an example first add a a couple of errors
to an alternating pattern and then capture their position.

This requires the following steps:

• Preparing the measurement (see “How to Prepare the Error
Location Capture Measurement” on page 234)

• Demonstrating the measurement (see “How to Demonstrate the
Error Location Capture Measurement” on page 235)

How to Prepare the Error Location Capture Measurement

To prepare an Error Location Capture measurement to detect the
location of an errored bit in an alternating pattern:

1 Disable the pattern generator outputs by pressing the 0V
(Disable) button in the PG Output Setup screen.

2 Use a shielded cable to connect the pattern generator's Data Out
port and the error detector's Data In port.

3 Use a second shielded cable to connect the pattern generator's
Clock Out port and the error detector's Clock In port.

4 Terminate all non-connected pattern generator output ports with
50 Ω.

5 Make sure to preset the instrument state before running the
measurement: Select Preset Instrument State from the File menu.

6 Enable the pattern generator outputs by pressing the 0V
(Disable) button.

7 Press Sync Now and then Auto Align to find the optimum sampling
point. Check that the synchronization and alignment were
successful. None of the error indicators should show red.

The resulting BER should be zero.
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How to Demonstrate the Error Location Capture Measurement

To demonstrate the Error Location Capture measurement:

1 Switch to the Pattern panel and press the Open button. Load a
Fiber Channel random data pattern from the demo patterns
(Demo > Fiber Channel > RPAT.ptrn).

Press the Properties button and set the Pattern Type to Alternate. To
display both halves of the alternate pattern, press the Alt pat
view button.

Ensure also that the error detector tracks the pattern generator.

2 Insert two errors into pattern B. To do so, edit bits 80 and 100
of pattern B in overwrite mode.

3 Write the modified pattern to the pattern generator and the error
detector by pressing the ToPG&ED button.

4 For the pattern generator setup you need to specify the Alternate
Pattern and Aux In. Set the Internal Alternate Pattern Mode to Single Shot
B and disable Aux In.

5 Set up the error detector so that the Clock Setup is set to Clock
Data Recovery to get the error detector's clock from the incoming
data stream.

6 Switch to the Analysis panel and then press the Error Location
Capture icon.

7 Press the Start button to execute the measurement.

Status information is displayed in the lower section of the
display.

8 Press Insert B button.

The two captured errors are illuminated red in the captured
pattern grid. In the result list, the 1st Bit-Error Location Capture
indicates an error in bit 80. Use the error navigation buttons
(e.g. Next Error, Prev. Error) to display further bit errors in the
captured pattern.
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Error Location Capture - Reference

The Error Location Capture measurement compares the expected
pattern and the pattern that was actually received, and shows the
received pattern with the errored bits marked.

Elements of the User Interface

The following buttons help you to analyze the results:

• Hex / Bin

Choose between a binary or hexadecimal display of the pattern.
The current setting is shown in the status bar below the pattern
window.

Note that in hexadecimal view the captured error can only be
located as being one of a group of four bits. To display which of
the four bits is the errored bit, you have to switch to the binary
display.

• Exp. / Cap.

(Expected/Captured) Toggle the data view between the display
of the expected data, i.e. the data you defined on the error
detector, and the captured data, i.e. the data that was captured
at the error detector. The current state is displayed in the title
bar of the pattern grid.

• Run Select

Toggle the data view between the current run and the previous
run.

After a measurement run is successfully finished, the display is
automatically switched to the current run. The current state is
displayed in the title bar of the pattern grid.

• First Error

Jumps to the first errored bit in the pattern.

• Prev. Error

Jumps to the previous errored bit in the pattern.

• Next Error

Jumps to the next errored bit in the pattern.

• Last Error

Jumps to the last errored bit in the pattern.
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Explanation of the Results

The results are shown in various ways:

The graphic view highlights the located bit errors. The currently
selected bit is highlighted in red, all other errored bits are written
in red.

The status bar below the graphic view provides the following
information:

• Status: The status indicates if the measurement is running or has
ended. If the measurement has ended, it indicates if the
measurement ended successfully or was aborted.

• Position: The position of the current errored bit is shown.

• Hex/Bin: This field indicates how the data is shown (bin or hex
format).

• Length: This field indicates the length of the captured data. Note
that the value here does not equal the length of the pattern.

Compare Pattern File

The captured data is saved as an alternating pattern:

• Pattern A contains the expected data.

• Pattern B contains the errored data:

0s if the expected bits were also received, 1s for errored bits.

To calculate the captured pattern, XOR the bits from pattern A with
the bits from pattern B.

The pattern description contains the first error, the error count,
date and time.

The name of the pattern file is ELOC_RESULT_CURRENT.ptrn for
the current capture and ELOC_RESULT_PREVIOUS.ptrn for the
previous capture. These patterns are saved under C:\ N4903A
\Pattern on the machine with the firmware server.

The results are displayed in the window below the pattern. You can
compare the results of the Current Run with the results of the
Previous Run:

• 1st Bit-Error Location:

Address of the first captured errored bit.

• Bit Error Count:
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Number of all errored bits captured during the measurement.

Fast Eye Mask

Fast Eye Mask - Concepts

The Fast Eye Mask measurement is first of all meant for production
and screening tests. It allows to determine very quickly whether the
eye opening seen at the output signal of a device is within
specifications, that is, within certain timing and voltage limits.

Measuring the eye openings with an oscilloscope used to be a time-
consuming procedure. With the Fast Eye Mask measurement of the
Serial BERT , pass/fail information can be obtained within seconds.

This is achieved by measuring the bit error rate at a limited number
of test points. Up to 32 measurement points can be specified, each
defined by a sampling time relative to the actual sampling point
(which can be the optimum sampling point) and a threshold voltage
(which is adaptive). In practice, six measurement points will often
suffice to approximate the shape of the eye. Six measurement points
are preset by default.

N O T E The Fast Eye Mask can be run by using the appropriate SCPI commands, making it
possible to integrate the Serial BERT into a testing environment. See the
Programming Guide for details.

Example Results

The Fast Eye Mask measurement measures the bit error rate at
certain measurement points. These points have to be positioned
inside the expected eye opening.
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The results of a Fast Eye Mask measurement are displayed in
numerical form:

The rows Relative Time and Voltage define the positions of the
measurement points. The last row shows the measured bit error
rates at these points.

• The Relative Time of the measured points refers to the actual
sampling point. If synchronization and auto-alignment were
successful, the current sampling point is the optimum sampling
point.

Instead of UI (one Unit Interval is equal to one system clock
period), the relative time can also be specified in seconds.

• The Voltage is the decision threshold voltage at this measurement
point. The voltages of the measurement points can be set as
absolute voltages, as offset voltages, or as percentages. This is
done on the Parameters page of the Properties dialog.

By default, the six measurement points are symmetrically placed, as
illustrated in the figure below:
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These settings can be changed, and up to 32 measurement points
can be defined.

N O T E Critical areas at the error detector are generally close to ±0.5 UI.

Fast Eye Mask - Procedures

This section shows how to set up and perform a Fast Eye Mask
measurement. As an example we measure the eye of a shielded
cable.

This requires the following steps:

• “How to Prepare the Fast Eye Mask Measurement” on page
240

• “How to Execute the Fast Eye Mask Measurement” on page
241

• “How to Optimize the View of the Results” on page 242

How to Prepare the Fast Eye Mask Measurement

To prepare a Fast Eye Mask measurement to test a shielded cable:

1 Disable the pattern generator outputs by pressing the 0V
(Disable) button in the PG Output Setup screen.
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2 Use a shielded cable to connect the pattern generator's Data Out
port and the error detector's Data In port.

3 Terminate all non-connected pattern generator output ports with
50 Ω.

4 Use a shielded cable to connect the pattern generator's Data Out
port and the error detector's Data In port.

5 Switch to the Pattern panel and press Pattern Select. Select an
appropriate pattern, for example a pure 2^15-1 PRBS, for both
the pattern generator and the error detector.

6 For the pattern generator setup, you need to specify the logic
levels and the bit rate. Select ECL levels and a clock speed of
1250 M Hz in this example. This corresponds to a clock period
of 800ps. See “Setting up the Pattern Generator - Concepts ” on
page 69 for more information.

7 Set up the error detector so that the input range and the
termination matches the pattern generator's levels:

– Select an Input Range from -2V to 0V

– Set the Data Termination to -2V

– Set the Alignment BER Threshold to 1E-6.

– Set the Clock Setup to Clock Data Recovery to get the error
detector's clock from the incoming data stream.

8 Enable the pattern generator outputs by pressing the 0V
(Disable) button.

9 Press Sync Now and then Auto Align to find the optimum sampling
point. Check that the synchronization and the alignment were
successful. None of the error indicators should show red.

The resulting bit error rate should be zero.

How to Execute the Fast Eye Mask Measurement

To run the Fast Eye Mask measurement:

1 Switch to the Analysis panel and then press the Fast Eye
Measurement icon.

2 Press the Start button to execute the measurement.

The measurement is run and the result window shows the bit error
rates measured at six measurement points.
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The Relative Time refers to the current sampling point.

The Voltages are the decision threshold voltages for measuring the
bit error rate at this measurement point. The voltages of the
measurement points can be set as absolute voltages, as offset
voltages, or as percentages.

How to Optimize the View of the Results

After you have run a measurement, the resulting numerical values
are displayed. To improve the results, you can change the
measurement parameters:

1 Press the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required
settings:

– Parameters tab

These settings are used for data collection. Changes require
to run the test again. See “Parameters Tab” on page 243 for
details.

– Pass/Fail tab

These settings determine whether the calculated results are
recognized as passed or failed. However, a new test run is not
required when changes are made here. See “Pass/Fail Tab” on
page 244 for details.

– View tab

All settings on this tab only affect the way the data is
displayed. You do not need to run the measurement again.
See “View Tab” on page 245 for details.

3 Press OK when you have made all required changes to close the
Properties dialog box.

Fast Eye Mask - Reference

The Fast Eye Mask measurement returns the results in a numerical
form. The following sections provide explanations of the measured
parameters and the display options that are specific to this
measurement.

Properties that can be specified on the various tabs of the 
Properties dialog box:
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Parameters Tab

Note that if you modify the parameters on this page, you have to
rerun the measurement to update the results.

Set the criteria for moving to the next sample point:

• Number of Compared Bits

After this number of compared bits, the measurement stops for
the current sample point and moves to the next one.

The default is 1 million bits. That means, you can measure a bit
error rate down to 10 -6  (one error per million).

A smaller number reduces the duration of the whole Fast Eye
Mask measurement. A larger number increases the precision of
the measured bit error rates.

• Number of Errors

After this number of errors, the measurement stops for the
current sample point and moves to the next one. Thisallows you
to speed up the measurement. You can switch off this option if
only the number of compared bits is important.

N O T E The measurement moves to the next sample point when the first of the two criteria
is reached.

Set the criteria how the sampling points of the eye are displayed:

• Timing Unit

Choose between Unit Interval and Seconds to set the timing values
for the measurement points on the Parameters tab. This setting
does not affect the display of results.

• Threshold Type

Choose between Absolute, Offset,or Percentage to set the thresholds
for the measurement points:

– Absolute

You specify the thresholds for the measurement points as
absolute voltages.

– Offset

You specify the thresholds for the measurement points
relative to the threshold voltage of the actual sampling point.

– Percentage
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You specify the thresholds for the measurement points as a
percentage of the current eye opening voltage of the error
detector.

Depending on the quality and characteristics of the eye
opening, the resulting 50% threshold may deviate from the
decision threshold defined in the loaded setting.

• Number of Valid Points

Change the Number of Valid Points, if you wish to use less or more
measurement points for the measurement.

• Relative Time and Voltage

In the table at the bottom of the Parameters tab you can change
measurement points. Enter the Relative Time and Voltageaccording
to the above settings.

Pass/Fail Tab

The Pass/Fail tab of the Properties dialog box allows you to specify
the criteria to decide whether the DUT passes or fails the test. You
can change pass/fail criteria without rerunning a test. The software
only uses the criteria to rate the results of a measurement.

N O T E The pass/fail criteria do not control measurement execution. The measurement run
will be completed even if the measurement fails one or more of the criteria.
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The Fast Eye Mask measurement has only one pass/fail condition:
The bit error rate. If desired, enable the BER Threshold and set a
suitable threshold.

N O T E The BER Threshold will usually be 0, since you want the measurement to fail if a
single bit was received in error.

The pass/fail threshold applies to all measurement points. An

icon indicates all measurements where the bit error rate is higher
than this threshold, as shown in the figure below:

View Tab

The following parameters can be set on the View tab of the
Properties dialog box:

You can analyze for:

• All Errors

To display all errors.

• Errors if 0s Expected

To display the errors if "0" is expected, but "1" received.

• Errors if 1s Expected

To display the errors if "1" is expected, but "0" received.

You can set the Timing Unitfor the display of the relative time of the
measurement points on the Parameters tab. Choose between Unit
Interval and Seconds to select the unit.

Advanced Analysis 5

Agilent J-BERT N4903 High-Performance Serial BERT 245

Analyze

Grid



You can select the number of Decimal Places to be displayed in the
table.

Eye Diagram

Eye Diagram - Concepts

The Serial BERT  provides quick design analysis with the Eye
Diagram capability. The Eye Diagram allows a quick check for the
DUT’s signal output, and determines the signal quality. Due to the
higher sampling depth of a BERT value, the eye contour lines
display the measured eye at a deeper BER level, for accurate
results.

The Eye Diagram feature provides the following measurement
capabilities:

• Eye Diagram Waveform

• BER Contour Lines

• Automatic Measurement for the most relevant eye parameters:-

– Eye Height

– Eye Width

– Jitter P-P

– Jitter RMS

– Cross Voltage

• Markers

• Eye Mask

The Eye Diagram generates a three dimensional graph of the bit
error rate (BER). This measurement helps in determining and
analyzing the quality of the DUT’s signal output. The Eye Diagram
results comprise of voltage(y), time(x), and BER(z).

The Eye Diagram, and the table of Automated Eye Parameter
Measurement form simultaneously. They become more precise with
the increasing number of measured bits.
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The following graph shows how the Eye Diagram has been
integrated on the J-BERT N4903A High-Performance Serial BERT.

Methods of Representations

There are two methods of representing the eye diagram:

• Waveform

• Contour

Waveform

Waveform is the shape, and form of a signal. The waveform graph
shows the periodical variation of voltage against time.

The waveform in the Serial BERT  is similar to the one in the
oscilloscope. In this case, the waveform initially gives a coarse, but
quick picture of the signal quality; while the ‘smooth waveform’
quickly generates a high resolution graph. The waveform is
displayed in an incremental way, showing the coarse picture
quickly, and then refining it further.
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The BER Threshold is configurable. The BER Threshold is the level
up to which the signal is represented as waveform, and BER values
below this threshold are represented as contours.

BER Contour

Contour is a curve connecting points where the BER has a same
particular value. The contour graph is plotted within the Eye
Diagram, and it helps to determine the Eye Opening at deep bit
error rates, such as 1e-10, 1e-12, and so forth. Depending upon the
user’s requirement the deep BERs can be calculated. The
extrapolated eye contour lines display the eye opening for lower
BER levels, such as 1e-15. The BER is displayed as a function of
sampling delay, and sampling threshold.

The eye opening is one of the main characteristics of a high speed
device.

The legend on the right side of the screen represents the contour
BER values in different colors. When you select a BER value from

5 Advanced Analysis

248 Agilent J-BERT N4903 High-Performance Serial BERT



the legend, it displays the contour for the selected BER in the same
color. Initially all the BER values on the legend are struck across.
When the contour is measured, the BER value changes into normal
font; and when the contour is extrapolated the BER value changes
into italics. A BER value for which a Contour does not exist is
struck across. You can select multiple BER values. The lower BER
values are in red and pink, while the deep BER values are in green
and blue. The screen shot below displays teh contour and the
legend.

The outer contour represents the measured BER contour, while the
inner lines are extrapolated. For more details on extrapolation
see“Estimated Total Jitter” on page 172

The Minimum Number of Errors indicates the minimum number of
hits required to plot the contour.

Eye Mask Measurement

Masks are marked regions on the screen. When the mask region and
waveform intersect it is called a violation. The Mask test shows the
quality of the eye.

When the mask measurement begins, the instrument either aligns
the mask as per the eye levels of the waveform, or as per the
absolute voltages specified in the mask file. The position of the
mask can be changed by scaling the mask according to the eye.
Once the masks are positioned the mask test counts the number of
times a particular pixel falling in the mask region has been
measured. The mask violations are marked in green. A consolidated
report of the test is available on the left bottom of the graph. The
user can turn off the mask computation by pressing the “stop”
button.
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N O T E The mask test is enabled when "centre to" is set to "middle of eye", and
"persistence" is set to "infinite" in the Parameter Tab.

Automated Eye Parameter Measurement

Automated Eye Parameter Measurement characterizes an Eye
Diagram by measuring the rise time, the fall time, the eye
amplitude, and so forth. These measurements are called,Automated
Eye Parameter Measurement, they display the Eye behavior, and
they depend on the parameters set in the View Tab.

These results are displayed in a tabular form as shown below:

In case you want to see a specific set of Eye Measurements you can
select it on the Eye Measurements tab.
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N O T E The scroll bar at the bottom of the table shows the entire table and its contents.

For more details refer to “Eye Diagram - Reference” on page 264

Eye Diagram - Procedures

This section lists out some of the generic processes to set up
measurements, to run them, and to create Eye Diagrams.

In this section, you will learn about:

• “How to Prepare the Eye Diagram Measurement?” on page 251

• “How to Initiate an Eye Diagram Measurement?” on page 252

• “How to Change the Default Settings of an Eye Diagram?” on
page 253

• “How to Set Markers?” on page 257

• “How to Set Markers?” on page 257

• “How to Set Markers?” on page 257

• “How to Enter Notes?” on page 261

• “How to Save and Recall” on page 262

• “How to Export Fetched Data?” on page 262

How to Prepare the Eye Diagram Measurement?

An example to prepare an Eye Diagram measurement:

1 Click 0V (Disable) on the PG Output Setup screen, to disable the
pattern generator outputs.

2 Connect the DUT to the pattern generator’s Data Out port and the
error detector’s Data In port. Refer to the Getting Started Guide.

3 Terminate all non-connected pattern generator output ports with
50 Ohm.

4 Switch to the Pattern panel and click Pattern Select.

5 Select an appropriate pattern, for example a pure 2^15–1 PRBS,
for both the pattern generator and the error detector.

6 Specify the logic levels and the bit rate for the pattern generator
setup. For example, select ECL levels and a clock speed of 1250
MHz. This corresponds to a clock period of 0.8 ns.
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7 Set up the error detector to match the input range and the
termination with the pattern generator’s levels:

– Select an Input Range from –2 V to 0 V

– Set the Data Termination to –2 V

– Set the Alignment BER Threshold to 1E–6

– Set the Clock Setup to Clock Data Recovery to get the error
detector’s clock from the incoming data stream.

8 Enable Output

How to Initiate an Eye Diagram Measurement?

To run the eye diagram measurement:

1 Click the Analysis tab on the left panel.

2 Click the Eye Diagram icon.

3 Click the Start button to execute the measurement.

The measurement runs, and the eye diagram along with the
Automated Eye Parameter Measurement get updated constantly.

The following graph shows the eye diagram.

4 To stop the measurement click on Abort.
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How to Change the Default Settings of an Eye Diagram?

To achieve desired results, you can change the measurement
parameters:

1 Click the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required
settings:

– Parameters tab

The Parameter settings used for the measurement can be
changed only when the measurement is not running, and if
the settings are changed, then you will have to re-run the
measurement. (Refer to “Parameters” on page 264 for the
detailed options).
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– View tab

The view tab options set the parameters to measure, and
choose units for the displayed results in the numerical table.
(Refer to “View” on page 265 for the detailed options)
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– Graph tab

The graph settings give the display parameters like timing
units, waveform, contour, grid and markers.
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– Eye Measurementstab

The Eye Measurements tab lists out all the measurements. The
user can select specific results.
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How to Set Markers?

Markers help in tracking the BER at specific points, so to set the
markers:

1 Click on the Graph tab

2 Select Show Maker Lines

3 Apply Setting

This enables the markers, and a marker readout button appears
on the top left corner. You also have an option to Reset Markers
to their original position.
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The Marker reading is shown on the left side of the graph.

4 Click the marker readout button on the top left corner to see the
detailed marker readout.

How to Run the Mask Measurement?

To run the Mask Measurement, the Eye Diagram measurement must
be running.

1 Click on the Mask tab

2 Click Load button

3 Select a Mask File.

4 Select a Mask Alignment.
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5 Start

This starts the Mask Measurement.You also have options for
setting Mask Margins, and Mask Scaling.

6 Click the mask readout button on the bottom left of the screen to
either see, or close the detailed mask readout.

How to Customize Mask Files

A Mask file can be modified as per requirements. Following are the
sections in a mask file:

Mask File Identifier

The mask file identifier is the first line in a mask file. If the
identifier string is missing or incorrect, the file will not be loaded
and an error dialog box will be displayed.

MASK_FILE_N49xxx

Mask Title

The mask title is a quoted string of up to 15 characters. The title
is displayed on the mask readout when the file is loaded.

Example to Mask Title:

"2xGB Ethernetaa"

Region Number

The region number is an integer that defines a mask violation area
(or polygon).
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You can specify 1 to a maximum of 3 regions in a mask file.

Example to Region Number:

/* Region Number */ 2

Region Type

You can define three types of regions for each region number you
have specified:

• STD defines the actual mask region.

• MARGIN_MAX defines the maximum margin area when test
margins are set to 100%.

• MARGIN_MIN defines the minimum margin area when test
margins are set to -100%.

Example to Region Type:

/* Region Type */ STD

/* Region Type */ MARGIN_MAX

or

/* Region Type */ MARGIN_MIN

Number of Vertices

The number of vertices is an integer that specifies the quantity of
X and Y coordinates needed to define a mask region or polygon.

Example to Number of Vertices:

/* Number of vertices */ 4

X and Y Coordinates

These are the floating-point numbers that define the locations of
the mask polygon vertices for each region and region type defined
in the mask file. Mask Files use a relative coordinate system based
on an eye diagram’s zero level, one level, and crossing point
parameters.

Example to X and Y Coordinates:

+0.0, +1.0

Mask Setup

You can list various remote commands in the mask setup area to
define the relative vertical and horizontal positions of the 0 and 1
coordinates of the mask X and Y-axes. Commands listed in the
setup area are executed as part of the mask data load process.

Example to Mask Setup:

:MTES:SCAL:YTRACK OFF
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:MTES:SCAL:Y1 -0.65

:MTES:SCAL:Y2 +0.65

:MTES:SCAL:XDEL 312.5E-12

:MTES:AMET NRZEYE

:MTES:INP:MODE DIFF

In the above example, the Y1 and Y2 values define the mask with
an absolute voltage value. In some mask files, Y1 and Y2 values are
not specified, and so the voltage value is relative to either Vtop and
Vbase, or to the eye boundaries specified by the user in the GUI.

A mask can be set in two modes, either differential, or single. The
above example, ":MTES:INP:MODE DIFF", sets the mode of the mask
file to differential. The mask mode, when defined, should match the
mode set in 'ED Input Setup Dialog'. In case it doesn't match, an
error message will indicate this mismatch.

How to Enter Notes?

There is a tab on the top left corner of the graph for entering notes.

To enter notes:

1 Click on the Note Tab.

2 Enter your notes in the drop down text box. This gives the
timestamps of the comments entered. It’s a scrollable editor
where your latest comments are entered at the end.
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How to Save and Recall

To Save the following measurements:

• Eye Diagram

• Property Page

• Legend States

• Left Panel Values

• Automated Eye Parameter Measurement

1 Click on the Analysis Menu

2 Click on ‘Save Measurement’

To Recall the measurements:

1 Click on the Analysis Menu

2 Click on ‘Load Measurement’

How to Export Fetched Data?

You can export various counters to an exported file location.

1 Click on Analysis Menu
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2 Click on ‘Export Data’

When you click on ‘Export Data’ the following screen appears:

The Clipboard option saves the data on a clipboard.

The ‘Format Options’ takes you to the following screen.

You can select the ‘Format’, ‘Save to File’ and ‘Error Options’ as
per requirements.
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The ‘Save to File’ option specifies, either saving only the BER
values, or saving the BER, the Compared Bits, and the Errors.

The ‘Error’ option gives the user the choice of saving, the BER, the
Compared Bits, and the Errors, for different combinations of
expected 1s, 0s, and all.

Eye Diagram - Reference

The Eye Diagram measurement returns the results in graphical and
numerical forms. The following section explains the measured
parameters, and the displayed options that are specific to these
measurements. Additionally, some information is provided to
explain the theoretical background to these measurements.

Parameters that can be set on the various tabs of the Properties
pop-up:

Parameters

N O T E If the parameters on this page are modified, run the measurement again to update
the results. While the measurement is running the parameter settings cannot be
changed.

Set the criteria for Persistence.

• Infinite

With ‘Infinite’, the eye appears with the Automated Eye Parameter
Measurement, and the results keep on improving in accuracy, as
more number of points get measured and represented on the
diagram along with the deeper BER values. The BER threshold in
the Graph Tab decides how long the measurements will be done at
the boundaries of the eye. Once the measured points exceed the
BER Threshold defined by the user, the measurement is done deep
inside the eye.

This is a default setup for persistence.

• Minimum

With ‘minimum’, a reasonably clear eye, with transition, appears
along with all the Automated Eye Parameter Measurement, and
automatically the measurement restarts showing only the refined
eye diagram. To stop the measurements click the abort button.

• Secs
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With ‘Secs’, the measurement runs for the specified time, and
automatically the measurement restarts showing only the refined
eye diagram. To stop the measurement, click the abort button.

Sets the transition of the eye on the plot

• Middle of eye

With ‘middle of eye’, the center of the eye coincides with the center
of the screen.

• Transition

With ‘transition’, the transition of the eye coincides with the center
of the screen.

Set the criteria for the number of eyes.

• 1.5ui

This option displays ‘1.5’ eyes on the graph. The transitions of the
complete eye are placed such, that, they show ‘0.25’ eyes on both
sides. So, the total number of displayed eyes is 1.5.

• 2ui

This option displays ‘2.0’ eyes on the graph. The transitions of the
complete eye are placed such, that, they show ‘0.5’ eyes on both
sides. So, the total number of displayed eyes is 2.0.

View

Set the criteria for calculating the eye width, eye height, JPP, JRMS,
cross voltage according to the BER threshold selected.

• 0 Errors

To see ‘0 errors’ select the option. This gives the results according
to the last measured contour for the current measurement. This is
more significant in the case of deep BERs.

• BER Threshold

Enter the BER threshold at which the five results,eye width, eye
height, JPP, JRMS, and cross voltage, will be calculated.

The show checkbox displays the contour at which the results are
calculated.

Set criteria for transition time

• 10/90
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Measures horizontal scan from 10% to 90% of the signal amplitude.

• 20/80

Measures horizontal scan from 20% to 80% of the signal amplitude.

Set the criteria for eye boundaries. Total is 100% of the display
screen. These are applied for the level related parameters, for
example, 0-level, 1-level, Signal to Noise ratio, Eye Amplitude, and
so forth.

• Left Boundary

Marks the lower edge of the eye window boundary

• Right Boundary

Marks the higher edge of the eye window boundary

Set the criteria for eye width and eye height.

• Eye width at crossing point

This parameter gives the eye width at the crossover. Total is 100%
of the display screen.

• Eye width custom

This parameter gives the eye width at a specific percent of the eye
amplitude. (Starting from low level to high level).

• Eye height

This parameter gives the eye height at a specific percent of 1ui.
(Starting from left to right).

Set the criteria for the decimal placing in the return values.

• Decimal Places

This parameter sets the decimal placing for the Automated Eye
Parameter Measurement.

Set the criteria for the optical parameters. These are used to
convert level values to optical power values.

"power value" = ("level value" - "dark level") * "conversion gain"

• Dark Level

Internally generated offset signals.

• Conversion Gain

Is used to convert voltage level into power.
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• dBm

Output will be displayed in dBm.

power value[dBm]=10*log(power value[W]/1mW)

• W

Output will be displayed in Watt

Set the criteria for the Extinction Ratio Unit

• Ratio

Ratio of two optical power levels, low level and high level

• dB

Unit for measuring the extinction ratio.

ratio[dB]=10*log(ratio)

• %

Extinction Ratio in percentage

Graph

Set the criteria for the Timing Units:

• Unit Interval

Unit used to measure delay relative to the eye width.

• Seconds

Unit used to measure eye width in absolute terms of time.

Set the criteria for the waveform:

• Show Waveform

This option shows the waveform graphic.

• Smooth Waveform Graphic

The smooth waveform gives a finer waveform output. It
logarithmically interpolates between the measured points to give a
finer waveform.

• BER Threshold

The BER Threshold value allows the user to measure around the
eye boundaries first, and then, deeper inside the Eye for BERs
beyond the specified threshold.
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Set the criteria for the Contour:

• Show Contour line

This option plots the contour.

• Show Legend

This shows the list of BER values.

• Show Grid

The 353pxl X 289pxl screen is divided into a 10 X 8 grid. This
parameter adds a grid to the screen.

Set criteria for the markers:

• Show Marker Lines

This option enables the markers on the screen.

• Reset marker

This brings the marker back to its default position.

Mask

• Load Mask File

With Load, a mask file is loaded. Once the file is successfully loaded
the Start button gets activated.

Set Mask Alignment:

• Display

The Display mode aligns the mask using the Vtop and Vbase values
of the displayed waveform. All the threshold coordinates of the
mask will be relative to this voltage. This is the default mode for
mask alignment.

• Eye Boundaries

The Eye Boundary mode aligns the mask using the 1 level and 0
level of the waveform. The 1 level and the 0 level are calculated
between the Eye Boundary 1, and Eye Boundary 2.

Set Mask Margins:
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• Margins on

Mask Margins, allows the user to enlarge or shrink a mask in order
to see the margin size, and how much of it is violated. The
maximum and minimum margins are defined within the mask files.

Set Mask Scaling

With mask scaling the mask can be manually enlarged, shrunk, and
moved around. With the logic levels track selected, the mask regions
are bound together, and move together with a fixed amplitude.
Position (pos) gives the timing displacement, and dT gives the delta
time offset.

Set Mask Run Control:

The Mask Run Control aligns the mask, switches it on, starts
displaying the number of waveforms, and the number of mask
violations per mask region, and the worst BER per Mask region.

Exit stops the computation, hides the mask, and the violations.

Automated Eye Parameter Measurement

Table 26

S.No Parameter Description

1 Rise time Measures the mean
transition-time taken by
the data on the rising edge
of the eye diagram. The
data crosses three
thresholds: lower,
crossover point, upper and
the eye transition.
Note: Rise time is
dependent on the
Transition Time of the
View Tab. The two options
are 10/90 and 20/80.
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Table 26

S.No Parameter Description

2 Fall time Measures the mean
transition-time taken by
the data on the falling edge
of the eye diagram. The
data crosses three
thresholds: lower,
crossover point, upper and
the eye transition.
Note: Fall time is
dependent on the
Transition Time of the
View Tab. The two options
are 10/90 and 20/80.

3 Sample Count The number of points
measured for the eye
diagram. If persistence,
‘infinite’, is enabled, the
value will gradually
increase.

4 0-Level Zero level is the
measurement of the mean
value of the logical 0 of an
eye diagram.
Note: This measurement is
made in a section of the
eye referred to, as the eye
window boundaries. The
default value for the NRZ
eye window is the central
20% of the bit period. You
can change the eye
window boundary settings
in the Configure
Measurement dialog box.
These settings determine
what portion of the eye will
be measured.
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Table 26

S.No Parameter Description

5 1-level One Level is a measure of
the mean value of the
logical 1 of an eye diagram.
Note: This measurement is
made in a section of the
eye referred to, as the eye
window boundaries. The
default value for the NRZ
eye window is the central
20% of the bit period. You
can change the eye
window boundary settings
in the Configure
Measurement dialog box.
These settings determine
what portion of the eye will
be measured.

6 Eye Amplitude The difference between
the logic 1 level and the
logic 0 level.

7 Eye Width The horizontal
measurement of the eye
opening at a specified BER
Threshold.
Note: The Eye Width is
calculated according to
the BER Threshold set in
the View Tab. Eye Width is
calculated as per the
selection of either Width
at Crossing Point or
Custom defined Width.
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Table 26

S.No Parameter Description

8 Eye Height Measures the vertical
opening of an eye diagram
with respect to BER
threshold. This determines
“eye closure” due to noise.
Note: The Eye Height is
calculated according to
the BER Threshold set in
the View Tab. Eye Height is
calculated with 'Height at'
in the View tab.

9 Jitter P-P Full width of the histogram
at the eye crossing point
with respect to BER
threshold.
Note: The Jitter P-P is
calculated according to
the BER Threshold set in
the BERT from Calculate
Measurement Parameters
of the View Tab.

10 Jitter RMS A standard deviation of the
crossing point histogram
with respect to BER
threshold.
Note: The Jitter RMS is
calculated according to
the BER Threshold set in
the BERT from Calculate
Measurement Parameters
of the View Tab.
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Table 26

S.No Parameter Description

11 Cross Voltage Crossing percentage is a
measure of the amplitude
of the crossing points
relative to the 1 level and 0
level.
Note: The Cross Voltage is
calculated according to
the BER Threshold set in
the BERT from Calculate
Measurement Parameters
of the View Tab.

12 Signal to Noise Ratio In signal-to-noise, the
"signal" is the information
power of the signal
indicated by the difference
between the ‘1’, and ‘0’
level. The "noise" is the
combined standard
deviations of the ‘1’ level
spread, and the ‘0’ level
spread.

13 Extiction Ratio Extinction ratio is the ratio
of the 1 level power and the
0 level power of an eye
diagram.
Note: The Extinction Ratio
is calculated using the
Dark Level and Conversion
Gain of the View Tab.

14 OMA The Optical Modulation
Amplitude (OMA) is the
difference between the 1-
level power and 0-level
power.
Note: The OMA is
calculated using the Dark
Level and Conversion Gain
of the View Tab.
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Table 26

S.No Parameter Description

15 Duty Cycle Distortion
(DCD)

This value is the difference
between the period of a 1
bit and a 0 bit.

16 Average Power The mean of level 0 power
and the level 1 power.
Note: The Average Power
is calculated using the
Dark Level and Conversion
Gain of the View Tab.

Eye Diagram Screen

This graph gives the picture of the Eye Diagram Screen.
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Spectral Jitter

Spectral Jitter - Concepts

The Spectral Jitter measurement allows you to analyze the jitter
inherent in the output signals of your device under test (DUT) as a
function of the frequency. This measurement can be used for
investigating the behavior of the DUT, for example to identify
crosstalk effects.

Spectral Jitter Analysis

The Spectral Jitter measurement provides a method for investigating
the spectrum of the jitter, that means, its power distribution over
frequency.

Deterministic jitter can be caused by repetitive data patterns. It can
also be caused by internal or external periodic effects.

The Spectral Jitter measurement detects even small periodic
components that may be hidden in a high level of random noise. It
informs you about the frequencies of such components and
measures their contribution to the total jitter.

This helps to identify jitter sources and to reduce or eliminate their
influence.

Prerequisites for Using the Spectral Jitter Measurement

It is important that the initial sampling point is in optimum position
(which means, in the middle of the eye opening), because the
Spectral Jitter measurement derives its starting sampling point from
that point.

See also “General Requirements” on page 154.

How the Spectral Jitter Measurement Works

The Spectral Jitter measurement performs a capture and compare
operation in the jitter region. The number of compared and
captured bits is adjustable.

Advanced Analysis 5

Agilent J-BERT N4903 High-Performance Serial BERT 275



By default, the analyzer sampling point is set to an offset of -0.5
analyzer clock periods or unit intervals (UI) from the optimum
sampling delay.

Capture and compare means that a certain amount of incoming data
is captured and also compared with expected data in real time. The
number of captured data points is adjustable.

While the measurement is running, correct and incorrect data is
captured. The resulting records contain the captured data and the
corresponding error information.

These records are automatically processed. The error information is
subject to a fast Fourier transform (FFT). FFT reveals the spectral
components and their power. Several window algorithms are
provided to reduce the influence of leakage.

Jitter Distribution Over Time

Jitter has a more or less characteristic distribution over time.

The histogram of pure random jitter shows its Gaussian
distribution, as illustrated in the following figure:
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Deterministic jitter periodically adds and subtracts a delay to/from
the received signal.

Jitter caused by a square wave or on/off signal has produced the
following histogram:

Jitter caused by a triangle signal shows an even distribution:

Last, but not least, the histogram of jitter modulated by a sinusoid
exhibits two significant peaks:
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The jitter histogram of a real world signal shows most often a
mixture of these characteristic distributions.

Measurement Results

The Spectral Jitter measurement provides:

• A graphical view of power vs. frequency. This makes it easy to
identify prominent spectral jitter components. You can adjust the
horizontal and vertical axes according to your needs.

• You can switch between linear and logarithmic scales.

• Graphical markers and the zoom function assist you when you
are analyzing the graph visually.

• The numerical results include bit error rate, total power, and
noise power. They provide also frequency and power information
about the dominant peaks in the spectrum.

• Absolute and relative power values are available. Relative values
can be normalized to the total jitter power or the power of a
selected tone (frequency bin).

• Pass/fail limits can be set for the bit error rate, total power and
noise power, and the allowed jitter power in user-defined
frequency regions.
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Periodic Jitter and Bit Error Information

When the incoming signal is sampled at the transition point,
periodic jitter manifests itself in the bit error record. An example
may be helpful to understand the phenomenon.

Let us assume we expect and correctly receive a simple 0, 1, 0, 1,
0, ... pulse signal. If we would sample this signal one clock period
earlier (-1 UI), we would see a bit error rate (BER) of 1.0. This is
the maximum BER for this pattern.

Let us also assume, this signal is overlaid by a periodic jitter source
with sinusoidal characteristics.

Now we sample the incoming signal at the transition point (-0.5 UI
from the optimum sampling point).

The result is illustrated in the figure below.

1

0

0 1 0 1 0 1 0 1 0 1 0 1 0 1 0 1 0 1

1

0

1 0 1 0 1 0 1 0 1 1 0 1 0 1 0 1 0 1

increasing right shift decreasing right shift increasing left shift decreasing left shift

Signal without jitter

Expected and correctly
sampled data

Periodical,
sinusoid jitter

Signal with jitter

Captured data

Error data 1 1 1 1 1 1 1 1 1 0 0 0 0 0 0 0 0 0

0 1 0 1 0 1 0 1 0 1 0 1 0 1 0 1 0 1Expected data

The jitter source moves the received signal to the right and to the
left, but the sampling point is fixed (dotted lines show the
undisturbed signal). Because we are sampling at the transition
point, we get errors when the signal is shifted to the right and no
errors when the signal is shifted to the left.

The error signal shows a very characteristic and reproducible
pattern. The resulting BER for this kind of signal is 0.5. Other jitter
frequencies yield different but also characteristic error patterns and
also a BER which is half the maximum BER.

The maximum BER and hence the actual BER are pattern-
dependent.
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Considering the BER bathtub curve, the sampling point is in the
middle of the descending line.

If random data is used, the average bit error rate at the left-hand
side of the jitter region is 0.5.

The bit error rate at the right-hand side of the jitter region is 0.
We therefore expect a bit error rate around 0.25.

N O T E The Spectral Jitter measurement should only be used in conjunction with data that
has an equal distribution of ones and zeros over time. Otherwise, the results are
hard to predict and may be not reproducible.

Signal Processing

If the error signal is obtained as explained above, an analysis in the
frequency domain reveals the absense or presence of deterministic
jitter. Dominant frequency components become visible and their
contribution to the total jitter can be measured.

The modified error signal is subject to a fast Fourier transformation
(FFT).

FFT requires that the data record to be processed has a length that
is a power of two (2 n, such as 2 17, 2 18, 2 19, 2 20, and so on).

From that data record, the FFT calculates pairs of frequency/power
values. The number of pairs is half the number of samples. If you
have chosen a record length of 2 17 (which means 131,072 bits or
128 Kbit), the result contains 65,536 pairs. The maximum frequency
is half the data rate used for the test.

The results are displayed in the Spectral Jitter measurement
graphical and numerical result window.
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About FFT

For general information about the Fourier transformation and the
special characteristics of the fast Fourier transform, please refer to
the standard literature. For details, see the following documents:

• Frederic J. Harris, "On the use of Windows in Harmonic Analysis
with the Discrete Fourier Transform", Proceedings of the IEEE,
Vol.66, January 1978

• "The Fundamentals of Signal Analysis", Agilent Application Note
243, Publ. No. 5952-8898E

• "Fibre Channel - Methodologies for Jitter Specifications",
National Committee for Information Technology Standardization
(NCITS), T11.2/Project 1230/Rev. 10, June 1999

• Yi Cai, Bernd Laquai, Kent Luchman, "Jitter Testing for Gigabit
Serial Communication Transceivers", IEEE Design and Test of
Computers, Jan-Feb 2002

The error record contains a bipolar, rectangular signal. If such a
signal is periodic, you can expect a spectrum as illustrated below.

The fundamental frequency and its harmonics appear.

Such spectra have been measured with the Spectral Jitter
measurement.

A logarithmic power scale shows the details:

Advanced Analysis 5

Agilent J-BERT N4903 High-Performance Serial BERT 281

FFT results



When the repetition period of the characteristic pattern in the error
record increases, you will also find the typical sine-x-over-x decay
of the spectral power.

FFT assumes that the time record contains a representative section
of an endless periodic signal. It assumes that time records can be
seamlessly concatenated. If this is not the case, a phenomenon
called leakage occurs.

Leakage makes it impossible to detect minor adjacent spectral
components. The following two figures refer to a slightly disturbed
sine wave.
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When you perform a Spectral Jitter measurement, it is likely that
some degree of leakage occurs. The measurement therefore provides
a choice of FFT windows that allow you to detect leakage and to
reduce its impact.

An FFT window is a filter that sets the beginning and end of the
time record smoothly to zero. Such records can be seamlessly
concatenated.

When you are using a window, please note:

• No window removes leakage completely.

• Every window reduces the spectral power.

• Results obtained from different devices can only be compared if
the same window is used.

Spectral Jitter - Procedures

This section shows how to set up and use the Spectral Jitter
measurement. As an example, we measure the spectral jitter
behavior of a shielded cable.

This requires the following steps:

• “How to Prepare the Spectral Jitter Measurement” on page 284

• “How to Execute the Spectral Jitter Measurement” on page 284
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How to Prepare the Spectral Jitter Measurement

To use the Spectral Jitter measurement to test a shielded cable:

1 Disable the pattern generator outputs by pressing the 0V
(Disable) button in the PG Output Setup screen.

2 Use a shielded cable to connect the pattern generator's Data Out
port and the error detector's Data In port.

3 Terminate all non-connected pattern generator output ports with
50 Ω.

4 Enable the pattern generator outputs by pressing the 0V
(Disable) button.

5 Switch to the Pattern menu and press Pattern Select. Select an
appropriate pattern, for example a pure 2^15-1 PRBS, for both
the pattern generator and the error detector.

6 For the pattern generator setup, you need to specify the logic
levels and the bit rate. Select:

– Logic levels: LVPECL

– Clock speed: Gb Ethernet (1.06250 G b/s)

See “Setting up the Pattern Generator - Concepts ” on page 69
for more information.

7 Set up the error detector so that the input range and the
termination matches the pattern generator's levels. Select
Normal as the Active Input,an Input Range of 1-3V, and set the Data
Termination to 1.3V.

8 Also make sure that the error detector derives its clock from the
incoming data stream using Clock Data Recovery. See “Clock
Setup - Procedures” on page 116 for details.

9 Press Sync Now and then Auto Align to find the optimum sampling
point. Check that the synchronization and the alignment were
successful. None of the error indicators should show red, and the
resulting BER should be zero.

How to Execute the Spectral Jitter Measurement

To run the Spectral Jitter measurement:

1 Switch to the Analysis area. If the Spectral Jitter screen is not yet
displayed, press the Spectral Jitter icon.

2 Press the Start button to execute the measurement.

The measurement software runs the measurement and displays the
results. A total of 65535 points are displayed for this measurement.
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Numerical values are also displayed. The values include Bit Error
Rate, Total Power, and Noise power. Additionally, you can also
configure up to 16 frequency/power pairs. The latter are sorted
according to descending power contents. These results are discussed
in “Explanation of the Numerical Results” on page 187.

How to Optimize the View of the Results

After you have run a measurement, the resulting graph and the
calculated numerical values are displayed. To improve the results,
you can change the measurement parameters:

1 Press the Properties button to open the Properties dialog box.

2 Use the different tabs in this dialog box to make the required
settings:

– Parameters tab

These settings are used for data collection. Changes require
to run the test again. See “Parameters Tab” on page 180 for
details.

– Pass/Fail tab

These settings determine whether the calculated results are
recognized as passed or failed. However, a new test run is not
required when doing changes here. See “Pass/Fail Tab” on
page 181 for details.

– View tab, Graph tab, and Color tab

All settings on these tabs only affect the way the data is
displayed. You do not need to run the measurement again.
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See “View Tab” on page 183, “Graph Tab” on page 185, and
“How to Change the Colors of the Graph” on page 159 for
details.

3 Press OK when you have made all required changes to close the
Properties dialog box.

Spectral Jitter - Reference

The Spectral Jitter measurement returns the results in a graphical
and in a numerical form. The following sections provide
explanations of the measured parameters and the display options
that are specific to this measurement. Additionally, some
information is provided to explain the theoretical background
behind the jitter calculations.

Properties that can be specified on the various tabs of the 
Properties dialog box:

Parameters Tab

N O T E If you modify the parameters on this page, you have to rerun the measurement to
update the results.

Set the data acquisition parameters:

• Acquisition Depth

Suitable numbers can be chosen from the drop-down list.

The Acquisition Depth determines the length of the time record
used for the FFT.

A smaller number reduces the duration of the Spectral Jitter
measurement and its precision. A larger number increases the
measurement duration but also the frequency resolution of the
measured spectral components.

The frequency resolution of the measurement is:

data rate / Acquisition Depth
For example: If you have a data rate of 2.5 GHz and an
Acquisition Depth of 128 Kbit, the frequency resolution is 19.0735
kHz.

The relations are illustrated in the following figure:
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N O T E A high Acquisition Depth requires a high degree of computational effort and hence
time.

• Sample Point Offset

By default, the sampling point for the measurement is positioned
0.5 clock periods or UI ahead of the present analyzer sampling
point.

If the sampling point is set in the middle of the eye, this
corresponds to the transition point of the incoming signal. If you
have set the sampling delay manually, this is the time offset from
that point.

This option allows you to fine-tune the sampling point. The unit
is UI (unit intervals). This makes the setting independent of the
present clock frequency.

Set the FFT window for the FFT Calculation. The following windows
are provided:

• Uniform

• Hanning (sometimes also called Hann)

• Hamming

• Blackman

The "uniform" window is no window at all. This setting supplies the
original error record to the FFT.
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The other windows have the shapes illustrated in the figure below:

You can see from the figure that the Blackman window is the
strongest filter.

The windows are based on the following formulas:

N O T E In case of leakage, FFT windows improve the spectral resolution. FFT windows
generally reduce the measured spectral power.

For an introduction to FFT windows see “Leakage and Windowing”
on page 282.

Pass/Fail Tab

The Pass/Fail tab of the Properties dialog box allows you to specify
the criteria to decide whether the DUT passes or fails the test. You
can change pass/fail criteria without rerunning a test. The software
only uses the criteria to rate the results of a measurement.
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N O T E The pass/fail criteria do not control measurement execution. The measurement run
will be completed even if the measurement fails for one or more of the criteria.

The following Spectral Jitter Pass/Failcriteria can be selected for the
pass or fail decision:

• Bit Error Rate

• Total Power (in dB)

• Noise Power (in dB)

You can also define the pass/fail criteria for each of the defined
frequency ranges.

In the tabular view, each of the calculated values will be marked
with an

icon if it failed the test.

The following illustration shows a Spectral Jitter measurement that
has failed the criterion for the Bit Error Rate.
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View Tab

The graph shows the noise versus frequency. The View tab provides
you with various options for analyzing the data and setting
frequency ranges for evaluation.

The linear power scale is well suited for identifying large peaks in
the spectrum.

The View tab allows you to change the power scale from linear to
dB. The dB scale is a logarithmic scale. The dB scale allows you to
examine the whole power range.

The following figure shows an example of a double logarithmic
display.
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The figure above shows the absolute power scale and values as
calculated by the FFT. You can also calculate relative values.

Relative values can be normalized to either the total power ( True
Relative) or to the power of a selectable frequency bin ( Relative).

The following figure shows an example where the scale and the
power values have been normalized to the power measured at 1
MHz.

When you set the power values to relative, this changes not only
the graphical scale but also the calculated results. You can thus
calibrate the power values to any reference.
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The Noise Threshold can be moved with the mouse (or your finger).
It can also be set on the View page of the Properties dialog.

This threshold is used to separate between total power and noise
power. All components below the Noise Threshold are considered
noise. When the threshold is changed, the calculated Noise Power
values change.

If desired, change the Number of Top Frequencies to Show. This
determines the number frequency/power pairs in the numerical
section. Up to 16 pairs can be calculated and displayed.

Graph Tab

On the Graph tab, you can use the several options to optimize the
graphical display according to your needs.

Choose between logarithmic and linear scale for displaying the
frequencies.

Display the power either in a logarithmic (dB) or linear scale.

Show the entire frequency range or zoom in one part of it.

To analyze the graphs at a particular point, you can use the
markers. Additionally, you can display all related values for the
markers in the marker readout.

Pressing the Reset Markers button will set the markers back to the
default positions.

Several zoom factors are available. When you show the zoom graph,
you can also allow the zoom graph to track the mouse (or your
finger, if you are working directly on the Serial BERT ).
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Explanation of the Numerical Results

The measurement provides numerical results for:

• Bit Error Rate

• Total Power

• Noise Power

• The Frequency and total power for up to the 16 frequencies with
the highest total power.

You can set the number of top frequencies to be evaluated in the
View tab (see “View Tab” on page 183 for details).
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6 
Evaluating Results

Evaluating Results - Concepts

The Serial BERT  offers several different kinds of tests that can be
run:

• Instantaneous Measurements

This type of measurements is used to monitor the instantaneous
BER during measurement setup, experiments, and adjustments.

• Accumulated Measurements

This type of measurements is used to measure and log error
performance over time. Also, you can capture the location of bit
errors for further analysis.

• Eye Measurements

This type of measurements is used to measure the eye height and
width of the incoming data signal at specific alignment BER
thresholds. This information is displayed on a representation of
an eye diagram.

Instantaneous Measurements

Instantaneous Measurements - Concepts

With instantaneous measurements, you can directly view the
current BER on the screen. In order to stress your device under
test, you can then, for example, add errors to the data stream or
switch between different patterns and view the resulting BER. Or
you can adjust the output port parameters or the error detector's
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sampling point while the measurement is running and watch the
resulting BER immediately.

Such measurements can be used to find out the benchmark data,
for example, for a device prototype.

Test Methods

You can analyze the behavior of your device by employing several
test methods. If the changes in the test setup affect the BER, you
can immediately notice it on the screen. The resulting changes in
the BER let you learn about the DUT's behavior and limitations.
Some examples of modifications that you can make are listed below.

• Add errors to the data stream. You can, for example, perform a
confidence test of your measurement setup. The analyzer should
recognize all errors that you add. If it does not, you may have
a problem with your measurement setup. See for details.

• Use alternating patterns to switch between different data
streams. For example, if your device is designed to turn off in
response to a high BER, you can check if your device behaves
as expected. And you can observe what the BER is prior to data
loss. See for details.

• Manipulate the signal being generated by the pattern generator,
as described in .

• Adjust the sampling point to see the effect on the BER. See
“Sampling Point Setup - Concepts ” on page 119 for details.

• Make modifications to your device setup.

This can be used to see how changes to your device affect the
BER. You can determine what adjustments improve or degrade
the BER.

Instantaneous Measurements - Procedures

This section describes how to run, monitor, and analyze
instantaneous measurements.

Running Instantaneous Measurements

The Serial BERT 's error detector immediately starts calculating the
bit error rate as soon as it receives a valid signal at the data ports.
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N O T E Both the pattern generator and the error detector must be correctly set up and
connected to the DUT.

To run a BER measurement:

1 Check if all the values in the status line are correct: pattern
generator pattern and bit rate, error detector pattern and bit
rate.

2 View the BER display in the top left corner of the GUI.

If the measurement is running properly, a certain BER should
be displayed here. In most cases the BER is not a constant value
but slightly varying over time. If no BER is displayed because
there are no errors detected, you can manually insert an error
by pressing the Error Add button in the top right corner of the
screen.

When inserting an error, the BER should increase for a short
time and then return to the initial value.

How to Monitor the BER Results

There are different ways, how you can monitor instantaneous BER
values:

1 Listen to the BER warning tones. See “Audio Signals -
Procedures” on page 149 for details.

2 View the BER Results window, which is described in “BER Results
Window” on page 298.

3 View the BER bar and errors indicator. See “Status Indicators”
on page 298 for details.

How to Analyze the BER Results

>To analyze the behavior of your device, you can do the following
modifications to the test setup and monitor the effect on the
resulting BER:

1 Add errors to the data stream. See “Error Addition/Insertion -
Procedures” on page 95 for details.

2 Use alternating patterns to switch between different data
streams. See “Pattern Alternation - Procedures” on page 99 for
details.
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3 Adjust the parameters of the output port of the pattern
generator, as described in “Input and Output Ports - Procedures”
on page 77.

4 Manually move the sampling point. See “Sampling Point Setup -
Procedures” on page 122 for details.

5 Make adjustments to your device.

This can be used to see how changes to your device affect the
BER. You can determine what adjustments improve or degrade
the BER.

Instantaneous Measurements - Reference

This section describes all elements of the BER Results window and
the various status indicators:

BER Results Window

This window displays the actual ( BER) or cumulative ( AccumBER)
BER results:

• The BER is the current BER, calculated upon a period of 200ms.

• The AccumBER shows either the accumulated BER of the current
accumulation, or-if no accumulation is running-the results of the
most recent accumulation.

This enables you to monitor real-time BER behavior as you do
things such as to manually adjust the sampling point, to add errors,
or to make adjustments to your device.

Click this button to toggle between BER or AccumBER results.

This area displays the actual error count or cumulative error count.

N O T E The BER bar below the main menu bar also displays the actual BER. You can drag
the small yellow alarm threshold mark to change the BER Alarm Threshold.

Status Indicators

The BER bar displays the BER calculated upon a period of 200 ms.
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You can drag the yellow alarm threshold mark to change the BER
Alarm Threshold.

These indicators inform you about the following errors:

• Bit error in the data stream located

• Loss of pattern synchronization

• Complete loss of data

• Loss of the error detector's clock signal

• Loss of the pattern generator's clock signal

For troubleshooting information, see .

This indicator turns green when the instrument is under remote
control.

Status messages displays a one-line instrument status or error
message. Click the More... button to open an Error Message dialog
box with the complete message. This dialog box also contains a Help
button that takes you to the respective section of the Online Help.

This area displays the progress of the current accumulation period.
The accumulation period can be changed in the Accumulation Setup
dialog box. For more information, see “Accumulated Measurements
- Procedures” on page 301.

The PG and ED pattern types are displayed here for your reference.
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The PG and ED measured bit rates are displayed here for your
reference.

Accumulated Measurements

Accumulated Measurements - Concepts

Accumulation refers to collecting measurement data over a specific
period. This can be used to create test scenarios that are
reproducible and comparable. Also, you can let tests run over long
times and then evaluate the results afterwards. Furthermore, you
can use the log files to determine the location of occurring bit
errors for further root cause analysis.

N O T E While accumulation tests are running, you should not modify the measurement
setup, as the measured bit errors do not represent the performance of your DUT
under real circumstances.

The period of time can be set by manual start and stop commands,
an absolute time setting, or the time it takes to measure a specified
number of bits or bit errors. The accumulation period should be
long enough to make a statistically valid BER measurement. See
“Test Times and Confidence Levels” on page 15 for details.

N O T E During measurement logging, the Serial BERT logs data in ten-second intervals.
Your log file may be missing up to the last ten seconds of data. To avoid this
condition, accumulate for 10 seconds longer than desired.
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Accumulated Measurements - Procedures

This section describes how to run accumulated measurements and
how to analyze the results:

How to Run Accumulated Measurements

To run accumulated measurements:

1 Ensure that the instrument is set up correctly and that the error
detector is already in synchronization.

2 Press the Accumulation Setup icon in the ED Setup menu to check
the settings made for the data accumulation.

See “Error Accumulation - Procedures” on page 145 for details.

3 To begin accumulation, press the Start Accum button on the front
panel.

This causes the following events:

• If Prompt for File Name has been selected during setup, you will be
asked to enter a name for the log file before accumulation
begins.

• The data display in the Accumulated Results window is reset.

• The recording of data to the measurement log file is reset.

How to Stop Accumulated Measurements

If you specified a single or repeat test, the test runs until the
specified end condition is reached. If you selected a manual test, it
will run until you stop it manually.

• Press the Stop Accum button on the front panel to stop the test
immediately.

N O T E Errors are only counted when the signal at the Gate In port is low.
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How to View the Results

You can view data from accumulated measurements in several ways:

1 Press the Accumulated Results icon in the Results menu to view the
test results.

For easy comparison, the results of the current and previous
accumulation are listed here. See “Accumulated Measurements -
Reference” on page 302 for details on the reported values.

2 Examine the measurement log files on an external PC.

This allows to access all data for detailed processing and
analysis on a PC. Also, you can track the status of all indicators
(such as DATA LOSS and CLK LOSS) during the accumulation
period. If you want to view results from an accumulation period
prior to the current and previous test, you can view the
respective log file, too.

How to Analyze the Results

Accumulated measurements can help you determine the cause of bit
errors. Bit errors can be caused by a variety of problems. In
addition, instrument settings can affect how errors are measured
and displayed. The sync mode setting has the greatest effect.

• Analyze the basic accumulated results and log files. Possible
observations that may occur are:

– Errors became constant (and remained constant for a period
of time) or number of errored 0's was greater than errored
1's, see “Constant Errors (More Errored 0's than 1's)” on page
373.

– Errors were random, see “Random Errors” on page 374.

– Sync loss seconds were measured, see “Sync Loss Seconds”
on page 375.

Accumulated Measurements - Reference

The Accumulated Results window presents data from the current and
previous accumulation period.

N O T E Data from the current and all previous accumulation periods is available in the
measurement log files, if correctly set up.
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This window contains a graph and five tables:

Ratios Graph

This graph displays the delta errored 1's ratio, delta errored 0's
ratio, and total delta error ratio at data points over the entire
accumulation period. The error ratios on the y-axis are set to a
range of 1E+0 (100 % errors) to 1E-12. The accumulation period is
on the x-axis.

During accumulation, data will appear to move from left to right on
the ratios graph. When the graph is completely filling the display,
the x-axis time scale will double. The data graph is then occupying
only half of the display and will continue to move to the right again.
This will repeat until the accumulation period has ended.

This graph can accumulate a large amount of data. You can click
any point on this graph to zoom into an area of BER data. You can
continue to click on the graph until you have zoomed to the
maximum. The point you click will appear in the middle of graph.
You can press the back button (left arrow) to zoom out again.
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N O T E The zooming function cannot be used before the accumulation period has ended.

N O T E To view precise BER data for every point in time, view the measurement log file.

While zoomed in, you can move data left or right by dragging the
graph or by using the front panel knob.

You can also zoom vertically by dragging the top and bottom sizing
handles. The current view can be moved vertically if you click
between the handles and drag them up or down.

Accumulated Results

In the Accumulated Results table, the following values are listed:

• Bit Count

The number of bits considered for the accumulation period is
displayed here. This may not equal the total number of bits sent
from the PG.

• Error Ratio

The ratio of the error count to the bit count is displayed here
to 4 significant digits.

• Error Count

The number of errored bits measured during the accumulation
period is displayed here.
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• Errored 1's Ratio

The ratio of the errored 1's count to the bit count is displayed
here to 4 significant digits.

• Errored 1's Count

The number of logic 1's measured as logic 0's during the
accumulation period is displayed here.

• Errored 0's Ratio

The ratio of the errored 0's count to the bit count is displayed
here to 4 significant digits.

• Errored 0's Count

The number of logic 0's measured as logic 1's during the
accumulation period is displayed here.

G.821 Measurements

• Availability

The ratio of the available seconds to the total gating period
expressed as a percentage.

• Unavailability

The error ratio is calculated over 1 second timed intervals during
the gating period. An unavailable period begins when the error
ratio is worse than 1 x 10 -3  for 10 consecutive seconds. These
10 seconds are considered part of the unavailable time. The
unavailable period ends when the error ratio is better than 1 x
10-3  for 10 consecutive seconds. These 10 seconds are considered
part of the available time. Percent (%) Unavailability is the ratio
of the unavailable seconds to the total gating period expressed
as a percentage.

• Severely Errored Seconds

The ratio of the total number of available seconds with an error
ratio worse than 1 x 10 -3  to the total number of available
seconds, expressed as a percentage.

• Degraded Minutes

Severely errored seconds are discarded from the available time
and the remaining seconds are grouped into blocks of 60
seconds. Blocks which have an error ratio worse than 1 x 10 -6

are called Degraded Minutes and Percent (%) Degraded Minutes
is the ratio of the total number of degraded minutes to the total
number of 60 second blocks in the available time expressed as
a percentage. Incomplete blocks of less than 60 seconds are
treated as complete blocks of 60 seconds.
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• Errored Seconds

The ratio of the errored seconds in the available time to the total
number of seconds in the available time, expressed as a
percentage.

Interval Results

• Error Free Seconds

The number of seconds in which no errors were measured is
displayed here.

• Error Free Deciseconds

The number of deciseconds in which no errors were measured
is displayed here.

• Error Free Centiseconds

The number of centiseconds in which no errors were measured
is displayed here.

• Error Free Milliseconds

The number of milliseconds in which no errors were measured
is displayed here.

• Errored Seconds

The number of seconds in which errors were measured is
displayed here.

• Errored Deciseconds

The number of deciseconds in which errors were measured is
displayed here.

• Errored Centiseconds

The number of centiseconds in which errors were measured is
displayed here.

• Errored Milliseconds

The number of milliseconds in which errors were measured is
displayed here.

• Sync Loss Seconds

The number of seconds in which the error ratio was greater than
the sync threshold is displayed here.

Accumulation Parameters

• Elapsed Time
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The time elapsed during the accumulation period is displayed
here.

• Percent Complete

For single and repeat accumulation modes, the percentage of the
accumulation period completed is displayed here to one decimal
place. For repeat mode, this percentage is recalculated each time
the accumulation period repeats.

• Accumulation Mode

The type of accumulation mode is displayed here. The mode can
be Manual, Single, or Repeat.

• Accumulation Period

For single and repeat accumulation modes, the accumulation
period is displayed here. The period will be displayed in elapsed
seconds, error count, or bit count, depending on the selected
method.

Burst Results

The recommended application for burst mode is to measure
multiple data bursts in quick succession. In this way, you can
accumulate data for all bursts together. You may wish to accumulate
the number of bits necessary for a statistically valid BER
measurement. Refer to “Introduction to Burst Sync Mode” on page
137 and “Test Times and Confidence Levels” on page 15 for details.

When the accumulation period lasts for the duration of all bursts,
the gaps in error counting (while the Gate In signal was high) will
not be included in BER calculations. The gaps in error counting will
not be considered error-free periods.

N O T E If the gaps between data bursts are greater than 1 second (or 100 ms in the
measurement log file), they may be visible in the accumulated results graph.

• Burst Status

The following states may be returned:

– No Error

No burst errors have occurred (any of those listed below).

– Gate Signal Too Long

This error can occur if there are too many bits within a burst.
The limit is 4 Gbit. At 13 Gb/s, this occurs roughly after 0.3
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s (slower frequencies have a higher gate-in period). This error
has a higher priority than "no unique 48bits".

– No Unique 48 Bits Found

For reliable synchronization, a pattern must contain a unique
48-bit pattern (the detect word). If the current pattern does
not have a detect word, this error occurs.

If this status occurs, the synchronization may be incorrect, as
could also the measured bit error rate. There are standard
patterns that may contain more than one instance of the used
detect word. Statistically, every other burst would be correctly
synchronized.

In this case, it is recommended that you redefine the pattern.
This error can only occur with memory-based patterns.

– Unknown

The status is unknown. This can occur if accumulation has
not been started, or if Burst Sync mode has not been
activated.

• Burst Sync Ratio

Percentage of time in burst (while the Gate In signal is low) that
patterns are in sync and error counting is active. A higher
percentage is desirable, because it indicates that more data is
measured during each burst.

• Total Burst Count

Total number of bursts received while in burst mode during the
accumulation period.

• Bad Burst Count

Total number of bursts where sync is never achieved during the
accumulation period.

• Bit Count

The number of bits considered for the accumulation period is
displayed here. This may not equal the total number of bits sent
from the PG.
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Eye Measurements

Eye Measurements - Concepts

The purpose of eye measurements is to measure the eye height and
width of the incoming data signal at specific alignment BER
thresholds. This information is displayed on a representation of an
eye diagram.

Eye Measurements - Procedures

Eye measurements are made each time the Auto Align, Clock/Data
Center, or 0/1 Threshold Center functions are used.

To analyze the results:

1 View the graph and table in the Eye Results window.

This window provides detailed information on the calculated eye.
See “Eye Measurements - Reference” on page 309.

2 Analyze the results by observing changes in the eye results due
to the following adjustments:

– Make changes to your device or measurement setup.

– Run auto-search functions at different BER thresholds.

This will allow you to see the eye margin at specific BERs
and construct basic eye contour information.

3 Change the sampling point in the Sampling Point Setup window. See
“Sampling Point Display” on page 128 for details.

Eye Measurements - Reference

Eye results are displayed for the Current Align and Previous Align
process. They are also graphically displayed on a representation of
an eye diagram.

Evaluating Results 6

Agilent J-BERT N4903 High-Performance Serial BERT 309



Eye Width and Height

Eye width is the inside horizontal opening of the data eye in an eye
diagram. This measurement is made by the error detector after an
Auto Align or Data Center. The eye width at the current 0/1 decision
threshold is displayed on a simulated eye diagram. The left and
right eye edges are determined by the user-defined BER threshold.
Different BER thresholds will produce different eye width results.

Eye
width

Left eye
edge

Right eye
edge

Eye height is the inside vertical opening of a data eye in an eye
diagram. This measurement is made by the error detector after an
auto align or 0/1 threshold center. The eye height at the current
data input delay point is displayed on a simulated eye diagram. The
upper and lower eye edges are determined by the user-defined BER
threshold. Different BER thresholds will produce different eye
height results.

Eye height

Upper eye
edge

Lower eye
edge

N O T E Most oscilloscopes measure eyes differently, using statistical data. Therefore, the
eye results of a Serial BERT and an oscilloscope may be different.
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The table in the top half of the Eye Results window additionally
lists the following values:

• Eye Voltage Center

One of two components of the sampling point, the 0/1 decision
threshold (eye voltage center) is displayed here.

• Eye Data Input Delay

One of two components of the sampling point, the data input
delay is displayed here.

• Alignment Threshold

The alignment BER threshold is displayed here. This threshold
was used to define the eye edges and the above eye results.

• Delta Error Ratio

The BER measured during the previous 200 ms is displayed here.
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7 
Jitter Tolerance Tests

Jitter Tolerance Tests - Concepts

N O T E This chapter refers only to Serial BERT instruments on which the calibrated and
integrated jitter injection option J10 is installed.

A jitter tolerance measurement is used to determine the ability of
a device or system to maintain communication quality in the
presence of jitter. It comes in two varieties:

• Jitter Tolerance Characterization determines the jitter levels
where the device under test can no longer maintain a desired bit
error ratio (BER).

• Jitter Tolerance Compliance verifies that the device under test is
able to maintain a BER level at pre-defined jitter levels and jitter
frequencies, as defined by a standard.

The basic setup of a jitter tolerance test is illustrated below:
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Understanding Jitter Tolerance

The behavior and the passed/failed classification of data receiving
devices or circuits are determined by their ability to withstand

• Jitter

• Intersymbol interference

• Level noise

This refers particularly to the performance of phase-locked loops
(PLLs) or clock data recovery circuits (CDR).

Jitter tolerance can be measured by applying a distorted data signal
to the DUT and measuring the resulting bit error ratio. To make
jitter tolerance tests reproducible, the signal distortion must also be
reproducible. This requires some definitions.

Jitter

Receivers react differently on

• different types of jitter

• the jitter composition

• the jitter frequency spectrum

• the combination of jitter frequencies and data rate

Various test standards specify the jitter composition to be used for
jitter tolerance tests.

The Serial BERT  provides the following means for generating
artificial (reproducible) jitter:

• Two voltage-controlled signal delay lines

• A phase shifter for modulating the generated clock

For more information see

• “Understanding the Types of Jitter” on page 315

• “How the N4903 Generates Jitter” on page 319

Intersymbol Interference

Conductors on PC boards have a limited bandwidth. This causes
intersymbol interference which changes the shape of the received
eye opening. The eye becomes unsymmetrical.

The Serial BERT  provides the Interference Channel option J20 to
simulate ISI.
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For more information see

• “Intersymbol Interference” on page 318

Level Noise

Level noise affects the voltage amplitude of the eye opening.

The Serial BERT  provides the Interference Channel option J20 to
simulate level variations by adding sinusoidal interference.

For more information see

• “Crosstalk” on page 319

PLL Performance Test

Testing a PLL (or CDR) is not complete until the entire frequency
range of the PLL has been checked under worst-case conditions.

For this purpose, the Serial BERT  provides the Jitter Tolerance
Characterization measurement.

For more information see

• “Jitter Tolerance Characterization - Concepts” on page 336

PLL Standards and Compliance Tests

The Optical Internetworking Forum (OIF) as well as other
institutions have proposed standards for testing the performance of
data receivers and receiver circuits in the presence of jitter.

For this purpose, the Serial BERT  provides the Jitter Tolerance
Compliance measurement. This measurement is available as an
option (option J12) which can be ordered together with the
instrument or retrofitted.

For more information see

• “Jitter Tolerance Compliance - Concepts” on page 348

Understanding the Types of Jitter

The standards for jitter tolerance tests prescribe combinations of
certain jitter types. This section gives an overview of these types.
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Random Jitter

Random jitter (RJ) is always present. Resistors, transistors, and
other components generate noise that impacts transmitters and
receivers. This kind of jitter has a Gaussian distribution over time.

Theoretically, the Gaussian distribution stretches from - ∞ to + ∞. In
practice, the amplitude is defined by the crest factor (p-p amplitude
= sigma × crest factor)

Bounded Uncorrelated Jitter

Similar to random jitter, bounded uncorrelated jitter (BUJ) has also
a Gaussian distribution, but this distribution is cut (bounded) at
both sides.

This kind of jitter can be caused, for example, by crosstalk on a
parallel bus or by intersymbol interference of random or long
pseudo random binary bit sequences.

To simulate bounded uncorrelated jitter for jitter tolerance tests, it
can be generated from a filtered (frequency-limited) PRBS.

Periodic Jitter

Periodic jitter (PJ) is generally picked up from other periodic
sources.

Rectangular jitter may be caused, for example, by a switching power
supply. It has a distribution as shown below.
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The jitter amplitude is usually specified in UI. One UI (Unit
Interval) is always the reciprocal of the present data rate. For
example, if the data rate is set to 2 Gbit/s, one UI corresponds to
500ps.

This kind of jitter can be picked up from any adjacent signal or
clock. The jitter histogram has a U-shape.

Triangular jitter is always generated by a spread spectrum clock but
can also be caused by other periodic sources. Triangular jitter has
a uniform jitter distribution.
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Intersymbol Interference

Intersymbol interference (ISI) is caused by bandwidth limitations of
cables and backplanes. It cuts off higher frequencies and hence
changes the shape of the eye opening.

Intersymbol interference can be simulated by inserting a defined
transmission path between the pattern generator and the DUT.
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Crosstalk

Crosstalk between adjacent signal paths modulates the vertical eye
amplitude. This narrows the voltage range of the receiver needed
for capturing data correctly.

For jitter tolerance tests, amplitude modulation is most often
simulated by modulating the data output with a sinewave signal.
This is called Sinusoidal Interference (SI).

Total Jitter

Total jitter is the sum of all kinds of jitter.

Edge, level, and shape variations impact width, height, and
symmetry of the eye opening. An example is shown below:

How the N4903 Generates Jitter

An Serial BERT  on which the calibrated and integrated jitter
injection option J10 and the interference channel option J20 are
installed, combines all the necessary jitter sources in one
instrument.
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Jitter Generation Block Diagram

To support all present test standards, the pattern generator of the
Serial BERT  has the following hardware architecture:

The clock can be generated from the internal oscillator or an
external source.

The instrument has internal sources for spread spectrum clocking
(SSC), sinusoidal jitter (SJ), periodic jitter (PJ), bounded
uncorrelated jitter (BUJ), and random jitter (RJ). In addition, an
external jitter signal can be applied at the Delay Ctrl Input.

Note that all these sources can be individually switched on or off.

This is a special modulator that modulates the generated clock with
a low-frequency signal. The resulting jitter superimposes all other
jitter components.

Two sources are provided for modulating the clock: Spread
spectrum (triangular) or sinusoidal. Only one of them can be used
at a time.

When sinusoidal modulation is chosen, the Clock Output and
Trigger Output ports can be connected to the unmodulated or the
modulated clock. If SSC is enabled, the Clock Output and Trigger
Output ports provide the spread spectrum clock.
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Two delay lines are provided for generating data jitter, a 500 ps
delay line and a 200 ps delay line. Considering the data output, they
are connected in series.

The 500 ps delay line is provided for generating large jitter
amplitudes at low bit rates. It cannot be used for bit rates higher
than 3.37Gbit/s.

The source for periodic jitter (PJ) can be connected to the 500 ps
delay line or to the 200 ps delay line.

All other sources can only be connected to the 200 ps delay line.

The Subrate Clock Output follows the 500 ps delay line. It is not
influenced by any jitter produced by the 200 ps delay line.

Interference Channel

The option J20 Interference Channel is available for simulating
intersymbol interference (ISI) with or without sinusoidal
interference (SI).

This is a hardware module that can be plugged into the instrument.
It has two ports, P1/ P1 and P2/ P2. Both can be connected single-
ended or differentially.

The Interference Channel provides a switchable signal path with
Nelco 4000-6 FR4 characteristics. This path can be connected
between the pattern generator's Data Out port and the DUT. For
instructions refer to “Connecting the J20 Option” on page 392.

The Interference Channel provides also a sinewave generator and a
resistive combiner. This makes it possible to add sinusoidal
interference (amplitude modulation) to the data signal.

The Interference Channel is built up as shown in the following
figure.
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The figure above shows the connections for a single trace segment
combined with sinusoidal interference.

N O T E Note that all these relays and traces exist twice to support single-ended and
differential operation.

When intersymbol interference is switched off, there is a minimum
trace length between P1 and P2.

ISI must be enabled if sinusoidal interference shall be added to the
signal. In this case, the minimum trace is longer (refer to the
technical specifications).

Data can be input by connecting the pattern generator's Data Out
port to either P1 or P2.

If P1 is used as input, sinusoidal interference is (or can be) added
after the signal has passed the chosen trace. Seen from the DUT,
this is called "near end" injection. If P2 is used as input, sinusoidal
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interference is (or can be) added at the beginning of the trace. This
is called "far end" injection.

Jitter Setup

Jitter Setup - Concepts

The Jitter Setup function is used for composing the total jitter in a
defined and calibrated way.

This function reflects the present setup of the Serial BERT 's internal
jitter generation hardware (see also “Jitter Generation Block
Diagram” on page 320).

The display is divided into two sections:

• Delay line status and switch area

• Overview and setup area

Delay Line Status and Switch Area

The switch is a button that can be pressed. It switches the periodic
jitter source to either the 500 ps or the 200 ps delay line.

The delay lines show markers which indicate the used and the
remaining jitter amplitude in UI. Colored bars allow you to judge
the impact of each jitter component on the total jitter.

UI is the acronym for Unit Interval. One UI is the present clock
period.

Sinusoidal jitter is not generated by a delay line but by modulating
the clock. Sinusoidal jitter cannot be used together with SSC,
because both features use the same modulator.
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Overview and Setup Area

Five colored rows keep you informed about the present jitter
composition of:

• Random jitter

• External jitter source (connected to the Delay Ctrl Input)

• Bounded uncorrelated jitter

• Periodic jitter

• Sinusoidal jitter

Each type can be separately turned on or off.

The Overview column consists of buttons that can be pressed to
change the parameters of each jitter type independently from
others.

Jitter Setup - Procedures

Do the following to compose the desired jitter:

1 Press the Jitter button on the front panel or, in the Jitter
window, press the Jitter Setup Icon.

This opens the Jitter Setup window.

2 Enable jitter generation. Click the respective checkbox.
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When this checkbox is disabled, no jitter is generated. This refers
to all the jitter types shown on the screen, even if they seem to
be connected. When this checkbox is enabled, the displayed
status becomes active.

N O T E The Jitter Enable checkbox has no impact on SSC. If spread spectrum clocking is
enabled (from the Bit Rate Setup window of the Pattern Generator), it continues,
even if the Jitter Enable checkbox is off.

Select the Delay Line

To select the delay line for periodic jitter, press the switch.

N O T E The 500 ps delay line cannot be used for bit rates above 3.37 GHz.

Specify the Jitter Components

To specify the jitter components:

1 Activate a jitter source (press its checkbox).

2 Click its button in the Overview column.

This opens a window to set the parameters. An example for
random jitter is shown below.
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A parameter that must be set for any jitter type is Amplitude. This
defines the timely width of the jitter component.

3 Observe the consumption of delay line capacity indicated by the
delay line markers. Ensure that the total jitter remains within
the margins of the chosen delay line.

4 Return to the overview display by pressing the Overview button.

5 Proceed with the next jitter type you wish to add.

N O T E When you activate an External jitter source (by pressing its checkbox), you will find
that this apparently consumes the whole free capacity of the delay line (at the right-
hand side of the red bar).

But this is just an indication. You can still add or change internal jitter components.
The external jitter range is automatically updated when you add, change, or switch
off one of the internal sources.

Jitter Setup - Reference

The Jitter Setup function is used for composing the total jitter in a
defined and calibrated way.

Jitter Enable

This checkbox is used enable or disable jitter generation.
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When this checkbox is disabled, no jitter is generated. This refers
to the whole composition shown on the screen. When this checkbox
is enabled, the present status becomes active.

N O T E The Enable checkbox has no impact on SSC. If spread spectrum clocking is enabled
(from the Bit Rate Setup window of the Pattern Generator, see “Spread Spectrum
Clock” on page 88), it continues, even if the Jitter Enable checkbox is off.

Delay Line Switch

This switch can be pressed to switch the source of periodic jitter
to either the 500 ps or the 200 ps delay line.

N O T E The 500 ps delay line cannot be used for data rates above 3.37 GHz.

Delay Line Display

The delay line display shows red markers that indicate the
consumption of delay line capacity by the present jitter setup.

Colored bars indicate the consumption by the various jitter
components.

The consumption is shown in UI (Unit Intervals) and is calculated
from the present data rate. Because the delay lines have a fixed
time capacity, the scales change when the bit rate is changed.

Jitter Composition Overview

This section of the Jitter Setup function shows the present jitter
composition.
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To become active, jitter sources must be switched on (by enabling
the corresponding checkbox) and must at least have an Amplitude
greater than zero.

The Overview column consists of buttons that can be pressed to
change the parameters of each jitter type independently from
others.

The Overview button can be used to return after changing
parameters.

Random Jitter Parameters

The random jitter Amplitude must be entered as an rms (root mean
square) value. The rms value corresponds to the sigma factor σ of
the bell-shaped Gauss distribution curve (see also “The Gaussian
Marker” on page 164).

7 Jitter Tolerance Tests

328 Agilent J-BERT N4903 High-Performance Serial BERT

Amplitude



To modify the value, click inside the text field and enter the desired
value directly with the numeric keyboard, or use the knob close to
the numeric keyboard to fine-tune the value.

The peak-to-peak amplitude is calculated by multiplying the rms
value with the crest factor (which is currently fixed to 14). The

Amplitude p-p box shows how much of delay line capacity the setting
consumes.

The random jitter source is equipped with a 10 MHz high pass and
a 500 MHz low pass filter to limit the spectral range. Both filters
can be disabled or enabled by pressing the respective buttons.

Bounded Uncorrelated Jitter Parameters

Bounded uncorrelated jitter is characterized by

• Data rate

• Amplitude

• PRBS polynomial

• Low pass filter

A graph indicates whether the chosen setting of frequency and
amplitude is tolerable.
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You can specify your own setup or choose one of the predefined
settings.

You can choose one of four predefined settings:

• CUSTom: The individual parameter values apply.

• CEI6G: Meant for CEI 6 Gbit/s tests: PRBS data rate is 1.1 Gbit/
s, the PRBS polynomial is 2 9-1, the low-pass filter is 100 MHz.

• CEI11G: Meant for CEI 11 Gbit/s tests: PRBS data rate is 2 Gbit/
s, the PRBS polynomial is 2 11-1, the low-pass filter is 200 MHz.

• Gaussian: Preset values for Gaussian distribution: PRBS data
rate is 2 Gbit/s, the PRBS polynomial is 2 31-1, the low-pass filter
is 100 MHz.

Enter an appropriate Data Rate. Refer to the technical specifications.

The maximum peak-to-peak Amplitude is limited by the free capacity
of the 200 ps delay line.

The PRBS polynomial can be chosen from a list. Available are eight
polynomials, from 2 7-1 up to 2 31-1.

The bounded uncorrelated jitter source is equipped with four low-
pass filters with cut-off frequencies at 20, 50, 100, and 200 MHz.
One of these filters is always active.

Periodic Jitter Parameters

Periodic jitter (PJ) is characterized by

• Amplitude

7 Jitter Tolerance Tests

330 Agilent J-BERT N4903 High-Performance Serial BERT

Setting

Data rate

Amplitude

PRBS

Filter



• Frequency

• Waveform

A graph indicates whether the chosen setting of frequency and
amplitude is tolerable.

The maximum peak-to-peak Amplitude is limited by the free capacity
of the chosen delay line.

The maximum Frequency of the periodic jitter source depends on the
chosen waveform. Refer to the technical specifications.

You can switch between sine, rectangular, or triangular jitter source
waveforms.

External Jitter Source Parameters

When you enable the External checkbox, the Jitter Setup function
reserves the remaining free capacity of the 200 ps delay line for the
signal applied to the Delay Ctrl Input.

The parameter window informs you about

• Amplitude (max)

• Voltage (max)

• Slope
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N O T E Even if the External jitter source is enabled, you can still add or change internal
jitter components. The range of the external jitter source is automatically updated
when you add, change, or turn off one of the internal sources.

This is the maximum jitter Amplitude that can be generated.

This is the maximum voltage that can be accepted. It would
generate the maximum jitter amplitude. Before connecting an
external jitter signal, always ensure that this signal does not exceed
the maximum voltage.

N O T E The Delay Control Input has an overvoltage protection. For details see “Delay Control
Input - Concepts” on page 93.

The Slope indicates the present relation between the voltage applied
and the resulting delay.

Sinusoidal Jitter Parameters

Sinusoidal jitter is independent from periodic jitter. It is generated
by modulating the clock that is used for data generation. It can
therefore not be enabled, if SSC is active.

Sinusoidal jitter is characterized by

• Amplitude (peak-to-peak)

• Frequency
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There is a dependency between frequency and acceptable amplitude.
A graph indicates whether the chosen setting of frequency and
amplitude is acceptable.

The maximum peak-to-peak Amplitude is limited by the chosen jitter
frequency.

Note that high-frequency sinusoidal data jitter can be generated by
the Periodic Jitter function or by applying an External jitter source.

This checkbox controls a switch. The Clock Output and Trigger
Output ports can be connected before or after the clock modulator
(the Subrate Clock Output always follows the clock modulator).

When this checkbox is enabled, the Clock Output provides and the
Trigger Output follows the modulated clock. When this checkbox is
disabled, the Clock Output and the Trigger Output ports provide
pure signals without sinusoidal jitter.

N O T E This checkbox has no effect when spread spectrum clocking is active. SSC takes
effect on all clock and trigger outputs.
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Interference Channel Setup

Interference Channel Setup - Concepts

The optional Interference Channel module can be plugged into the
instrument. For an introduction please refer to “Interference
Channel” on page 321.

This module is to be connected between the pattern generator's
Data Out port and the DUT. For installation instructions refer to
“Installing Hardware Options - Procedures” on page 391.

The Interference Channel simulates intersymbol interference (ISI).
It has backplane traces that conform to the Nelco 4000-6 FR4
specification.

The trace length can be set. According to the chosen length, the
module generates a reproducible amount of intersymbol
interference.

The Interference Channel provides also a sinewave generator and a
modulator. If sinusoidal interference (amplitude modulation) is
enabled, a minimum trace length is used.

Data can be input at P1 or P2 by connecting the pattern generator's
Data Out to P1 or P2, respectively.

The output is meant to be connected to the input of the DUT.

C A U T I O N The module has golden 2.4 mm connectors. Be sure to use the specific cables or
adapters. Improper connection can damage the module.

Interference Channel Setup - Procedures

To set up the Interference Channel module, click the corresponding
icon of the Jitter panel.
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To use the Interference Channel module:

1 Click the checkbox that enables the module.

2 Select a trace (refer to the technical specifications for details)

3 If desired, enable sinusoidal interference.

If you have enabled sinusoidal interference, enter appropriate
values for Frequency, Amplitude, and Mode.

Interference Channel Setup - Reference

The Interference Channel module must be enabled before it can be
used. This is done by clicking the corresponding checkbox.

When the Interference Channel is disabled, it establishes an almost
direct connection between P1 and P2. For details about the
minimum trace length refer to the technical specifications.

Trace Number

To specify the degree of intersymbol interference, select a suitable
trace length.

The user interface provides numbers from 1 to 9. The greater the
number, the longer is the trace.
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Sinusoidal Interference

To enable the addition of sinusoidal interference, press the
corresponding checkbox.

Set the parameters to desired values:

The peak-to-peak amplitude of sinusoidal interference must not
exceed a certain level (see the technical specifications).

The frequency range of sinusoidal interference is limited (see the
technical specifications).

One of four modes can be chosen for sinusoidal interference:

• Common: Requires that a differential data signal is generated and
connected to P1/ P1 or P2/ P2 of the Interference Channel.

In common mode, both components of the differential data signal
are amplitude-modulated with the same sinewave. This adds
common mode noise.

• Differential: Requires that a differential data signal is generated
and connected to P1/ P1 or P2/ P2 of the Interference Channel.

In differential mode, both components of the differential data
signal are amplitude-modulated, one with the normal sinewave,
the other with the inverted sinewave. This adds differential
noise.

• Single-ended normal: Modulates the data signal that is connected
to P1 or P2 of the Interference Channel.

• Single-ended complement: Modulates the data signal that is
connected to P1 or P2 of the Interference Channel.

Jitter Tolerance Characterization

Jitter Tolerance Characterization - Concepts

During a jitter tolerance characterization test, jitter is applied
sequentially at a number of frequency points in the frequency range
of interest.
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The receiver checks for the onset of transmission errors and
increments/decrements the jitter amplitude using a control
algorithm, re-testing for errors at one frequency point until the
target BER threshold is found. This is repeated for each subsequent
jitter frequency step to provide a plot of the DUT tolerance.

Green points (BER below limit) and red crosses (BER above limit)
are used to display the results.

After a measurement has exceeded the target BER or when moving
to the next frequency point, a measurement settling or relax time
can be applied. This allows the DUT to settle after changes and
before the next measurement; this is important because some
devices may need time to recover from error conditions caused by
jitter exceeding the margin during the search for the threshold.

The maximum jitter amplitude the Serial BERT  can generate is also
frequency dependent, as illustrated below.
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Sinusoidal jitter (SJ) and periodic jitter (PJ) with sinusoidal
characteristic are used for the test. Whether SJ or PJ is used
depends on the jitter frequency. SJ supports wide amplitude
variations up to some MHz. PJ supports narrow amplitude
variations over a wide frequency range. The measurement switches
automatically between the two sources.

When the measurement has finished, the jitter composition shown
in the Jitter Setup window is restored.

Target BER

The target bit error ratio must be specified.

The condition for moving from one jitter amplitude step to the next
can be set to

• numbers of received bits and errors

• a confidence level

Additionally, a relax time can be specified.

Number of received bits or errors

When numbers of received bits or errors are enabled, the
measurement proceeds with the next amplitude as soon as one of
the two numbers is reached.

But we are often dealing with very small tolerable bit error ratios,
10-12  and below. Measuring such a bit error ratio precisely (and just
for one single point) takes time.

Confidence level

The Jitter Tolerance Characterization measurement offers therefore
the option to set a level of confidence. This approach is based on
statistics.

Statistics tell us, for example, that if we receive 3 × 10 12 bits
without any error, the probability that the BER is below 10 -12  is
higher than 95 %. If an error occurred, more bits must be compared
to achieve the same confidence level. For details see “Explanation
of the Fast Total Jitter Measurement” on page 173.

The measurement proceeds with the next amplitude as soon as the
desired level of confidence is reached. Setting a confidence level
ensures that neither too few nor too many bits are captured.
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Relax time

If the measured BER is higher than the target bit error ratio, the
device under test may have lost synchronization. For devices that
need some time to recover from the situation, a relax time can be
specified. This time takes effect each time the BER limit has been
exceeded. The next BER measurement starts after this time has
elapsed.

Vertical Search Methods

You can specify that the jitter amplitude changes in linear steps
from maximum to minimum or vice versa. The step size is
adjustable.

You can also specify that the jitter amplitude changes in logarithmic
steps from maximum to minimum or vice versa. Minimum and ratio
are adjustable.

Alternatively, you can also specify one of two dynamic (binary)
search methods.

Searching Down/Up

Both search directions, upwards and downwards, are supported.
This helps to find out whether the device exhibits some degree of
hysteresis. The BER measured at a specific jitter amplitude may be
different if this amplitude is approached downwards or upwards.

When you search in downward direction (from maximum to
minimum), the test for one frequency stops as soon as the measured
BER falls below the target bit error ratio.

The following figure shows an example of a logarithmic search
downwards.
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The maximum amplitude (indicated by the dotted blue line) is given
by the capability of the instrument.

Searching downwards is usually faster than searching upwards,
because the measurement of a single point is finished as soon as
the BER is found to be above the limit.

When you search in upward direction (from minimum to
maximum), the test for one frequency stops as soon as the
measured BER exceeds the target bit error ratio.

Dynamic Search

If you perform the measurement over a wider frequency range, you
measure many useless points with the downwards/upwards
methods. To construct the tolerance curve, we actually need only
the two points between which the measured result turns from green
to red.

To reduce the measurement time without sacrificing precision, the
Jitter Tolerance Characterization measurement offers two additional
search methods:

When binary search is enabled, the measurement starts with the
maximum jitter amplitude (100 %).

If the result is red (measured BER higher than target BER), the
search goes downwards. The next amplitude is set to 50 %.
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If the new result is still red, the next amplitude is set to 25 %. But
if the new result is green, the search goes upwards, and the next
amplitude is set to 75 %.

Depending on the result, the search algorithm changes the direction
and continually halves the step size.

This continues until the specified accuracy (the final step size) is
reached.

Binary is the fastest search method. It approaches the amplitude of
interest from both sides. However, binary search can lead to
incorrect results if the device to be tested shows hysteresis.

This algorithm combines binary with linear downward search.

Extended binary search starts like the binary search. Depending on
the result, the search algorithm changes the direction and
continually halves the step size.

This continues until the specified coarse step size is reached. Then,
the coarse step size is maintained until a transition from green to
red is found. After that has happened, the algorithm changes the
direction and uses fine linear downward steps of specified size to
localize the transition precisely.

Extended binary search takes more time than binary search but
leads to reproducible results for devices with hysteresis.

Jitter Tolerance Characterization - Procedures

To access the Jitter Tolerance Characterization measurement, press
the corresponding icon of the Jitter panel.

To set up a Jitter Tolerance Characterization test, press the
Properties button.

This opens the Jitter Tolerance Properties dialog.
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Setting the Frequency Range

Choose Auto or Manual mode.

In Auto mode, the jitter frequencies are automatically calculated:

1 Enter the Start Frequency.

2 Enter the Stop Frequency.

Start and stop frequency define the measurement's frequency
range.

3 Set the Number of Steps between start and stop.

The Number of Steps yields a set of logarithmically equidistant
frequencies.

In Manual mode, the automatically calculated jitter frequencies can
be edited. You can also enter your own comma-separated list of
frequencies.

Setting the BER Limit

1 Set the Target Bit Error Ratio.

This defines whether a measured point is flagged green or red.
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2 Choose the Verification Method.

Setting a Confidence Level is generally recommended. See also
“Target BER” on page 338.

If you enable Absolute Bits/Errors, the measurement proceeds with
the next amplitude as soon as one of the two numbers is
reached.

3 If desired, set a Relax Time.

For details see “Relax time” on page 339.

Setting the Search Mode

1 Choose one of six search modes:

– Downwards linear

– Downwards logarithmic

– Upwards linear

– Upwards logarithmic

– Binary search

– Extended binary

For details refer to “Vertical Search Methods” on page 339.
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2 Accept or change the related parameters.

Before Running the Test

For DUTs that require a training sequence it is essential to prevent
clock loss at the beginning or end of the test. To avoid clock loss,
the sinusoidal jitter component has to be enabled. Since the
sinusoidal jitter for the test is generated internally, the jitter
amplitude must be set to zero:

1 In the Jitter window, press the Jitter Setup Icon.

This opens the Jitter Setup window.

2 Enable jitter generation. Press the respective checkbox.

3 Activate Sinusoidal jitter.
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4 Set the jitter amplitude to 0 UI.

The device can now be tested without clock loss.

Running the Test

Once you have specified the Frequency, BER, and Search criteria,
press the Start button to run the test.

The bar in the lower right-hand corner of the screen shows the
progress.

You can also abort the test at any time by pressing the Abort button.

When the measurement has finished, the jitter composition shown
in the Jitter Setup window is restored.

Jitter Tolerance Characterization - Reference

Jitter tolerance characterization determines the actual jitter levels
where the device under test can no longer maintain a desired BER.

Frequency Specification

You can choose Auto or Manual mode.

In Auto mode, the jitter frequency is automatically swept from Start
Frequency to Stop Frequency.

• Start Frequency: This is the minimum and first jitter frequency to
be generated. It determines the left-hand border of the graphical
result display.

• Stop Frequency: This is the maximum and last jitter frequency to
be generated. It determines the right-hand border of the
graphical result display.

The measurement always includes the start and stop frequencies.
The frequency scale is logarithmic.

• Number of Steps: The Number of Steps between start and stop defines
the test frequencies.
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To determine the individual test frequencies, an algorithm
divides the horizontal logarithmic scale into a set of
logarithmically equidistant frequencies.

In Manual mode, you can edit the automatically calculated
frequencies. You can also enter a single frequency or your own list
of frequencies. For example, you can jump between low and high
jitter frequencies.

Enter the frequencies in Hz, separated by commas, for example:

2e4, 1.75e6, 6.334e5, ...

BER Specification

The Target Bit Error Ratio defines the required BER. The jitter tolerance
curve is constructed from the points where the measured BER
crosses the Target Bit Error Ratio.

The Verification Method defines under which circumstances the
measurement proceeds from one jitter amplitude to the next. You
can choose between two Verification Methods:

Setting a Confidence Level is generally recommended. This ensures
that neither too few nor too many bits are captured. See also
“Target BER” on page 338.

If you enable Absolute Bits/Errors, the measurement proceeds to the
next jitter amplitude as soon as either the number of received bits
or the number of errors is reached.

N O T E Ensure that you capture a number of bits that suffices to verify (with the desired
probability) that a measured point has a BER below the Target Bit Error Ratio.

This is the wait time that takes effect after the measured BER is
higher than the target BER. It allows the DUT to recover from the
situation. The unit is seconds. The next measurement starts after
that time.

Search Specification

On this page of the Jitter Tolerance Properties dialog, you specify how
the measurement proceeds upwards or downwards from one
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measured point to the next. The chosen method impacts the
measurement duration. The specified parameters influence both
measurement duration and precision.

You can choose one of six search methods:

• Downwards linear

• Downwards logarithmic

• Upwards linear

• Upwards logarithmic

• Binary search

• Extended binary

For a description of these methods refer to “Vertical Search
Methods” on page 339.

For linear search, you can set the step size.

• Downwards linear starts from the maximum (which depends on the
jitter frequency). A step size of 100 mUI, for example, may result
in a sequence of 1000 UI, 999.9 UI, 999.8 UI, and so on.

The test for one frequency stops when the BER limit is met or
zero amplitude is reached.

• Upwards linear starts from the minimum. A step size of 100 mUI,
for example, will result in a sequence of 0.1 UI, 0.2 UI, 0.3 UI,
and so on.

The test for one frequency stops when the BER limit is exceeded
or the maximum amplitude is reached.

For logarithmic search, you can set the minimum amplitude and the
ratio. The ratio is the factor by which the present amplitude value
is multiplied to calculate the next amplitude.

• Downwards logarithmic starts from the maximum (which depends
on the jitter frequency). A ratio of 0.666, for example, may result
in a sequence of 1000 UI, 666 UI, 444 UI, and so on.

The test for one frequency stops when the BER limit is met or
the specified minimum amplitude is reached.

• Upwards logarithmic starts from the specified minimum amplitude.
A ratio of 1.5, for example, may result in a sequence of 0.1 UI,
0.15 UI, 0.225 UI, 0.3375 UI, and so on.

The test for one frequency stops when the BER limit is crossed
or the maximum amplitude (which depends on the jitter
frequency) is reached.
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For binary search, you can set the accuracy.

This defines the minimum jitter amplitude step size. The test for
one frequency stops when this step size is reached.

For a description of this method refer to “Binary search” on page
340.

For extended binary search, you can set the coarse and fine
accuracy. The test for one frequency stops when the BER limit is
crossed with fine accuracy amplitude steps.

For a description of this method refer to “Extended binary search”
on page 341.

Jitter Tolerance Compliance

Jitter Tolerance Compliance - Concepts

The Jitter Tolerance Compliance test is used to ensure that the jitter
tolerance of the device under test complies with a certain standard.

N O T E The Jitter Tolerance Compliance measurement is a software option that requires a
license. For details on how to obtain and install such licenses refer to “Installing
Software Licenses - Procedures” on page 390.

Measurement Principle

The Optical Internetworking Forum (OIF) and other institutions
have proposed and published standards for testing the performance
of data receivers and receiver circuits in the presence of jitter.

These standards prescribe the required jitter tolerance over jitter
frequency. The jitter tolerance for each frequency bin is defined by
a jitter amplitude (normalized to the bit rate and hence specified in
Unit Intervals – UI) and a BER threshold which must not be
exceeded.

A simple example is shown in the figure below:
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Some standards are more detailed, as illustrated in the following
figure:

During a jitter tolerance compliance test, jitter with the specified
jitter amplitude is sequentially applied at a number of frequency
points in the frequency range of interest.

The receiver checks for transmission errors and measures the bit
error rate.

The graphical display shows the results.
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A green circle indicates that the BER at this point did not exceed
the target BER. A red cross indicates that the BER at this point
exceeded the target BER. If this happens, the test is marked as
“failed”.

A table below the graph provides details about the measurement
conditions like date/time, data pattern, bit rate, and added jitter
components.

The measurement results for each point can also be exported as a
numerical list in text format.

The maximum jitter amplitude the Serial BERT  can generate is also
frequency dependent, as illustrated below.

The standards demand and the measurement generates jitter with
sinusoidal distribution.
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In terms of the Serial BERT , sinusoidal jitter (SJ) and periodic jitter
(PJ) with sinusoidal characteristic are used for the test (see also
“How the N4903 Generates Jitter” on page 319).

Whether SJ or PJ is used depends on the jitter frequency. SJ
supports wide amplitude variations up to some MHz. PJ supports
narrow amplitude variations over a wide frequency range. The
measurement switches automatically between the two sources.

The measurement cannot be executed if jitter generation is totally
disabled. SJ and PJ may be enabled or disabled.

N O T E SJ and SSC (Spread Spectrum Clock, option J11) operate mutually exclusive. You
cannot run a Jitter Tolerance Compliance measurement while the SSC is active.

If desired, you can add additional jitter of random, external, or
bounded uncorrelated origin to the automatically generated jitter.

When the measurement has finished, the jitter composition shown
in the Jitter Setup window is restored.

Target BER

The target bit error ratio must be specified.

The condition for moving from one jitter amplitude step to the next
can be set to

• numbers of received bits and errors

• a confidence level

Additionally, a relax time can be specified.

Number of Received Bits or Errors

When numbers of received bits or errors are enabled, the
measurement proceeds with the next frequency as soon as one of
the two numbers is reached.

But we are often dealing with very small tolerable bit error ratios,
10–12 and below. Measuring such a bit error ratio precisely (and just
for one single point) takes time. Therefore, the measurement
provides the option to set a confidence level.
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Confidence Level

The Jitter Tolerance Compliance measurement offers the option to
set a level of confidence. This approach is based on statistics.

Statistics tell us, for example, that if we receive 3 × 10 12 bits
without any error, the probability that the BER is below 10 –12 is
higher than 95 %. If an error occurred, more bits must be compared
to achieve the same confidence level. For details see “Explanation
of the Fast Total Jitter Measurement” on page 173.

The measurement proceeds with the next frequency and jitter
amplitude as soon as the desired level of confidence is reached.
Setting a confidence level ensures that neither too few nor too many
bits are captured.

Relax Time

Before the measurement proceeds to the next frequency bin, a
measurement settling or relax time can be applied.

This allows the DUT to recover in case it has lost synchronization
due to an excessive high bit error rate. The next BER measurement
starts after this time has elapsed.

About Jitter Tolerance Standards

Every Jitter Tolerance Compliance test requires a standard. You can
use one of the predefined standards. Additionally, you can define
and use your own "user-defined" standard.

In terms of the Serial BERT , a standard is represented by a
sequence of paired numbers. Each pair consists of a frequency value
(Hz) and the associated jitter amplitude value (UI).

Also part of a standard specification are the standard’s name and
descriptive text.

Predefined Standards

The Jitter Tolerance Compliance option provides a number of
predefined standards.

Predefined standards specify:

• Jitter frequency range

The jitter frequency range may depend on the bandwidth of the
receiver being tested.
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• Bit rate range

Some standards define the jitter tolerance curve as a function of
the bit rate. If this is the case, the edges of the jitter tolerance
curve are shifted towards higher frequencies if the bit rate is
increased, and vice versa.

• Jitter amplitudes in defined sections of the jitter frequency range

The slopes between adjacent sections may be double logarithmic
(shown as straight lines in the double logarithmic display) or are
calculated according to certain algorithms.

• Data pattern to be used

This can be, for example, a certain PRBS-polynomial or a
specific test pattern.

• Signal voltage range

Most standards refer to specific devices.

• Jitter composition

A standard may prescribe that additional jitter components with
specific amplitudes have to be added.

The standards provided by Agilent can be chosen from a list of
predefined standards.

Every standard is accompanied by a description that states its
specific requirements, like applicable bit rates, patterns to be used,
and so on.

N O T E Before running the test, set up the instrument to ensure that these requirements
are met. For details on the recommendations and their dependencies see
Description in the “Standard Specification” on page 363.

If a standard specifies a tolerance curve that is bit rate dependent,
the curve is automatically adapted to the present bit rate. If you
change the bit rate, the curve is automatically recalculated.

The standards provided by Agilent cannot be edited locally.

User-Defined Standards

You can create your own standard in a text file.

A user-defined standard consists of a paired list of numbers.
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Each pair specifies a jitter frequency (Hz) and the associated jitter
amplitude (UI), for example:

2e3, 110<cr><lf>
3.24e4, 50<cr><lf>
71.234e4, 10<cr><lf>
10.654e6, 0.2<cr><lf>
18.333e6, 0.2<cr><lf>
<cr><lf> stands for <carriage return><line feed> or just <Return>.

N O T E The list must be sorted according to the frequencies in ascending order. The jitter
amplitude for a given frequency must not exceed the instrument’s capability.

The list of predefined standards has a Browse option that allows
you to identify and load such a text file.

If you have selected a text file, you can append it to the list of
predefined standards. You can assign a name to your standard and
add a description. Then, your standard appears directly in the list
like the standards provided by Agilent, and you don’t have to
browse any more.

Your standard is stored in a file with the suffix .jcs. This is still a
text file which can be edited. The directory is C:\N4903A
\JTolStandards.

User-defined standards are taken “as is”. That means, neither the
bit rate nor any other conditions are taken into account.

The instrument uses double logarithmic interpolation to generate
the jitter amplitudes between two successive amplitude values. This
is indicated by linear slopes in the double logarithmic graph.

Special Features

You can freely specify the jitter frequency range and the number of
points to be measured. You can also adjust the frequency range and
the point positions to the loaded standard.

In addition, you can add a margin to the standard.

Jitter Frequency Test Points

You can specify the jitter frequency range to be used for the test,
from 1 kHz up to some hundred MHz. You can hence measure only
a portion of the standard or points outside the standard. Points
outside the standard will always pass the test.
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If a standard prescribes a certain range, for example from 2 kHz to
20 MHz, you can select a checkbox to adjust the jitter frequency
range to the loaded standard.

You can also specify the number of points to be measured. By
default, the measurement points are evenly distributed along the
logarithmical frequency axis.

You may wish to measure the BER exactly at those frequency points
where the specified jitter amplitude changes. By selecting a
checkbox, the distribution of the measurement points can be
adapted to the loaded standard, and the BER at the points of
interest will be measured.

Margin

It is possible to increase the jitter amplitudes of any standard by
adding a margin. This increases the stress on the device under test.

The margin is set in percent. A margin of 25%, for example, has the
effect that each amplitude value is multiplied by 1.25.

The following figure shows an example of a measurement with a
margin of 50% and sample point adaptation.
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Jitter Tolerance Compliance - Procedures

To access the Jitter Tolerance Compliance measurement, press the
corresponding icon of the Jitter panel.

To set up a Jitter Tolerance Compliance test, press the Properties
button.

This opens the Jitter Tolerance Properties dialog.

Setting the Standard

Select either a predefined standard or load a standard from a text
file.

1 Switch to the Standard tab.

A preview and a short description of the selected standard are
displayed.

2 To load a different standard, open the list.
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The list contains all predefined standards, including user-defined
standards. User-defined standards are preceded by an asterisk
(*).

3 Select one of the predefined standards.

or

Press Browse... to load your own standard, stored in a text file.

This opens a dialog box which allows you to load a file. By
default, the browser searches for files with the suffix .jcs, but
you can access any file.

N O T E The required file format is described in detail in “User-Defined Standards” on page
353.

4 Press OK to load the data temporarily. Use this option, for
example, if the jitter-frequency list of your standard is still
subject to change.

or

Press Apply to Predefined Standards to load the data and add the
standard to the list of predefined standards. For details see
“Adding a User-Defined Standard” on page 361.

If you wish to increase the stress on the device under test, you can
enter a Margin.
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T I P With the Auto Frequencies checkbox, you can adjust the test frequencies
automatically to the selected standard. This is described belowin “Setting the
Frequency Range” on page 358.

Setting the Frequency Range

You can freely specify the jitter frequency range and the number of
points to be measured. By default, the test points are suitably
distributed within the frequency range – according to the loaded
standard. But you can change the distribution according to your
needs.

1 Switch to the Frequency tab.

The measurement's frequency range and the list of test
frequencies are displayed.

If the Auto Frequencies checkbox on the Standard tab is selected,
start and stop frequency are by default set according to the
selected standard.

N O T E When you change the selection state of the Auto Frequencies checkbox, press
Apply on the Standard tab to accept the change and to update the frequency list.

2 If desired, change the default values. For example, if only a
certain frequency range has to be tested:
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Enter the Start Frequency and the Stop Frequency.

3 Set the Number of Steps between start and stop.

T I P When Auto Frequencies is activated, the Number of Steps can also be set on the
Standard tab.

The resulting frequency list depends on the setting of the Auto
Frequencies checkbox on the Standard tab:

• Checkbox is selected (default):

The list yields frequencies that are recommended for the selected
standard, for example the edge frequencies.

• Checkbox is not selected:

The list of frequencies yields a set of logarithmically equidistant
frequencies.

In Manual mode, the automatically calculated jitter frequencies can
be edited. You can also enter your own comma-separated list of
frequencies.

N O T E If the frequency list is edited in Manual mode, the Auto Frequencies checkbox on
the Standard tab is automatically deselected.

Setting the BER Limit

1 Set the Target Bit Error Ratio.

This defines whether a measured point is flagged green (test
passed) or red (test failed).
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2 Choose the Verification Method.

Setting a Confidence Level is generally recommended. See also
“Target BER” on page 351.

If you enable Absolute Bits/Errors, the measurement proceeds with
the next amplitude as soon as one of the two numbers is
reached.

3 If desired, set a Relax Time.

For details see “Relax Time” on page 352.

Before Running the Test

Before running the test, set up the instrument to ensure that the
requirements of the selected standard are met. Recommended test
pattern and additional jitter are displayed in the standard's
description field on the Standard tab of the Jitter Tolerance Properties
dialog.

For details on the recommendations and their dependencies see
Description in the “Standard Specification” on page 363.

For DUTs that require a training sequence it is essential to prevent
clock loss at the beginning or end of the test. To avoid clock loss,
the sinusoidal jitter component has to be enabled. Since the
sinusoidal jitter for the test is generated internally, the jitter
amplitude must be set to zero:
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1 In the Jitter window, press the Jitter Setup Icon.

This opens the Jitter Setup window.

2 Enable jitter generation. Press the respective checkbox.

3 Activate Sinusoidal jitter.

4 Set the jitter amplitude to 0 UI.

The device can now be tested without clock loss.

Running the Test

Once you have specified the Standard, Frequency, and BER, press the
Start button to run the test.

The bar in the lower right-hand corner of the screen shows the
progress.

You can also abort the test at any time by pressing the Abort button.

Managing User-Defined Standards

User-defined standards are saved in the folder C:\N4903A
\JTolStandards. The extension is .jcs.

To add a user-defined standard to the list:

1 Press the Properties button and switch to the Standard tab.

2 Select the last entry in the list: Browse….

This opens a dialog box which allows you to load a file.
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N O T E The file must contain a comma-separated list of frequencies and jitter values. The
file format is described in detail in “User-Defined Standards” on page 353.

3 Select the desired file and press Open.

The Properties of Imported Standard dialog is displayed.

4 Enter a Name and Description for the standard.

5 Press Apply to Predefined Standards.

The standard is added to the list of predefined standards. In the
list, user-defined standards are preceded by a "*".

To delete a user-defined standard from the list:

• Delete the corresponding file in the C:\N4903A\JTolStandards
directory.

Managing Measurement Results

If you want to store the measurement results for later use, you can
either save them as an .jcp file (to be opened in the user interface)
or as a .txt file for spreadsheet applications.

Saving Measurements

To save a measurement as an .jcp file for later use in the user
interface:

1 After your measurement has finished and the results are
displayed, select Save Measurement from the File > Save menu.

2 Select a proper file name and location and press the Save button.

Exporting Measurement Results

To export the measurement results into a .txt file for later use in
external spreadsheet applications:

1 After your measurement has finished and the results are
displayed, select Export Data from the Analysis menu.

2 In the Save as dialog box, select the path and file name for
the .txt file.

3 Press Save to export the data to the specified destination.
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Loading Measurements

To load previously saved measurements:

1 Select Open Measurement from the File > Open menu.

2 Use the file dialog box to locate the desired .jcp file and press
Open to load the measurement.

Accessing Comment and Condition Text

To access the comment or condition text of a measurement:

• Double-click Modify Comment below the graphical display.

This opens the Jitter Measurement Comment dialog box.

You can enter a comment. The condition is automatically added by
the system.

You can also read the full comment or condition in case only part
of the text is displayed in the result table.

Jitter Tolerance Compliance - Reference

Jitter Tolerance Compliance determines whether a device under test
maintains a desired BER at defined jitter levels. The jitter levels can
be derived from predefined standards.

Standard Specification

The drop-down list contains all predefined standards, including
user-defined standards. The shape of the selected standard is
shown in the preview area. The frequency range and the jitter
amplitude range of the standard is given in the preview. A
description is displayed at the bottom of the Standard tab.

The last entry in the list is Browse…. Select this entry to load a file
that contains a user-defined standard. See “Setting the Standard”
on page 356 for details.

To aggravate test conditions, the standard's test jitter amplitude can
be increased by Margin percent. The display shows a black line for
the standard and a green line for the new jitter amplitudes.
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Select the Auto Frequencies checkbox to set frequencies that are
recommended for the selected standard. This list contains, for
example, the edge frequencies of the standard.

T I P You can change single frequency points. Press Apply to accept the selected Auto
Frequencies setting and switch to the Frequency tab. In Manual mode, you can
edit the automatically calculated frequencies. If you do so, the Auto Frequencies
checkbox is automatically deselected.

Enter the number of test frequencies ( Number of Steps) either on this
tab, or on the Frequency tab.

This is the creator's description of the selected standard. Standards
provided by Agilent are described by the following items:

T I P Use the scroll bar if not all information is displayed.

• Document that describes the standard in detail. The document
name usually indicates the date or revision of the standard.

• Recommended settings for the test pattern like Bit Rate range,
Pattern types and voltage level ranges:

– Voltage Level from Standard: This is the peak-to-peak differential
input level range for the DUT as given in the standard.

– Voltage Level at PG (recom): This is the recommended output
level at the pattern generator to achieve the minimum voltage
Level from Standard.

N O T E This recommendation depends on the simulated intersymbol interference (ISI): The
minimum voltage Level from Standard is only met if the trace to simulate the ISI is
selected as in the description item Additional Jitter. Other settings of the ISI can
change the DUT's input level up to four times.

Consider these recommendations when setting up the pattern
generator (see “Setting up the Pattern Generator - Concepts ” on
page 69).

• Additional Jitter components you have to add for the compliance
test if the standard requires non-sinusoidal jitter components,
such as random jitter (RJ) or intersymbol interference (ISI).
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N O T E The recommended ISI setting is only valid, if both pattern and bit rate are set
according to the standard's recommendation (see the corresponding description
items).

Consider these recommendations when composing the desired
total jitter (see “Jitter Setup - Procedures” on page 324). Note
that the sinusoidal jitter is automatically generated and no setup
is required.

Frequency Specification

You can choose Auto or Manual mode.

In Auto mode, the jitter frequency is automatically swept from Start
Frequency to Stop Frequency.

• Start Frequency: This is the minimum and first jitter frequency to
be generated. It determines the left-hand border of the graphical
result display.

• Stop Frequency: This is the maximum and last jitter frequency to
be generated. It determines the right-hand border of the
graphical result display.

The measurement always includes the start and stop frequencies.
The frequency scale is logarithmic.

• Number of Steps: The Number of Steps between start and stop defines
the test frequencies.

The location of the individual test frequencies depends on the
setting of the Auto Frequencies checkbox on the Standard tab:

– Checkbox is selected (default):

The list yields frequencies that are recommended for the
selected standard, for example, the edge frequencies.

– Checkbox is not selected:

The list of frequencies yields a set of logarithmically
equidistant frequencies.

N O T E Alternatively, you can set the Number of Steps on the Standard tab.

In Manual mode, you can edit the automatically calculated
frequencies. You can also enter a single frequency or your own list
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of frequencies. For example, you can jump between low and high
jitter frequencies.

Enter the frequencies in Hz, separated by commas, for example:

2e4, 1.75e6, 6.334e5, ...

T I P Press Apply if you want to keep the setting of frequencies for the current test run,
but if you still want to change the standard or BER specification. If all properties are
set as desired, press OK.

BER Specification

The Target Bit Error Ratio defines the pass/fail criteria of the jitter
tolerance compliance test. For every test point along the standard
curve, the test is failed if the measured BER lies above the Target
Bit Error Ratio.

The Verification Method defines under which circumstances the
measurement proceeds from one frequency to the next. You can
choose between two Verification Methods:

Setting a Confidence Level is generally recommended. This ensures
that neither too few nor too many bits are captured. See also
“Target BER” on page 351.

If you enable Absolute Bits/Errors, the measurement proceeds to the
next jitter frequency as soon as either the number of received bits
or the number of errors is reached.

N O T E Ensure that you capture a number of bits that suffices to verify (with the desired
probability) that a measured point has a BER below the Target Bit Error Ratio.

The relax time allows the DUT to recover in case it has lost
synchronization due to an excessive high bit error rate. The next
BER measurement starts after this time has elapsed.

Explanation of the Results

Additionally to the graphical results, the measurement provides
some information below the graph. You can also export the results
to a .txt file.
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The following information helps you to interpret and document the
test:

• Result of the test (passed or failed).

• Date and Time when the test was finished.

• Margin that was set for the test.

• Further test Conditions like the selected test pattern and
additional jitter components.

• Double-click  Modify Comment, to enter a Comment for every test.

T I P If not the whole information is displayed in the Condition/Comment column, this
is indicated by "…". Double-click Modify Comment to see the complete text in a
separate window.

If you want to use the measurement results with other applications,
you can export the data to a file via Analysis > Export Data....

The contents of the resulting file may look as follows:

Jitter Tolerance Measurement 4/10/2006 12:12:37 PM
Standard: XAUI
Margin: 0 %
Condition: 2^23-1 PRBS@2.488 Gb/s; 
Comment: 
Passed Points: (frequency; amplitude; number of bits; 
bit error rate; number of errors; result)
1000; 8.5; 3013355404; 0; 0; passed;
1790.61312892; 8.5; 3015843721; 0; 0; passed; 
3206.295377462; 8.5; 3015843721; 0; 0; passed; 
5741.234598079; 8.5; 3015843721; 0; 0; passed; 
10280.33004753; 8.5; 3015843725; 0; 0; passed; 
18408.09395274; 8.5; 3013355401; 0; 0; passed; 
22100; 8.5; 3015843721; 0; 0; passed; 
32961.77471018; 5.69902566387; 3015843724; 0; 0; passed; 
59021.78654856; 3.182723041524; 3015843725; 0; 0; passed; 
105685.1858862; 1.777448735363; 3013355405; 0; 0; passed; 
189241.2813802; 0.9926481084359; 3013355401; 0; 0; passed; 
338857.922973; 0.5543621301573; 3015843723; 0; 0; passed; 
606763.4457141; 0.3095934689654; 3015843724; 0; 0; passed; 
1086478.592045; 0.1728980224511; 3015843725; 0; 0; passed; 
1875000; 0.1; 3013355405; 0; 0; passed; 
1945462.831206; 0.1; 3015843721; 0; 0; passed; 
3483571.287383; 0.1; 3015843721; 0; 0; passed; 
6237728.482718; 0.1; 3015843722; 0; 0; passed; 
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11169358.5158; 0.1; 3015843771; 0; 0; passed; 
20000000; 0.1; 3013355409; 0; 0; passed; 
Failed Points: (frequency; amplitude; number of bits; 
bit error rate; number of errors; result)
This file can be imported into spreadsheet applications such as
Microsoft Excel, for example. Use the semicolons as delimiters for
the rows or columns.

T I P The comment can be entered with the Modify Comment button below the graphical
result view.
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8 
Solving Problems

Solving Problems - Concepts

This section provides information that can help you to troubleshoot
the Serial BERT  in case any problems occur.

Setup Problems

Setup Problems - Concepts

You may run into the following problems when setting up the Serial
BERT.

Front Panel not Working

If the front panel is not working and a hardware wizard calls on
you to install the driver for an unknown USB device, cancel the
hardware wizard and reboot the instrument.

This might happen if the front panel controller is not initialized
correctly at boot up.

Incorrect Error Detector Input Voltages

The error detector's protection circuit disconnects the input
amplifier if the incoming signal does not lie within the defined
input range. In this case, a dialog box will open that lets you define
the input range, sample point 0/1 threshold, termination voltage
and state. When you click OK, the input amplifier will be reenabled.
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If the input signal is still out of range for any of these parameters,
the error detector will be immediately disconnected again.

Error Detector Does not Count Bits

If the analyzer does not count any bits, press Sync Now.

This might happen after bad glitches at the clock input.

DLL Alignment Failed

If an error message containing the text "... DLL alignment failed ..."
is displayed, increase or decrease the bit rate by 1bit/s.

See “Bit Rate - Procedures” on page 85 for details on setting the
bit rate.

The instrument provides several error indicators to help you
identify setup problems.

The following list contains possible causes for setup problems,
sorted from the most severe to the least severe:

PG CLK LOSS

This indicator turns red when no clock signal is detected at the PG
Clock In port.

• External Clock Input is selected and the external clock is off or not
connected.

• Your cables or the external clock is faulty.

ED CLK LOSS

This indicator turns red when no clock signal is detected at the ED
Clock In port.

BERT connected looped back or to your device:

• The PG clock output is off or not connected.

• There is no connection to the ED clock input.
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• Your cables are faulty.

BERT connected to your device:

• There is no clock signal from your device.

• Your device is faulty.

DATA LOSS

This indicator turns red when no data signal is detected at the ED
Data In port.

BERT connected looped back or to your device:

• The PG data output is off or not connected.

• There is no connection to the ED data input.

• The 0/1 threshold is not in the eye limits of the incoming data
signal. Use Auto Align or select Avg 0/1 Threshold.

• Your cables are faulty.

BERT connected to your device:

• There is no data signal from your device.

• Your device is faulty.

SYNC LOSS

This indicator turns red when the measured BER is higher than the
sync threshold.

BERT connected looped back or to your device:

• The sampling point is incorrect. Use Auto Align.

• The data pattern is inverted. Toggle Data Inverted or use Auto
Align.

• The ED pattern does not match the incoming data pattern. Make
the ED track the PG pattern, or set ED and PG patterns
independently the same.

• Patterns have lost sync in manual sync mode. Use Auto Align, Sync
Now, or select Auto Sync mode.

BERT connected to your device:

• The data eye is very small. If Auto Align does not correct sync
loss, set the 0/1 threshold manually.

• Your device has inverted the data pattern. Toggle Data Inverted or
use Auto Align.

Solving Problems 8

Agilent J-BERT N4903 High-Performance Serial BERT 371



• Your device has changed the data pattern. Set the ED and PG
patterns separately.

• If the fundamental BER of your device is higher than the sync
threshold BER, you can select a higher sync threshold BER.

Error

This indicator turns red when errors are detected. View the BER bar
or BER Results to see the nature of the errors.

BERT connected looped back or to your device:

• Stable errors caused by the error add function: Turn error add
off.

• Stable errors caused by false sync: Select a lower sync threshold
BER.

• Variable and high errors may be caused by faulty connectors/
cables.

BERT connected to your device:

• Stable or variable errors can also be caused by your device.
Correct the problems with your device.

• If the problems are not clear, then accumulate measurement data
and analyze results.

Measurement Problems

Measurement Problems - Concepts

Accumulated measurements can help you determine the cause of bit
errors. Bit errors can be caused by a variety of problems. In
addition, instrument settings can affect how errors are measured
and displayed. The sync mode setting has the greatest effect.

8 Solving Problems

372 Agilent J-BERT N4903 High-Performance Serial BERT



Some phenomenon you might observe with the possible causes are
listed below:

Constant Errors (More Errored 0's than 1's)

A hardware failure may have occurred in your device. The errors
became constant at the point of failure.

Digital circuitry often has parallel architecture in which data lines
are multiplexed in stages into one serial data line. This example
assumed that a PRBS pattern was going through digital circuitry
that had a total multiplexing ratio of 256:1. The constant errors
were produced from one data line that became "stuck" high in the
first stage of multiplexing.

The data line that was "stuck" high produced errored 0's 50% of the
time with the PRBS pattern. Therefore, at the serial rate, one out
of every 512 bits was measured as an errored 0 (1/256 * 50% =
1/512). In addition, the inverse of the error ratio was a multiple of
2.

In this example, the analyzer could have been in manual sync or
auto sync mode with 1E-2 as the sync threshold BER. If the sync
mode settings were different, the results would not have been
measured and displayed in the same way.

The BER in this example (approx. 2E-3) was greater than the
default sync threshold BER (1E-3). If the analyzer was in the
default auto sync mode, it would have activated the synchronization
functions and continually shifted the position of the reference
pattern in an attempt to find a lower BER.
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N O T E The accumulated results table displays the total accumulated error ratio. Look in
the measurement log file to see the error ratio during the period of constant errors.

The error ratio during periods of constant errors was 0.00195313.
This corresponds to 1.953E-3.

Random Errors

Random errors may have been caused by a noisy waveform. Noise
can be caused by bad cables or connectors.

The output of your device may contain errors due to noise, although
a noisy waveform is not present at the output. The noise may
originate somewhere else within your device or system, causing
random bit errors to be passed on to other components. Therefore,
your device may have a good output waveform and still transmit
random bit errors.
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Sync Loss Seconds

The sync loss seconds in this example may have been caused by
high bursts of errors or momentary clock loss. The clock signal from
a clock recovery module may have momentarily ceased. To confirm
periods of momentary clock loss, check the measurement log file.

In this example, the analyzer was in auto sync mode. If the analyzer
was in manual sync mode, the results would not have been
measured and displayed in the same way.

When the clock signal resumed, the received and ED reference
patterns could only be aligned if the synchronization functions were
activated. In manual sync mode, this would not have happened
because synchronization functions are only activated manually.

In manual sync mode, sync loss and high BER would have been
measured from the start of the momentary clock loss to the end of
the accumulation period.

Data in this measurement log file confirms that there were periods
of momentary clock loss.
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Using the Measurement Log to Identify Problems

Measurement Logs are saved as CSV (comma separated variable)
files. Follow the steps below to view results in a measurement log
file:

1 Copy the measurement log file from the analyzer to your PC. By
default, log files are saved in the folder C:\N4903A\log.

2 Open a spreadsheet application on your PC.

3 Import the measurement log file. If your application has an
import wizard, you may need to indicate that data is delimited
with commas.

4 Once the file has been imported, you may need to resize
columns. The imported log file should appear similar to the
following example.

N O T E During measurement logging, the Serial BERT logs data in ten-second intervals.
Your log file may be missing up to the last ten seconds of data. To avoid this
condition, accumulate for 10 seconds longer than desired.
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You can view and analyze the following information in the
measurement log file:

Table 27

Instantaneous Cumulative

BIT COUNT BIT COUNT Cumulative

ERROR COUNT ERROR COUNT Cumulative

ERROR RATIO ERROR RATIO Cumulative

ERRORED 0 COUNT ERRORED 0 COUNT Cumulative

ERRORED 0 RATIO ERRORED 0 RATIO Cumulative

ERRORED 1 COUNT ERRORED 1 COUNT Cumulative

ERRORED 1 RATIO ERRORED 1 RATIO Cumulative

SYNC LOSS ERROR SECONDS Cumulative

PG CLOCK LOSS ERROR FREE SECONDS Cumulative

ED CLOCK LOSS ERROR DECISECONDS Cumulative

DATA LOSS ERROR FREE DECISECONDS Cumulative

SYNC LOSS SECONDS Cumulative

BURST STATUS Cumulative

BURST SYNC RATIO Cumulative

TOTAL BURST COUNT Cumulative

BAD BURST COUNT Cumulative
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Other Messages

Other Messages - Concepts

This section covers additional error messages that may occure when
working with the Serial BERT .

Overheat Protection

The Serial BERT  is equipped with an overheat protection function
to prevent it from overheat damage.

If the temperature of the error detector or pattern generator
exceeds a certain threshold, the Serial BERT  displays the following
warning message , respectively :

N O T E The temperature level is not yet critical. However, the Serial BERT may be damaged
if operation is continued. The message is intended to inform you to take the
appropriate measures. Save your current instrument settings, shut down the Serial
BERT and let it cool down before operating it again.

If the Serial BERT  is operated at this state for a longer time, the
temperature may reach a critical level. In this case, the following
message is displayed:
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The Serial BERT  will be shut down, your instrument settings will
not be saved.

If the Serial BERT  has indicated overheating, do the following:

• Shut down the instrument and let it cool (45minutes to 1hour).

• Reduce the environmental temperature.

• Make sure that the fans are running and the ventilation holes
are not blocked.

• If the problem continuously recurs, contact Agilent support.

C A U T I O N Do not operate the Serial BERT before it has cooled down again. Otherwise your
instrument may get damaged.

When you are switching on the Serial BERT  after it was shut down
due to a temperature error, you will see a message box that informs
you about which module caused the problem.
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9 
Customizing the Instrument

Customizing the Instrument - Concepts

The Serial BERT  provides various utilities for adjusting the
instrument to your personal preferences.

Restoring the System

Restoring the System - Procedures

Although any bootable diskette created on another PC with either
Windows 98 or Windows XP can be used for emergency repair of
your system, we strongly recommend to create the bootable diskette
at your system.

Store the diskette on a safe place and use it to restore the operating
system to its factory state.

C A U T I O N When the operating system is restored, all personal settings, programs and user
data will be lost. Make sure that important data is saved to external media before
restoring the system.

How to Create a Bootable Diskette

1 Minimize the Serial BERT  user interface window by selecting
Minimize GUI from the Utility menu.

2 Place a blank diskette in the instrument's floppy disk drive.
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3 Click Start, and then click My Computer.

4 In the file browser select the symbol for drive A:.

Do not open the drives folder, only select it.

5 Select Format in the File menu.

6 Make sure that the title of the dialog box is Format Floppy (A:).

C A U T I O N Do not format any other drive but the floppy drive.

7 Click Create an MS-DOS startup disk.

8 Click Start and follow the instructions.

N O T E The MS-DOS startup disk only allows the system to boot into an MS-DOS prompt.
The disk contains no additional tools and is not a substitute for Windows XP Setup
Boot Disks.

How to Restore the Operating System

1 Turn off the instrument and connect a keyboard and mouse to
the instrument. See “Connecting Peripherals” on page 384 for
details.

2 Insert the bootable diskette in the floppy drive.

3 Turn on the instrument.

4 On the command prompt type d: and press ENTER.

5 Type recover, press ENTER and follow the instructions.

Configuring the Instrument

Configuring the Instrument - Concepts

This section covers information on the configuration of the Serial
BERT.
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Updating the Software

New software features are offered for the Serial BERT  from time to
time; you may be able to enhance the capabilities of your
instrument by updating the software.

See the Agilent Serial BERT web site to see if updates are available
for your instrument:

http://www.agilent.com/find/Serial BERT

Besides the latest versions of the user interface and firmware
server, you will also find instructions for the update process.

C A U T I O N Before you update the instrument's software, make sure that the software matches
the instrument's hardware. An update can be carried out, even if the software does
not match the hardware. In this case the instrument may go into a corrupt state or
not all features may be available.

The applicable hardware versions are listed with the software update version. You
can find the instrument's hardware version on a label at the rear panel.

When updating the firmware server on the instrument, make sure
you select the Hardware installation option.

After the firmware server has been updated, you are prompted to
start a BIOS update. Allow the BIOS to be updated (the firmware
server requires the modifications). Do not interrupt the BIOS
update.

Note that you must reboot the instrument after updating the
firmware. If you do not reboot the instrument, the firmware may
not have access to the instrument's hardware.

Configuring the Instrument - Procedures

Follow the instructions below to configure the instrument according
to your personal needs:

Setting Date and Time

Your instrument uses the date and time when:

• Saving files

• Saving self test information
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• Saving calibration information

To set the date and time of your instrument, do the following:

1 On the Utilities menu, click Set Time and Date... This opens the Date/
Time Properties dialog box.

2 Set the date and time.

3 Click OK.

Setting the GPIB Address

Your instrument is set to a default GPIB (General Purpose Interface
Bus) address. You can change this address by doing the following:

1 On the Utilities menu, click Change GPIB Address.... This starts the
GPIB Address Change dialog box.

2 Select an address in the New GPIB Address list.

3 Click OK. The new address will be applied and the dialog box
will close.

Each instrument must be set to a unique GPIB address to avoid
multiple instruments transferring data at the same time.

N O T E The default address is 14; however, addresses from 0 to 31 may be used if the default
address is the same as another instrument's GPIB address. Address 21 is usually
reserved for the computer interface Talk/Listen address and should not be used
as the instrument address.

Connecting Peripherals

You can connect an external monitor, mouse and keyboard to the
instrument on the Serial BERT 's rear panel. To connect a mouse or
a keyboard, you can use either the USB ports or the PS/2 ports.

For more details refer to “Using an External Monitor ” on page
388 and “Using the On-Screen Keyboard” on page 387.

N O T E If the touchscreen is disabled, the external keyboard and mouse are also disabled.
See “Turning the Touchscreen Off/On” on page 386 on how to enable/disable the
touchscreen.
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Enabling the LAN Connectors

You can enable the LAN connection on your Serial BERT . This will
allow you to connect to network printers and remote servers with
access to shared folders and files.

The Serial BERT  has two RJ-45 LAN connectors on the rear panel.
They support 10 Base-T and 100 Base-T Ethernet networks using
TCP/IP and other Microsoft supported networking protocols. The
Serial BERT  uses Microsoft® XP Pro.

For detailed instructions on how to enable the LAN connectors,
please refer to the Microsoft® XP Pro manual.

C A U T I O N Because your network settings are unique to your IT infrastructure, Agilent
Technologies will not be able to assist you with connecting your instrument to your
network. Please contact your network administrator or IT department for
assistance. For more information, refer to the MS Windows resource kit (available
from Microsoft) that is appropriate for your computer system.

C A U T I O N Do not connect the Serial BERT to a network that is configured to automatically
install software on network devices. Installing or overwriting files on the Serial
BERT computer system may impact the operation of the instrument. Please contact
your network administrator or IT department to find out whether you have this type
of network.

Configuring the Instrument - Reference

The Serial BERT  has the following utilities for configuring the
instrument:

Set Date/Time Dialog Box

This function opens the Date/Time Properties dialog box of
Windows®. Use this dialog box to set the date and time as well as
the time zone of your location.

Customizing the Instrument 9

Agilent J-BERT N4903 High-Performance Serial BERT 385



GPIB Address Change Dialog Box

Your instrument is set to a default GPIB (General Purpose Interface
Bus) address. You can change this address by doing the following:

1 On the Utilities menu, click Change GPIB Address... This starts the
GPIB Address Change dialog box.

2 Select an address from the New GPIB Address list.

3 Click OK. The new address will be applied and the dialog box
will close.

Each instrument must be set to a unique GPIB address to avoid
multiple instruments transferring data at the same time.

N O T E The default address is 14; however, addresses from 0 to 31 may be used if the default
address is the same as another instrument's GPIB address. Address 21 is usually
reserved for the computer interface Talk/Listen address and should not be used
as the instrument address.

Configuring the Touchscreen

Configuring the Touchscreen - Procedures

The following procedures help you to configure the touchscreen
according to your personal needs:

Turning the Touchscreen Off/On

This function disables the instrument touchscreen, external
keyboard, and mouse.

1 On the Utilities menu, click Touchscreen Off. The Enable
Touchscreen icon is placed in the upper right hand corner of the
instrument display.

2 Click the Enable Touchscreen icon to enable the touchscreen,
keyboard, and mouse again.
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Calibrating the Touchscreen

In normal usage, you should not need to calibrate the touchscreen
display. But, if you feel that it needs to be realigned with the video
display, do the following:

1 If the title bar of the Serial BERT  user interface is not visible,
select Title Bar from the Utility menu.

2 Minimize the Serial BERT  user interface window.

3 In the system tray, next to the clock in the lower right corner,
right-click the Touchscreen Settingsicon to open the menu with the
available options.

4 Select Calibrate, then Device 1, and Normal. A blank screen with a
target appears.

5 Click the target to start the calibration. When the calibration is
complete, the calibration window will close.

Configuring the Double Click

You can adjust the behavior of the touchscreen display to simulate
the double-click action of a typical personal computer or trackball.
To configure the touch settings:

1 Select Display Utility from the Utility menu. This opens the
Configuration Utilities dialog box.

2 Click Display to open the Display Area Configuration dialog box.

3 Click the Timed Double Touch slide bar to adjust the amount of time
that can pass as you touch the display screen. You can preview
your adjustment by clicking/touching the Test Box.

Using the On-Screen Keyboard

You can use the on-screen keyboard to enter text in any text field.
It can be used along with the standard keyboard or keypad.

1 Click in a text field to position the cursor in it.

2 Press the On-Screen Keyboard button to open the on-screen
keyboard.

3 Click letters or numbers as desired. For numbers, you must add
the unit by pressing the G/n, k/m, M/µ, or x1 front panel button.
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4 Press the On-Screen Keyboard button again to close the on-screen
keyboard.

5 Continue with your work.

N O T E You can also access the on-screen keyboard from the Utilities menu. A check mark
appears next to the menu entry, indicating that it has been selected.

Using an External Monitor

To switch between the Serial BERT 's built-in display and an
external monitor, do the following:

1 Connect the external monitor with an appropriate power supply
and with the VGA connector on the Serial BERT 's rear panel.

2 If the title bar of the Serial BERT  user interface is not visible,
select Title Bar from the Utility menu.

3 Minimize the Serial BERT  user interface window.

4 In the system tray, next to the clock in the lower right corner,
right-click the Displayicon to open the menu with the available
options.

5 Select Graphics Options, then Output To, and the desired output
device:

– Monitor for an external monitor

– Notebook for the built-in display

Use the same procedure to switch back to the built-in display.

Configuring the Touchscreen - Reference

This section describes the options of the on-screen keyboard:

Click Set to access the Options menu:

• Move OSK Window

Click this to enable the arrow keys on your actual keyboard.
They can then move the software keyboard.
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T I P You can always move the On-Screen Keyboard window by clicking its title bar and
dragging it.

Additionally, you can switch between different views of the on-
screen keyboard. The following table lists the displayed buttons for
the different views:

Table 28

Softkeys Letters Numeric Characters

Qwerty Full X X X X

Qwerty Simple X X X

Qwerty
Minimum

X X

Block Full X X X X

Block Simple X X X

Block
Minimum

X X

Minimum X

N O T E Qwerty options mimic the layout of an actual keyboard. Block options present the
letter characters in alphabetical order.

T I P If you select one of the larger on screen keyboard displays, such as Qwerty Full or
Block Full, the keyboard may cover most of the instrument display. If this occurs,
continue to make your keyboard entry, then either close the on screen keyboard or
change to a smaller display.
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Installing Software Licenses

Installing Software Licenses - Procedures

The Serial BERT  has optional features that require a license. The
following procedures explain how to obtain and install a license:

Obtaining a License

To obtain a license:

1 In the Utilities menu, click Licenses. The Licenses dialog informs
you about the options that require a license.

2 Record the HOST ID / MAC Addr shown in the window. This is
the MAC Address of the Serial BERT .

3 Contact your Agilent representative and purchase a Software
Entitlement Certificate.

4 Visit the website .

5 Follow the instructions on the website. You will need the
certificate and the MAC Address.

6 You will receive a licence file over the web. The file has the
suffix .lic.

Installing a License

To install a license:

1 Copy the licence file to the Serial BERT .

2 In the Utilities menu, click Licenses.

3 Double-click the feature you wish to enable.

4 Follow the instructions in the window.

Installing Software Licenses - Reference

This section explains the options for installing a license.
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Licenses Dialog

The Licenses dialog informs you about the options that require a
license.

The HOST ID / MAC Addr shown in the window is the MAC
Address of your Serial BERT . You will be asked for this address
when you request a license file for an option from Agilent.

N O T E The MAC Address is used for generating the license key code. That means, the key
stored in the license file refers to just one instrument. If you wish to enable a licensed
feature on a different instrument, you need another license file.

Install License

The Install License dialog is used for installing a license.

It indicates the feature that has been selected before opening the
window and allows you to browse for the associated license file.

The suffix of a license file is .lic.

If the license file has not been copied to the Serial BERT  and is not
accessible via LAN, click the Enter button.

Enter License Key

This dialog allows you to enter the license key manually.

That means, you need to read (and probably print) the license file
with a text editor and type the key code.

Installing Hardware Options

Installing Hardware Options - Procedures

The Serial BERT  has a slot for installing optional hardware.

At the present time, the J20 Interference Channel is available. This
module can be used for adding intersymbol interference and
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sinusoidal interference to the signal generated by the Pattern
Generator.

Installing the J20 Option

To install the J20 Interference Channel:

1 Perform the regular shutdown procedure provided by the
operating system.

2 Disconnect the instrument from mains.

C A U T I O N Never plug in or remove a module while the instrument is connected to mains power.

3 Unscrew and remove the slot cover.

4 Insert the module into the slot.

5 Press the lever until the module rests firmly in place, the front
plate aligned with the Error Detector's front panel.

6 Insert and tighten the fixing screw.

7 Power up the instrument. The software will automatically
recognize the new component and provide the Interference
Channel Icon and according setup functions in the Jitter window.

Connecting the J20 Option

The J20 Interference Channel has two ports, P1 and P2. They can
be connected single-ended or differentially. For a description see
“Interference Channel” on page 321

If you connect P1 to the Data Out of the Pattern Generator, P2
provides the output that is meant to be connected to the DUT. This
is ilustrated in the following figure.
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If you connect P2 to the Data Out of the Pattern Generator, P1
provides the output.

C A U T I O N The module has golden 2.4 mm connectors. Be sure to use the specific cables or
adapters for the connections. Improper connection can damage the module.

Printing

Printing - Procedures

This section provides information on setting up and using a printer:

Connecting a Printer to the Instrument

The instrument supports parallel and serial printers as well as USB
and LAN connected printers.

To connect your printer to the instrument:

1 Turn off power to the instrument and printer before connecting.

2 Connect the printer to the instrument with the cable that came
with your printer.

Once you have connected the printer to the instrument, you will
need to add the printer driver before you can use the printer.
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Adding a Printer

Use the following procedure to add a printer to the instrument.

1 On the File menu, click Print Setup, then Add Printer... This opens
the Add Printer Wizard dialog box.

2 Click My Computer for a local printer installation, or click Network
printer server for a printer connected to another server.

N O T E Before you can add a network printer, you must connect to a Local Area Network
(LAN). In addition, your login must provide you with access to the network printers
that you wish to add. Please contact your network administrator or IT department
for assistance.

3 Follow the instructions in the Add Printer Wizard until you have
selected a local printer and configured the printer port.

4 If your printer is not in the list of available printers, you will
need a copy of the printer driver. Select a printer from the
displayed list and click the Have Disk button.

The instrument will then prompt you to put your printer driver
disk into the floppy disk drive (drive A:\).

5 Follow all other instructions.

Removing a Printer

When you disconnect a printer from the instrument and no longer
intend to use it, you can remove the printer driver and increase the
free disk space available on the instrument's internal hard disk
drive.

To remove a printer driver:

1 On the File menu, click Print Setup, then Configure Printer.... This
opens the Printers dialog box.

2 Click the printer driver you want to remove.

3 In the File menu in the Printers dialog box, select Delete. A dialog
box will appear to confirm the removal of the printer driver.

4 Click Yes to confirm your selection.

Setting the Default Printer

You can set the printer you use most often as the default printer.
Then all printouts will be sent to the default printer unless you
explicitly select another printer.
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To specify the default printer:

1 On the File menu, click Print Setup, then Configure Printer.... This
opens the Printers dialog box.

2 Choose one of the currently mapped printers. If the printer you
want to use is not yet included in this list, see “Adding a
Printer” on page 394.

3 On the File menu in the Printers dialog box, click Set As Default.

4 Click Close. The default printer selection is applied and the
dialog box closes.

N O T E The printer capabilities will vary depending on the printer you have installed and
configured.

Printing a Hardcopy

N O T E Before you can print, you must first have the appropriate printer driver installed. The
printer properties and capabilities will vary depending on the printer you have
installed and configured for the instrument.

To print a hardcopy of the instrument's display to the default
printer:

• Click Print from the File menu on the main menu bar.

Configuring Printer Properties

You can change the properties of a selected printer:

1 On the File menu, click Print Setup

2 Click Configure Printer....

This opens the Printers dialog box

3 In the File menu in the Printers dialog box, select from the
following options:

– Server Properties

Click this option to change such items as printer margins,
spooler warnings and alarms, and port configurations.

– Properties

Click this option to change such items as pre-determined
access times, security items, and LAN protocols.
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– Document Defaults

Click this option to change such items as pages per sheet,
print quality, paper select, and portrait vs. landscape layouts.

4 Select Close in the File menu of the Printers dialog box.

The new settings will are applied and the dialog box closes.

N O T E The printer properties and capabilities will vary depending on the printer you have
selected.

Printing Problems

You should check the following when your printer fails to print:

1 Check if the printer is turned on and the printer cable is
securely attached to both the printer and the instrument's
printer connector.

2 Check if the printer driver for your printer is installed.

3 Check if the printer port is configured correctly.

For more information on printer problems, see the printer's
operation manual.

File Management

File Management - Procedures

This section provides information on saving and recalling
instrument states, log files, patterns, and screenshots.

You can save the files on the local disk. Note that the local disk
must not be re-partitioned in a Windows 2000 environment.

You can also plug an USB stick into the rear of the instrument for
saving and recalling files. No driver is required because Windows
has a built-in driver that supports USB memory drives. In the file
browser, you can access the USB stick via the Removable Disk drive.

To avoid loss of data, stop the USB device and wait until the LED
light of the USB stick is off before unplugging the USB stick.
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To avoid loss of data when removing the USB stick:

1 Minimize the GUI.

2 In the system tray, next to the clock in the lower right corner,
right-click the Safely Remove Hardware icon.

A window containing a list of the USB devices appears.

3 Click on the popup message Safely Remove Mass Storage Device.

4 Confirm the acknowledgement message Save to remove hardware....

5 Check that the LED light of the USB stick is off and unplug the
USB stick.

Saving Instrument States

Saving the current instrument state stores all the setup parameters
for the instrument's hardware and software.

To save the setup with the current filename and directory path, do
the following:

• In the File menu, click Save and then Save Instrument State.... The
current instrument state will be immediately saved.

To save the setup with a new filename or directory path, do the
following:

• In the File menu, click Save and then Save Instrument State As....
This opens a dialog box, which allows you to create
subdirectories, rename setup files, or overwrite existing setup
files.

N O T E Ensure your instrument state files have the extension, *.btz. If you do not specify
an extension or use a different extension, the instrument may not recognize the file
as an instrument state file.

N O T E The default pathname for user defined instrument states is C:\N4903A\Settings

The number of instrument states you can save is limited only by
the available space on the internal hard disk or floppy disk. Each
instrument state uses approximately 6 kB of disk space.

T I P Remember to always make a backup copy of your files. If your original files are
damaged or lost, you can restore the files from the backup copy.
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Recalling Instrument States

Recalling the instrument state restores all the setup parameters for
the instrument hardware and software.

To recall the setup, do the following:

• In the File menu, click Open and then Open Instrument State.... This
opens a dialog box which allows you to select the setup file you
want to recall.

T I P Remember always to make a backup copy your setup files. If your original files are
damaged or lost, you can restore the files from your backup copy.

N O T E The default pathname for user defined instrument states is C:\N4903A\Settings

Saving and Recalling Measurement Logs

Measurement Logs are saved as CSV (comma-separated values)
files. Follow the steps below to view results in a measurement log
file.

1 Copy the measurement log file from the Serial BERT  to your PC.
By default, log files are saved in the folder C:\N4903A\log.

2 Open a spreadsheet application on your PC.

3 Import the measurement log file. If your application has an
import wizard, you may need to indicate that data is delimited
with commas.

4 Once the file has been imported, you may need to resize
columns. The imported log file should appear similar to the
following example.

N O T E During measurement logging, the Serial BERT logs data in ten-second intervals.
Your log file may be missing up to the last ten seconds of data. To avoid this
condition, accumulate for 10 seconds longer than desired.
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You can view and analyze the following information in the
measurement log file:

Table 29

Instantaneous Cumulative

BIT COUNT BIT COUNT Cumulative

ERROR COUNT ERROR COUNT Cumulative

ERROR RATIO ERROR RATIO Cumulative

ERRORED 0 COUNT ERRORED 0 COUNT Cumulative

ERRORED 0 RATIO ERRORED 0 RATIO Cumulative

ERRORED 1 COUNT ERRORED 1 COUNT Cumulative

ERRORED 1 RATIO ERRORED 1 RATIO Cumulative

SYNC LOSS ERROR SECONDS Cumulative

PG CLOCK LOSS ERROR FREE SECONDS Cumulative

ED CLOCK LOSS ERROR DECISECONDS Cumulative

DATA LOSS ERROR FREE DECISECONDS Cumulative

SYNC LOSS SECONDS Cumulative

BURST STATUS Cumulative

BURST SYNC RATIO Cumulative
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Table 29

Instantaneous Cumulative

TOTAL BURST COUNT Cumulative

BAD BURST COUNT Cumulative

Saving and Recalling Patterns

You can save your pattern in either of the following ways:

• Click the Save icon on the Pattern Editor toolbar.

If the pattern has not been saved earlier, a file dialog box opens
that allows you to navigate the file system and name your
pattern.

Alternatively, you can use the following procedure:

1 From the File menu, select Save.

2 Then select Save Pattern in Editor.... to save the pattern with the
current filename. Or click Save Pattern in Editor as.... to open a file
dialog box that allows you to save the pattern with a new name.

N O T E The default pathname for patterns is C:\N4903A\Patterns.

Saving and Recalling Screen Images

The instrument allows you to save an image of the current display
screen. You can save this image to the internal hard disk or a
floppy disk. You can later print this file or import it to a word
processing or graphics editing program.

To save an image of the display screen, do the following:

1 In the File menu, select Save.

2 Select Save Screen Capture....

This opens a dialog box, which allows you to save the image as
a *.bmp (256 color bitmap file format) file.
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Follow the steps below to view screen images on an external PC:

1 Copy the screen image file from the Serial BERT  to your PC. By
default, image files are saved in the folder C:\N4903A\User.

2 Open the file in Microsoft Paint or another graphics program.

Preset Instrument State

Preset Instrument State - Procedures

To reset the instrument to the preset state select one of the
following options:

• Press the Preset button on the front panel.

or

• Select Preset in the File menu.

or

• Send an *RST command to the GPIB controller.

Self Test

Self Test - Concepts

The self test checks specific hardware components for basic
functionality. At initialization, the following self tests are
automatically run:

• Pattern Generator Power Up Test

• Error Detector Power Up Test
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N O T E The current system state is saved and the instrument is re-initialized before
performing the selected tests. The saved system state is restored upon completion
of the self test.

When Self Test is selected from the Utility menu, the Self Test Options
dialog box opens. In this dialog box, you can select additional self
tests that will run when you click Run Test.

N O T E During accumulation or while auto-search functions are in progress, Self Test is
not available.

The pass/fail results of the self test are displayed in the Self Test
Options dialog box. In case of failed tests, you can view detailed
error messages in a separate window.

Self Test - Procedures

To run a self test:

1 Select Self Test from the Utility menu.

This opens the Self Test Options dialog box.

2 Select the desired tests and click the Run Test button.

3 After the self test has finished, the results are displayed next to
each selected test.

4 If a test failed, you can view detailed error messages by clicking
the respective Message button.

Self Test - Reference

This section contains information about the Self Test Options dialog
box used for setting up and running a self test and for viewing the
results.

Self Test Options

The Self Test Options dialog box offers to select the following tests:

• Pattern Generator Bios Self Test
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This test is checking all the modules, chips, and registers of the
pattern generator more thoroughly than the Power Up test. It
may take about 5 minutes to complete.

• Pattern Generator Power Up Messages

This test is automatically run after switching on the instrument.
It mainly checks if all important modules, chips, and registers of
the pattern generator are available and accessible.

• Pattern Generator Auto Calibration

This test runs a timing calibration that calibrates the clock to
data alignment of the pattern generator. It may take about 15
minutes to complete.

• Error Detector Bios Self Test

This test is checking all the modules, chips, and registers of the
error detector more thoroughly than the Power Up test. It may
take about 5 minutes to complete.

• Error Detector Power Up Messages

This test is automatically run after switching on the instrument.
It mainly checks if all important modules, chips, and registers of
the error detector are available and accessible.

• Error Detector Auto Calibration

This test runs a timing calibration that calibrates the clock to
data alignment of the error detector. It may take about 15
minutes to complete.

Select All/Unselect All

Use the Select All button to select all tests in the Self Test Options
dialog box. After clicking the button, it becomes the Unselect All
button. Clicking the button again will then unselect all tests and
display the Select All button again.

Run Test

After selecting at least one test, use this button to start the test. If
you selected tests, that need a longer time to complete, a message
box opens. Confirm your selection by clicking OK. A second message
box is informing you while the test is still running and closes when
finished.
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Message Buttons

After the self test has finished, the results ( Success or Failed) are
displayed next to each test. If a test has failed, you can use the
Message button to open the BIOS Messages window with detailed
error messages explaining the failure reason.
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Output Levels, 204
Output Timing, 185

Decision Threshold, 111
Delay, 74, 80
Delay Control Input, 71
Delay Line display, 327
Delay Line selection, 325
Deterministic Jitter, 188
Different In/Out Rates

Connections, 18
Differential, 110
Differential Inputs

Connections, 18
Double Click Configuration, 387
DUT Connecting, 17
DUT Output Timing/Jitter
measurement, 168

E

ED CLK LOSS, 370
Edge Resolution Optimization

Eye Opening, 225
Output Levels, 199
Output Timing, 180

Edit Pattern Window, 44, 62
Editing Patterns, 40
Equal BER at BER Threshold, 218
Error Accumulation, 145
Error Accumulation , 144
Error Add button, 95
Error Add input, 71
Error Addition/Insertion, 95

Error Detector
1/0 threshold, 111
Auto Threshold, 118
Aux Out port, 108
Aux Output , 129
Clock In port, 107
Clock Setup, 112
Data In port, 107
Data In setup, 110
Error Out port, 108
Gate In port, 107
Input and Output Ports, 106
Setup, 105
Trigger Out port, 108

Error Indicator, 372
Error Insertion

Constant Rate, 96
External Signal, 96
Manually, 95

Error Location Capture measurement,
232
Error Out port, 108
Estimated Total Jitter, 188
Example of an Output Level
Measurement

Changing Properties, 197
Improving the Display, 196
Running the measurement, 194

Example Patterns, 33
External Clock Source, 87
External Data Source

Connections, 21
Eye Diagram, 119
Eye Edge, 120
Eye Height, 310
Eye Measurements, 309
Eye Opening measurement, 216
Eye Width, 310

F

False Synchronization, 135
Fast Eye Mask measurement, 238
Fast Total Jitter at BER, 181
Fast Total Jitter measurement, 168

Explanation, 173
Numerical results, 190
Result Display, 189

File Management, 396
Flip-Flop

Connections, 19

G

G.821 Measurements, 305
Gate In port, 107
Gate In signal timing, 139
Gating, 82
Gauss curve, 165
Gaussian Marker

introduction, 164
Output Levels, 202
Output Timing, 169

Generated Patterns, 53
GPIB Address, 384
Graph Tab

Eye Opening, 230
Output Levels, 204
Output Timing, 185
Spectral Jitter, 292

Grid , 251

H

Hardware-generated patterns, 23
High Level, 205
High Level Std. Dev., 207

I

Input and Output Ports
Error Detector, 106
Pattern Generator, 70

Input Range
Error Detector, 112

Instantaneous Measurements, 295
Interference Channel, 321

Setup, 334
Internal Clock Source, 86
Intersymbol Interference, 335
Intersymbol interference (ISI), 318
Interval Results, 306
Introduction to the Serial BERT, 9
invalid, 189
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Inverted Data
Error Detector, 111
Pattern Generator, 81

ISI, 318

J

Jitter
example, 166
fast total, 173
Generation Block Diagram, 320
Total, 319
Types of, 315

Jitter composition overview, 327
Jitter Mean, 188
Jitter Setup, 323
Jitter Tolerance

Reference, 345
Jitter Tolerance Characterization,
336

BER, 338, 346
Confidence level, 338
Frequency, 345
Relax time, 339
Search, 346
Search methods, 339

Jitter Tolerance Compliance, 348
BER, 366
Confidence level, 352
Frequency, 365
Margin, 355
Predefined Standards, 352
Reference, 363
Relax time, 352
Standard Specification, 363
Target BER, 351
User-defined Standards, 353

Jitter Tolerance Tests
Basics, 313

L

LAN Connectors, 385
Level Results, 205
Linear Markers, 163

Loading
Pattern, 41
Pattern directly from Pattern
Editor, 43

Logic Families, 74
Logic Levels Setup, 77
Low Level, 206
Low Level Std. Dev., 207

M

Manual Pattern Alternation, 100
Manually Inserting Errors, 95
Mark Density, 52
Markers, 

Gaussian, 164
introduction, 163
Linear, 163

Mean Level, 206
Measured Points, 230
Measurement Log, 146, 376
Measurement points

defaults, 239
Measurements, 295
Memory-based Patterns, 23
Min BER for Q, 204
More Errored 0's than 1's, 373
MUX/DEMUX Pair

Connections, 20

N

No. of points, 188
Noise Threshold, 292
Normal, 110
not applicable, 189
Number of Compared Bits

Eye Opening, 225
Fast Eye Mask, 243
Output Levels, 199
Output Timing, 180

Number of Errors
Eye Opening, 225
Fast Eye Mask, 243
Output Levels, 199
Output Timing, 180

Number of Top Frequencies to Show,
292

Number of Valid Points, 244
Numerical Results

Eye Opening, 231
Output Levels, 205
Output Timing, 187
Spectral Jitter, 293

O

Offset threshold, 243
On-Screen Keyboard, 387
Optimal Sample Point Delay, 187, 190,
231
Optimal Sample Point Threshold, 231
Optimum Sampling Point, 122
Oscilloscope Connections, 20
Output blanking, 82
Output Level Parameters, 73
Output Levels measurement, 191
Output Protection, 72
Output Timing measurement, 168
Output Timing Measurement
Optimization, 180

P

Parameters
Bounded uncorrelated jitter, 329
External jitter, 331
Periodic jitter, 330
Random jitter, 328
Sinusoidal jitter, 332

Parameters Tab
Eye Opening, 225
Fast Eye Mask, 243
Output Levels, 198
Output Timing, 180
Spectral Jitter, 286

Pass/Fail tab
Eye Opening, 226
Fast Eye Mask, 244
Output Levels, 200
Output Timing, 181
Spectral Jitter, 288

Index
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Pattern
Alternation, 98
Creating New, 39
Editing, 40
Editor, 44, 62
Examples, 33
from file, 24
Generated Patterns, 53
Hardware generated, 23
Length, 30
Load status indicators, 49
Loading directly from Pattern
Editor, 43
Loading from file, 41
mark density, 52
memory-based, 23
Opening Existing, 40
PRBN, 25
PRBS, 23, 25
Properties, 48
provided patterns, 24
Repetition, 32
Resolution, 30
Saving, 41
Selecting, 50
Sequence, 42
Sequence of patterns, 56
Setup, 23
software-generated, 24, 53
Supported Types, 28
Which Is Appropriate?, 26

Pattern Alternation
Manually, 100
With External Signal, 101

Pattern Generator
Auxiliary Input, 71
Clock In port, 70
Clock Out port, 71
Data Out port, 71
Delay Control Input, 71
Error Add input, 71
Input and Output Ports, 70
Ref. Clock input, 70
Setup, 69
Sub Clock Out port, 71
Trigger Out port, 71

Pattern Mode, 58
Pattern Synchronization , 131
Peak Peak Noise, 207

Percentage threshold, 243
Periodic jitter (PJ), 316
PG CLK LOSS, 370
Phase Margin, 187, 190
PJ, 316
Planning the Test, 9
Power scale, 290
PRBN, 25
PRBS, 25
PRBS Patterns, 23
Printing, 393
Problems, 369

Constant Errors (More Errored 0's
than 1's), 373
Random Errors, 374
Sync Loss Seconds, 375

Properties dialog box
DUT Output Timing/Jitter, 180
Eye Opening, 224
Fast Eye Mask, 242
Output Levels, 198
Spectral Jitter, 286

Pseudo Color Plot, 217

Q

Q Factor, 208
Q High Level, 209
Q High Level Nr. Points, 209
Q High Level R^2, 209
Q High Level Std.Dev, 209
Q Low Level, 210
Q Low Level Nr. Points, 210
Q Low Level R^2, 210
Q Low Level Std.Dev, 210
Q Optimum Threshold, 208
Q Residual BER, 209
Q-Factor Calculations

mathematics, 211
Notes, 214

QBER vs. Threshold Graph, 203

R

R^2 values, 189
Random Errors, 374
Random jitter (RJ), 316
Random Jitter RMS, 188

Ratios Graph, 303
Relative Time, 244
Requirements, 14
Resolution

Eye Opening, 225
Fast Eye Mask, 225
Output Levels, 199
Output Timing, 180

Results
see Numerical Results, 187

Return to Results button, 129
RJ, 316
Running Measurements, 295

S

Sampling Point Setup, 119
Saving Patterns, 41
Self Test, 401
Sequence

creating, 59
definition, 56
loops, 63
properties, 66
recalling, 60
saving, 60

Sequence Editor, 61
Toolbox, 65

Sequence Mode, 58
SequenceExpression, 56
Sequences, 56
Serial BERT

introduction, 9
Setting Date and Time, 383
SI, 319
Signal/Noise Ratio (Peak Peak), 207
Sinusoidal Interference, 336
Sinusoidal Interference (SI), 319
Software-generated patterns, 24
Software-generated patterns, 53
Software-generated
patterns;Pattern:software-
generated , 51
Solving Problems, 369
SONET/SDH Receiver

Connections, 21
Spectral Jitter measurement

procedure, 283
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Spread Spectrum Clocking, SSC, 84
Standard patterns, 24
Status Indicators, 298
Sub Clock Out port, 71
Supported Pattern Types, 28
SYNC LOSS, 371
Sync Loss Seconds, 375
Sync Now button, 126

T

Termination
Error Detector, 111

Terminations
Setup, 77
Usage, 74

Test
Duration, 15
Planning, 9
Requirements, 14
Which Test Is Appropriate?, 13

Test points (Fast Eye Mask), 238
Threshold

absolute, 243
offset, 243
percentage, 243

Threshold Eye Opening, 231
Threshold Margin, 206
Threshold Resolution

High Level (Eye Opening
measurement), 226
High Level (Output Levels
measurement), 199
Low Level (Output Levels
measurement), 199, 226

Threshold Types, 243
Time Eye Opening, 231
Timing Unit

Eye Opening measurement, 230
Fast Eye Mask measurement, 243

Total Jitter BER Threshold, 190
Total Jitter Peak-Peak, 190
Total Jitter Peak-to-Peak, 188
Total Jitter RMS, 188
Total Jitter Uncertainty, 190
Touchscreen

Calibration, 387
Off/On, 386

Trigger
Error Detector, 129

Trigger Out
Error Detector, 108
Pattern Generator, 89

Trigger Out port, 71
Troubleshooting, 369

U

Uncertainty Band, 174
User pattern, 24
User-Defined Sequences, 56

V

Vampt, 80
Variable Mark Density, 52
Vhi, 79

View Tab
Eye Opening, 228
Output Levels, 202
Output Timing, 183
Spectral Jitter, 290

View tab
Fast Eye Mask, 245

Vlo, 80
Vof, 79
Voltage

of measurement point, 244

W

Waveform, 251

X

Xover, 80

Z

Zero SubstitutionPattern
zero substitution, 52

Zoom Function
Eye Opening, 230
Output Level, 204
Output Timing, 186
Spectral Jitter, 292
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